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前  言 

FreeHand 是当前最为流行的图形处理软件之一，它功能强大、易学易
用，自从 Macromedia 公司 1988 年推出第一版以来，逐渐成为市场上最流
行的矢量绘图软件之一，广泛应用于平面设计、广告装潢、商业等各个领

域，并且 FreeHand 的功能还在不断地加强。最新推出的 FreeHand9．0 更
是功能强大，界面友好，它使用 PostScript 语言来定义线条、形状和填充
插图等，所以打印效果也十分清晰，能适应各种分辨率的打印。 
本书是按一般用户对软件的认识由浅入深的顺序编写的，在各个章节

中穿插一定数量适合该章节学习的实例，并辅以较详细的文字说明，而且

大都采用比较简洁、通俗的语言。这些会让读者更加容易上手，从而更好

地把握本书的学习和软件的使用。大家都知道现在大多数应用软件都是“傻

瓜’’式，面向对象型的。要想很快入门儿也不难，但要想学好像

FreeHand9．0 这样功能丰富而强大的软件，不花费一定的时间投入一定的
精力是不太现实的。所以，请读者不要试图一口气读完这本书，而应按章

节循序渐进，并对书中的实例进行实际操练，逐步提高对该软件的应用水

平。 
由于编者的水平有限，加之时间较为仓促，书中难免有错误和不足，

恳请广大读者和用户朋友批评指正。 
编  者 
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第 1章  FreeHand 9.0入门 

FreeHand 9.0 是一个易学易用、操作简单方便但是功能却非常强大的
图形处理软件，它小巧玲珑，完全安装也只需要几十兆的空间。FreeHand 9.0
使用矢量绘图原理，从最基本的线条路径和文本入手，再辅助以功能强大

并且丰富多彩的渲染效果功能，创建出来的作品占用磁盘空间小，但图像

清晰不受分辨率的影响。 
本书将以目前市场中最常用的操作系统 Windows 98 作为默认的操作

系统，在该系统下由浅入深地讲授 FreeHand 9.0的强大功能和使用方法。 
在这一章里，主要讲授 FreeHand 9.0的入门知识，介绍一下软件的安

装和工作界面中的工具栏、菜单栏和浮动面版功能。相信用户一定会被

FreeHand 9.0 那强大的功能和操作的简便性所吸引，并愉快地步入该软件
的学习中。 

1.1  FreeHand 9.0的安装和启动 

众所周知，现在的软件绝大部分都是有安装向导的，安装十分容易，

所以在这里只简略介绍一下安装步骤。 
FreeHand 9.0的安装步骤如下。 
（1）首先，打开计算机的电源开关，待进入 Windows 后，放入 FreeHand 

9.0的安装光盘，然后在光盘目录下找到 Macromedia FreeHand 9.0这个文
件夹，再在其目录下找到 setup.exe 文件，双击运行它，这时就会进入如图
1-1所示的安装界面。 

 

图 1-1  FreeHand 9.0 的安装界面 

（2）此时，再单击“Next”按钮，这时便会弹出一个协议对话框，这
便是 Macromedia公司关于 FreeHand 9.0的用户协议书，如图 1-2所示。 
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图 1-2  FreeHand9.0 的安装协议书 

（3）对于用户协议书，很显然只有选则 Yes 选项，单击它会弹出一个
“安装路径”对话框，如图 1-3所示。 

 

图 1-3  FreeHand9.0 的安装路径 

F 注意 

在安装过程中，因为某种原因要中断安装过程时，可以单击按钮

“Cancel”或者“No”，弹出如图 1-4 所示的对话框。在该对话框中单击“Exit 
Setup”按钮即可退出安装，若单击“Resume”按钮则回到中断位置。 

 
图 1-4  “退出安装”对话框 
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（4）它的默认路径是 C：\Program Files\Macromedia\FreeHand 9，如
果不想装入该路径，可以单击“Browse”按扭进入路径选择对话框，如图
1-5所示。 

 

图 1-5  选择安装路径 

' 提示 

如果想把软件装在一个新目录下，可以直接在文本框内键入路径全

名，再单击“OK”按钮，然后系统会弹出对话框询问是否生成该目录，再
单击“OK”按钮即可生成设定的目录，并回到安装界面。 
（5）选择好合适的安装路径后（这里设置在默认目录下），再单击“OK”

按钮，接着会重新进入原来的 FreeHand 9.0的安装路径对话框，只是路径
改变了，再单击“Next”按钮，进入安装类型对话框，如图 1-6所示。 
（6）其中有 3 个选项，分别是 Typical （典型安装）、Compact （最

小安装）以及 Custom （自定义安装）。Typical 是专对大多数普通用户定
制的，也是其默认选项，Compact 是对于磁盘空间较小或作简单使用的用
户而设计的，而 Custom 是对高级用户而设计的。作为一般用户并且有足
够的硬盘空间最好选择 Typical （典型安装），然后直接单击“Next”按钮。
进入一个语言种类选择对话框如图 1-7所示。 
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图 1-6  安装类型 

 

图 1-7  选择语言种类 

（7）这里有两个选项，分别是 U.S English Dictionary（美语版）和 Int’l 
English Dictionary（标准英语版）。可根据需要选择一种，再单击“Next”
按钮，进入如图 1-8所示的界面。 

 

图 1-8  开始菜单-程序文件夹 

（8）再单击“Next”按钮，弹出如图 1-9所示的对话框。 
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图 1-9  复制文件 

（9）同上步一样，直接单击“Next”按钮，弹出一个进度显示条，如
图 1-10所示，说明此时已开始复制文件了，请耐心等待。 

 

图 1-10  进度显示 

（10）待其完成复制以后，会弹出一个对话框提示是否确认完成。如
图 1-11所示。 

 

图 1-11  完成安装 

（11）此时只需再单击一下“Finish”按钮即完成对 FreeHand 9.0 的
安装工作。接下来的工作就只剩注册了（如果想马上注册的话）。

FreeHand9.0的安装工作就这么简单！ 
（12）安装完成后便可启动 FreeHand9.0，只需再在“开始”菜单里选

择“程序”一栏中的“Macromedia FreeHand 9”，接着再将鼠标移到“FreeHand 
9”选项，单击鼠标，立刻就启动了 FreeHand 9.0，进入其欢迎画面，如图
1-12所示。 
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图 1-12  FreeHand 的欢迎画面  

然后会弹出一个有关注册的对话框，如果要注册则选择“ now”，通过
因特网立即会联入 Macromedia 公司的网站进行注册。如果不想现在注册
则选择“Later”按钮，进入 FreeHand 9.0的工作界面，如图 1-13所示。 

 

图 1-13  FreeHand 9.0 的工作界面 

（13）到此为止，已成功的完成了 FreeHand 9.0的启动工作。 
如果是第一次启动 freeHand 9.0，它会在启动时弹出一个窗口，如图

1-14所示。 

 

图 1-14  启动向导窗口 
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其中： 
◆  N e w ：用当前模板建立一个新的文件。 
◆  Previous File ：打开最近编辑的文档。 
◆  Open ：打开文档。 
◆  Templates ：使用系统提供的专业模板来创建新文档。 
◆  FreeHand Help ：提供系统帮助。 

F 注意 

选中复选框则每次软件启动自动加载此向导窗口，否则，不再弹出此

对话框。 

1.2  FreeHand 9.0工作界面介绍 

当做好一切准备工作，启动 FreeHand 9.0便可进入到如图 1-15 所示工
作主界面。 

 

图 1-15  FreeHand 9.0 的窗口主界面 

FreeHand 9.0 的界面主要由应用程序窗口和文档窗口构成。另外，
FreeHand 9.0 还有丰富的浮动面板，它们使操作灵活方便并且易于编辑修
改，能适应每个使用者的需要，体现每个使用者的风格，使软件个性化。

下面将对界面上不同的组件作详细的介绍。 

1.2.1  菜单栏 

FreeHand 9.0的菜单栏共有 8 个：File （文件）、Edit （编辑）、 View 
（查看）、Modify （修改）、Text （文本）、Xtras （特效或者叫外挂功能）、
Windows （窗口）、Help （帮助）。各菜单栏下均包括子菜单，有的还有
多级子菜单。菜单有的复选有效，这类主要控制编辑模式和各工具栏的显

示模式。 
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图 1-16  主菜单栏 

◆  File菜单 ：主要用于对文件的各种操作，如图 1-17所示。 

 

图 1-17  File 菜单 

◆  Edit菜单    ：主要用于对所选对象的处理和编辑。 
◆  View菜单   ：主要用于对视图的控制。如图 1-18所示。 
◆  Modify 菜单  ：主要用于对所选对象的修改操作。 
◆  Tex t 菜单   ：主要用于文本类的操作。 
◆  Xt ras 菜单  ：主要用于对所选对象进行特殊效果的处理。 
◆  Window 菜单 ：主要用于对窗体的操作。 
◆  Help 菜单  ：主要用于在操作过程中获得它的联机帮助。 
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图 1-18  View 菜单 

F 注意 

在某些参考书中，把菜单 Xtras 翻译为外挂功能。另外还有一些翻译
词汇与本书不同，请大家灵活掌握，以英文为准。 

/ 小技巧 
菜单栏的快捷键主要分为 Ctrl 类和 Alt 类。例如，File→NewCtrl+N 这

就是说，新建文件的方法可以用鼠标逐次选择相应菜单或单击工具栏对应

图标按钮，也可以直接在按住 Ctrl 键后按下 N 键，还可以按住 Alt 键逐次
按下 F、N 键（Alt 键在此过程中不能放开）。若快捷键为 Ctrl+Shift+G，则
表示同时按住 Ctrl、Shift 两功能键，再按下 G键。 

' 提示 

菜单栏包括了软件的几乎所有功能，在以后的进一步学习和实例中还

将进一步深入介绍。不过，本书不可能将菜单的每一项都讲得很详细，仅

是对大多数用户经常运用的菜单作讲解，所以，若想详细了解某一单项，

最好的方法还是在运用本书的同时结合帮助文件再加上自己动手去尝试，

相信您会有很大收获的。 
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1.2.2  工具栏 

工具栏是将常用的一些命令或预定义以图标按钮形式呈现在用户面

前，有了它就可以借助图标记忆一些常用的命令，运行某命令时直接单击

对应图标按钮即可，可提高工作效率，减轻用户负担。 
1.2.2.1  主工具栏 

 

图 1-19  主工具栏 

表 1-1  主工具栏功能一览简表 

按 钮 名 称  对 应 菜 单 栏  对 应 功 能  

New（新建） File→ New 创建新图 

Open（打开） File→Open 打开已有文件 

Save（保存） File→Save 保存当前文件 

Import（导入） File→ Import 
将其他格式的文件

导入到当前文件 

Print（打印） File→Print 打印 

Graphics（图像） Edit→  Find And Replaced→
Graphics 

打开图形（查找和

替换、选择）面板 

Align（对齐） Windows→Panels→ Align  打开对齐面板 

Lock（锁定） Modify→Lock 将对象锁定 

Ulock（解锁） Modify→Unlock 将锁定对象解锁 

Object（对象） Window→Inspectors→Object  打开对象信息面板 

Transform（变换） Window→Panels →Transform 打开变换面板 

Color List（颜色列
表） 

Window→Panels→Color List  打开颜色列表 

Color Mixer（调色
板） 

Window → Panels → Color 
Mixer 

打开调色板 

Layer（层） Window→Panels→ Layers 打开层面板 

Smyble（符号） Window→Panels→Symbols 打开符号面板 

Help（帮助） Help 打开联机帮助 
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' 提示 

表 1-1 既可以作为初学者了解 FreeHand 9.0 的基本内容，还可以作为
以后学习中临时查阅的重要工具。通过它你可以很方便地知道其各个控键

的功能。另外，每一条命令可能和几个菜单命令对应，在此仅列出一个，

请用户注意。 
1.2.2.2  文本工具栏 

文本工具栏主要用来对文本进行一系列的编辑和设置，其大体上同其

他软件的同类工具相类似。文本工具栏如图 1-20 所示，表 1-2 列出了其他
软件不常见的几个功能。 

 

图 1-20  文本工具栏 

表 1-2  文本工具栏功能一览简表 

按 钮  按 钮 名 称  功 能  

 
在路径中流动 在封闭路径类绕排文本 

 
附着路径 沿路径加载文本 

 
脱离路径 将文本脱离路径 

 
转换路径 将文本转换为路径 

 
文字编辑器 编辑文本 

 
拼写 用对话框进行编辑 

 
结交选择 选择结交剩余模式 

F 注意 

以上介绍只是对该控键最基本的介绍，读者现在只需了解其大概，摘

本书后面有较为详细的实例介绍。 
1.2.2.3  信息栏 

信息栏主要显示操作对象的一些信息，如当前光标所在位置等。如图
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1-21所示。 

 

图 1-21  信息栏 

图 1-21 左上角小格内显示操作对象是处于锁定或非锁定的状态，左上
方的矩形框内显示操作对象的名称，右上方的矩形框内显示坐标所在位置，

而下方的矩形框（现为空）内显示相对参考点的坐标和相对极半径和极角。 
1.2.2.4  工具箱工具栏 

FreeHand 9.0 提供了极为丰富的绘图、文本编辑、对象控制等工具，
其各种功能如表 1-3所示。 

 
图 1-22  工具箱 

表 1-3  工具箱功能一览表 

按 钮 名 称  操 作  功 能  

拖动 选定对象 

双击 进行敏感和非敏感的选择 
Shift+拖动  选择多个对象 

Pointer（箭头） 

双击对象 对对象进行旋转等特效操作 

单击、拖动 用不规则区域选定对象 
Lasso（套锁） 

双击 进行敏感和非敏感的选择 
Eyedropper （ 拾 色
管） 

拖动 将选定颜色进行移植 

单击按钮 创建新文本框 
Shift+拖动 创建正方形文本框 

Text（文本） 
Alt+拖动 

以单击点为中心向外扩展成文本

编辑框 
拖动 创建矩形 
Shift+拖动 创建正方形 
Alt+拖动 创建以中心向外扩展的矩形 

Shift+ Alt+拖动 
创建一单击点为中心向外扩展的

矩形 

Rectangle（矩形） 

双击 打开矩形对话框，进行设定 
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续  表 
按 钮 名 称  操 作  功 能  

拖动 创建以单击点为中心的多边形 
Polygon（多边形） 

双击 进行多边形边数的选择 
拖动 创建椭圆 
Shift+拖动 创建圆形 
Alt+拖动 以单击点为中心创建椭圆 

Ellipse（椭圆） 

Shift+ Alt+拖动 以单击点为中心创建圆形 
拖动 以单击点为中心创建螺旋线 

Spiral（螺旋线） 
双击 打开螺旋线对话框，进行设定 

Line（直线） 拖动 以单击点为起点创建直线 
拖动 用鼠标进行自由绘图 
双击 打开徒手画对话框，进行设定 

Freehand（徒手画） 
拖动 

绘制曲线和直线，并可改变曲线曲

率和旋转方向 
单击 生成节点连缀成线 

Pen（钢笔） 
拖动 改变曲线曲率和方向 
拖动 创建贝赛尔曲线 Bezigon（贝赛尔曲

线） Alt+拖动 在两点间生成曲线 
拖动 切断选定的线条和轮廓 

Knife（小刀） 
双击 打开其对话框，设置切割方式 
单击对象+拖动
节点 

随意改变图形外观 Freeform（手画造
型） 

双击 设置拖动节点的方式 
拖动 旋转被选定的图形和文本 
Shift+拖动 以四十五度角为增量旋转 Rotate（旋转） 
双击 设置转角和旋转中心 
拖动 产生镜像效果 

Reflect（镜像） 
Shift+拖动 以四十五度角为增量镜像旋转 
单击对象 缩放选定对像 
Shift+拖动 成比例缩放选定对像 Scale（缩放） 
双击 设置缩放比例、方式 
拖动 倾斜选定对像 

Skew（倾斜） 
Shift+拖动 沿水平和竖直方向倾斜选定对象 

Trace（回溯描图） 拖动 
选择该工具，自动将选定的位图转

化成路径 
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续  表 
按 钮 名 称  操 作  功 能  

Perspective（透视） 拖动 
将多个对象重叠，显示重叠后的三

维立体图像 
拖动 对页面进行移动操作 

Page（页面拖动） 
Alt+拖动 对页面进行移动、复制操作 
单击对象 对选定对像进行放大 Magnification （ 放

大） Alt+单击对象 对选定对像进行缩小 

1.2.2.5  状态栏（图 1-23） 

 

图 1-23  状态栏 

状态栏主要用来显示操作对象的状态。它最左边的下拉框中可以选择

缩放比例如：54%，200%等，而与其临近右边的下拉框中可以选择页数，
两者中间的两个控键分别是用来向前和向后翻页。 
中间的显示模式下拉框可用于进行显示模式的选择，显示模式包括：

预览，快速预览，基准线和快速基准线及闪光削齿模式等五种模式。预览

模式用于显示所有线条、填充颜色、特色效果处理，就是提前的打印效果。

快速预览模式速度较快，但不显示特殊效果也不显示具体内容。基准线模

式只显示基本骨架和图像路径，不显示填充和特殊效果，只显示文本。而

快速基准线模式则只显示路径和框架。 
最后面的下拉列表可以选择度量单位，如：磅，英寸，毫米等。 

1.2.2.6  封装工具栏 

封装工具栏用来产生多种封装变形效果。如图 1-24所示。 

 

图 1-24  封装工具栏 

1.2.2.7  特效工具栏及特效操作工具栏 

特效工具栏主要用来进行各种特效操作，如对对象进行三维旋转和镜

像操作等，如图 1-25所示。 
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图 1-25  特效操作工具栏和特效工具栏 

1.2.3  浮动面板 

FreeHand 9.0 中除菜单栏、工具栏外，最有特色的就是浮动面板。它
可以根据用户的需要随时打开或关闭，可以随时调整大小，折叠拆分；另

外浮动面板还有实时性能及时显示编辑结果和状态，使操作窗口与浮动面

板间的交互性更好，这也是它优于对话框的原因。另外，浮动面板的集成

性很好，用户打开一个面板就可以完成某一类功能的几乎全部操作。 
FreeHand 9.0的浮动面板基本上可以分为 3大类：Inspectors面板、Panel

面板及 Xtras 面板。它们均可以在 Windows（窗口）菜单栏找到对应的选
向来控制对应浮动面板显示与否，如图 1-26所示。 

 

图 1-26  控制浮动面板的菜单 

浮动面板的拆分很简单，用户只要点住要拆分出来的子面板向外一拉，

拉出如图 1-27 所示的虚框，再放开鼠标即可完成拆分；若要合并两个分离
的浮动面板，只要将其中一个直接拖到另一个上即可。无论拆分还是合并，

都要见到虚框才能成功，尤其合并时，一定要拖动面板标签而不能拖动标

题栏，否则只能把两个浮动面板叠在一起而非合并。 
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图 1-27  浮动面板拆分示意图  

下面将按照面板分类依次介绍这 3类面板。 
1.2.3.1  Inspectors（检查器）面板组 

Inspectors 面板组是 FreeHand 9.0 中最常用且功能最强大的面板组。
默认状况下，包含 Object （对象检查器）、Stroke（笔划检查器）、Text（文
本检查器）、Fill（填充检查器）、Document（文档检查器）5 个子面板，这
5个子面板可以拆分也可以组合。该面板对应功能如表 1-4所示。 

表 1-4  Inpectors面板功能一览简表 

面板名称 代 表 窗 体  功 用 简 介  

Object 
（对象） 

 

该面板是一个动态显示面板，与用

户操作有很好的交互性。它随用户

选定对象属性的不同，显示的内容

也会发生相应的变化。例如：选定

一矩形，该面板就会对应显示矩形

的长、宽、左下角坐标等属性；选

定椭圆，就会显示其长短轴长度及

该椭圆元素外接矩形左下角坐标。

另外，用户还可以直接在面板中修

改被选定元素的一些属性，如对象

的位置、大小等 
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续  表 
面板名称 代 表 窗 体  功 用 简 介  

Stroke（笔
划） 

 

该面板主要设置绘图时的线型、颜

色、宽度等属性，还可以设置箭头

类型、线段端形状、接合方式及是

否压印（Overprint）等等 

Text （ 文
本） 

 

该面板主要用于设置文本的一些

诸如字体（普通、粗体、斜体）、

字号、对齐格式（左、中、右对齐）

属性，还可以设置行距、基线位移

（Baseline shift）、有无特效等。标
签下有 5 个按钮，经常使用第一
个，以后的几个主要可以设置段落

格式、比例、间隔、行列属性等等  

Fill （ 填
充） 

 

该面板主要是用于相对向内填充

色彩等，而且还可以实现滤镜图案

等效果。主要有 9 种填充方式：
None（无）、Basic（基本）、Custom
（自定义）  、Gradient（渐变）、
Lens （滤镜）等。在每种模式下
都有详细的设定，同样具有良好的

交互性。不过，如果你的显示器不

够好的话，可能会有一些小麻烦，

但也很容易克服，视觉效果可能不

太理想 
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续  表 
面板名称 代 表 窗 体  功 用 简 介  

Document
（文档） 

 

该面板主要设置页的显示方式及

是否增加新页，查看指定区域，设

置页面的放置方式、纸张大小，设

置打印机的分辨率等，对于刚入门

者，并不太重要；但是如果要想把

您的作品打印出来的话，这一个面

板是必须精通的 

1.2.3.2  Panels（画板）面板组 

Panels 面板组是 FreeHand 9.0提供的第二类浮动面板组，它的主要功
能是对被选定对象的操作及其颜色类型、颜色模型等属性的设定。该面板

组大致可以分为以下 3类： 
（1）Layers（层）、Styles（样式）、Symboles（符号）组，主要设定

对象的层、样式等属性。 
（2）Colors（颜色）、Mixer（调色板）、Tints（色调）、Halftones（半

色调）组，主要进行和色彩有关方面的设置。 
（3）Align（对齐）、Transform（变换），主要进行对象分布对齐及形

状变换等属性的设置。 

表 1-5  Panels面板功能一览简表 

子 面 板 名  代 表 窗 体  功   能  

Layers（层） 

 

层是比较新的一个概念，

FreeHand 9.0将各个对象放在
不同的层上，就可以使对象重

叠但互不干扰，层面板可以控

制显现与否、是否显示线条、

是否锁定、层的颜色、层的名

称，还可以进行层的添加删

除。在 Option 下拉按钮下，还
有许多扩展功能 
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Styles（样式） 

 

该面板可以提供大量的文本

样式和图形样式，还可以自定

义特殊格式，使用这些套用的

格式快速生成特定格式的文

档或图形。本面板用好可以大

大提高工作效率，在 Option
下拉按钮下有更丰富的功能，

在此不一一赘述 

Symbols（符号） 

 

这是一个 FreeHand 9.0新增的
面板，它的功能是把被编辑的

对象分成若干各组，这样可以

把同类的对象归到同一个组

里面，可实现集成化操作，提

高工作效率。另外，该面板可

以引入或导出文件，而不必自

己去创建一些简单或常用的

对象，只要从做好的模板中提

取需要的对象，也可以自己做

一些模板然后导出以备以后

使用 

Colors（颜色） 

 

该面板主要功能是对于当前

文档或被选定对象显示一些

填充颜色。左起第一个按钮代

表仅仅填充内部区域，第二个

代表填充轮廓线的颜色，第三

个代表轮廓线与内部全部填

满。Options 按钮下有更多内
容，可以设定颜色模式等。这

是一个十分重要的面板，担任

主要的着色工作 
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续  表 
子 面 板 名  代 表 窗 体  功  能  

Mixer （ 调 色
板） 

 

这个面板为创建不同的颜色提

供了方便，为了适合不同习惯

的用户和在某些特定环境下的

方便，该面板有 4 种颜色模式：
CMYK（  青、红、黄、黑）、
RGB（红、绿、蓝  ）、HLS（色
调、亮度、饱和度）、系统取色

器。左数第四个按钮系统取色

器，可以让用户从当前系统颜

色中选取一种颜色；第五个钮

用于把当前选定颜色加入颜色

列表中去。该面板与色调、颜

色面板紧密配合，共同完成颜

色设置 

Tints（色调） 

 

它是调色板的一个辅助面板，

辅助调色板进行更加细微精确

的调色工作，主要功能市微调

颜色，如在调色板中选定红色，

该板中就会出现渐深的红色，

为 0%—100%，拉动滑块儿或
直接输入数字就可以得到不同

的色样。总之，它是主调色板

的一个辅助面板，二者结合好

就可以得心应手地调出各种颜

色 

Halftones（半
色调） 

 

半色调时将连续的色调用尺寸

和角度两个参量来表示的方

法。它可以设定屏幕的模式：

Default（默认）、Round dot（圆
点）、Line（线）、Ellipse（椭
圆）4种网点屏幕模式 
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续  表 
子 面 板 名  代 表 窗 体  功  能 

Align（对齐） 

 

该面板主要功能是使对象对齐

和分布，对齐模式主要有以下

两种：垂直和水平。每种对齐

方式又有无格式、顶对齐、左

对齐、右对齐、分布对齐等。

用户若选定 Align to page 则
表示选定对象以绘图页面的各

边为对齐基线 

Transform（变
换） 

 

该面板主要功能是进行对对象

形状特性的变换。主要可以进

行以下几个方面的变换：Move
（移动）、Rotate（旋转）、Scale
（缩放）、Skew（倾斜）、Refelct
（镜像）。单击对应按钮，变换

的详细参数设置便呈现出来，

具体用法不一一赘述，在后面

章节中还要进一步讲解 

1.2.3.3  Xtras（外挂功能）面板组 

该面板组包括 HTML Output Warning（HTML 输出警告面板）、URL 
Editor（URL 编辑面板）、Set note（备注面板）3 个面板组成。这些外挂
功能主要是提供一些与网页制作类型相关的功能，实现类似 Frontpage 中
超级链接并可以进行检查的功能。具体功能如表 1-6所示。 
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表 1-6  Xtras面板功能一览简表 

子 面 板 名 图  示  功  能  

HTML Output 
Warning（HTML 
输出警告面板） 

 

对于所编辑的网

页 元 素 进 行 检

查，检查链接等

是否正确，结合

File→Publish as 
HTML...等使用 

URL Editor
（URL 编辑面
板） 

 

可以编辑 URL
地址，使对象在

编辑网页元素时

可链接到设定的

URL地址，有超
级链接属性 

Set Note（备注
面板） 

 

可以对对象进行

备注说明，有助

于用户记忆对象

的属性 
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第 2 章  创建路径 

经过第 1章的学习之后，用户是否被 FreeHand 9.0 的强大功能所吸引，
还是被如此多的菜单、面板搞得有点头昏？不过，无论怎样都不要紧张，

刚刚开始接触每个软件都如此，只要迈出关键的第一步，就好办多了。在

这一章里主要讲授路径的创建方法和步骤及其相关工具的使用，下面首先

介绍几个概念。 

2.1  基本概念 

什么是路径？其实路径，就是 FreeHand 9.0 中常用到的对象基本元素
而已，它是可以编辑的线条或形状，包括直线、矩形和徒手画出的曲线等

由节点连成一体的线条。所谓图形，就是封闭的路径。一般来说都添入了

一定的样式和颜色。 
什么是节点？节点，简而言之，就是可以确定线条形状的点。比如，

一条直线的两个端点就是它的节点，这两个节点完全可以确定线性。复杂

的曲线除了节点外还要考虑曲率等因素。如何调整编辑路径呢？除了一些

基本的操作之外，还要学会手柄的用法。这些将在下一章中介绍。 
下面介绍一下 FreeHand 9.0 的绘图原理即绘图的核心思想。众所周知，

要确定一个图形，从数学角度讲就必须知道足够的特征参数。比如，确定

一个矩形（边水平或竖直）需要 4 个参数：矩形的长、宽、中心的横纵坐
标。由此还可以衍生出许多种矩形的确定方法，像确定矩形的对角线两端

点坐标、矩形中心及一个顶点的坐标、矩形的长宽和左下角顶点坐标。这

3 种方法前两种就是在本软件中绘制矩形的方法，而后一种则是在对象面
板中修改矩形属性的方法。 而在本软件中还给矩形加了一个倒角半径，
FreeHand 9.0 就是通过改变这 5 个参数对矩形执行基本操作，其实这就是
矢量绘图的特点。所以，现在您就不奇怪为什么 FreeHand 9.0功能强大，
而且它的文件比同样效果的位图文件小得多也就在情理之中了。 

2.2  绘制封闭路径 

2.2.1  绘制矩形和正方形 

矩形是最常见的四边形，它的绘制主要靠工具箱的矩形工具。绘制矩

形的方法主要有以下两种。 
（1） 两顶点法：单击工具箱的矩形按钮，使鼠标箭头变成十字叉型，
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在画板上拖动，满意后释放，则以单击点和释放点为矩形的两顶点生成矩

形，如图 2-1所示。 
（2） 中心加顶点法：步骤与方法（ 1）相同，只不过整个绘图过程中

须一直按住 Alt 键。绘出的矩形只不过是以单击点为中心另一个点为矩形
顶点而已。另外，这个过程中鼠标箭头也有变化，如图 2-2所示。 

 

图 2-1  两顶点法画矩形 

 

图 2-2  中心加顶点法画矩形 

矩形的面孔太没有个性了，加一个圆角吧！双击矩形按钮，则弹出如

图 2-3 所示对话框。直接输入或者拖动滑动条改变倒角半径后确定，再画
一个矩形就有了圆角。绘制倒角的矩形效果如图 2-4 所示。另外，如果设
置倒角半径为正方形边长的一半，那么绘制出来的正方形就变成了一个圆

形，同样，如果对于矩形使用的倒角半径比较大，那么，绘制出来的矩形

也就成了椭圆了。绘制的圆如图 2-4所示。 

 

图 2-3  矩形工具对话框 
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图 2-4  倒角的矩形 

/ 小技巧 
为了方便用户定位和编辑，可以使编辑页面显示网格（如图 2-4 所示）,

方法是选择菜单 View→Gird→Show 命令，复选有效显示网格；网格大小
也可以编辑，其对应的菜单命令为 View→Gird→Edit，如图 2-5所示。 

 

图 2-5  网格设置对话框 

' 提示 
一般在工具箱按钮右上角有特征折线的双击后会弹出增强功能对话

框。 
那么如何修改绘制好的路径呢？很简单，选择菜单命令 Windows→

Inspector→Object 打开对象浮动面板，浮动面板内依次显示矩形的左下角
坐标、宽度、高度和倒角半径，直接修改即可，如图 2-6所示。 
另外经常用到的面板是 Layer 面板，这也是经常用的面板。Layer（层）

是一个较新的概念。打一个形象的比喻，层好比是一张张胶片，最后的效

果好比是一层层的胶片叠加起来所形成的。一般把同类或关系密切的一组

对象放在同一层中，把容易在编辑中互相干扰的对象放在不同层上。所有

的对象都创建在层上也只能创建在层上，对象都在层内或不同的层之间进

行操作。在图 2-7 中，对号控制层的显示，显示对号显示层；小圆圈控制
是否给层内对象上色，圆圈填充表示层内对象以填充效果显示；锁定控制

该层对象是否锁定，锁头打开表示层可以进行编辑；接下来是层的前景色，

后面是层名；最后一项是显示是否处于编辑状态，显示钢笔图标代表当前

层处于编辑状态。对层的合理使用及以后编辑复杂的作品都很有帮助。 

把倒角设为正

方形边长的一

半，就画出圆 
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图 2-6  Object 面板 

 

图 2-7  Layer面板 

在默认状态下，系统自动为一个新文件创建 3 个层：Background（背
景层）、Guide（导航层）、Foreground（前景层）。背景层上主要进行一些
背景颜色的填充和背景图片的绘制，Guide 是导航层，所有的导航线将绘
制在此层上。Foreground 层绘制前景对象  ，一般默认的大多数对象绘制在
此层上。 

2.2.2  绘制椭圆和圆 

绘制椭圆很简单，方法其实和矩形绘制方法相仿。其实，画椭圆或圆

时，系统就是以外接该椭圆或圆的正常放置的矩形或正方形角点为控制点。
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对于精确定位依然是使用 Object 面板，如图 2-8所示。 
图 2-9 所示主要是对路径作了一些基本的变换（Transform）操作，对

应的菜单 Windows→Inspectors→Transform，对应的变换功能及对应浮动面
板按钮顺序为：移动、旋转、缩放、倾斜、镜像。 

 

图 2-8  Object 面板 

 

图 2-9  变换比较 

图例中列举了旋转和倾斜的效果，对其进行变换操作方法有二：其一

是选择箭头工具后直接双击路径，就会在椭圆周围出现 8 个控制点，在椭
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圆参考位置出现参考点（在面板中为 Center），然后直接拖动作变换（如图
2-10 所示）；其二是在各对应面板中修改各个参数，达到变换效果，如图
2-11所示。 

     

图 2-10 移动、缩放、倾斜、旋转及移动参考点时鼠标图标 

         

图 2-11  Transform面板的旋转、倾斜选项 

2.2.3  绘制多边形和星形 

使用工具箱多边形工具，可以绘制各种常用的多边形，单击工具箱中

对应图标按钮即可。在默认状态下，直接拖动可拖出一正六边形。正多边

形绘制仅有一种方式，即从中心开始，先确定一个顶点，再加上预先设定

好的一些参数即可完成绘制。另外，绘制时如果按住 Shift 键，那么多边形
中心和光标所出顶点位置连线以某一特定角度为增量旋转，且该角度大小

为 90°除以边数。如正六边形应以 90÷6=15 度为增量增加，这更加方便
用户。当然，应用 Transform面板进行变换操作更精确。 
双击多边形工具后会弹出对话框，进行边数、形状的设置。多边形工

具的具体功能见表 2-1。 
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表 2-1  多边形工具按钮功能一览 

项 目  名  称 对  应  窗   体 功    能 

Numbers of Sides
（边数） 

设定多边形或星

形边数，范围为
3~20 

Shape（形状） 

 

Star 为 星 形 ，
Polygon为多边形  

Star Points（星角类
型） 

自动对齐在边数

大于 4 时星形两
邻边在一条线上；

采用 Manual（手
调）表示星角形状

可以通过手工角

度调节滑块调节 

acute/obtuse（角度调
整）  

拖动滑块可

以从 0 到最大允
许值改变星形形

状，仅在手调状态

下才使用 

图 2-12 所示是设置自动和手调后的不同效果，请读者注意观察两者的
不同。 

 

图 2-12  八边星形不同效果 

2.3  绘制开放路径 

2.3.1  绘制直线 

单击直线工具按钮，发现鼠标呈“十”字形，即可画图。不按功能键，



30                       FreeHand 9.0 快学通 

 

则直线起、终点为鼠标单击点和释放点；按住 Shift 键，则直线被约束在 0
°、45°、90°、135°几个方向上；按住 Ctrl 键，则画出直线以单击点为
中心、释放点为一端点；当然，两个功能键也可同时按下，则同时具有二

功能。 
直线可以由直线工具来绘画，也可以由贝赛尔工具、徒手绘工具来完

成，具体的操作方法将在以下章节中进行介绍。 

2.3.2  绘制圆弧 

绘制圆弧的按钮并没有放在工具箱里，而是被放在 Windows→Toolbars
→Xtras tools 下，打开它，找到其上画着 1/4 圆弧的按钮 ，利用它可以画
开放圆弧、封闭圆弧、凸面圆弧、凹面圆弧、不规则圆弧和椭圆弧。双击

该按钮，弹出如图 2-13所示对话框。 

 

图 2-13  圆弧对话框 

需要注意的是，这个工具创键的是圆弧和椭圆弧，按住 Shift 绘制圆弧，
否则是椭圆弧。各复选项功能如下。 
（1）创建开放圆弧：绘制 1/4 开放式圆弧和椭圆弧，取消则绘封闭弧。 
（2）创建反转圆弧：复选该项圆弧上凸，否则圆弧下凹。 
（3）创建内凹圆弧：复选该项时，所绘出的图形是 1/4 圆弧与外接矩

形的切线边连接得到的图形，效果可以参看预览框。另外，选中此项则默

认圆弧封闭，即使选中开放圆弧，也只能绘出封闭弧。 
至于在实际的过程中如何绘制自己需要的弧，请用户自己亲自在实例

中体会。下面仅给一些基本的例子，如图 2-14所示。 

 

图 2-14  几个圆弧的实例 

F 注意 

在绘制过程中，凭感觉绘出的图不会十分令人满意，所以，经常要进
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行一些变换操作，方法与 2.2.2节讲的雷同，在此不再赘述。 

' 提示 
在特效工具（Xtras Tools）浮动面板下还有一些很有价值的按钮，如

涂抹工具、三维旋转工具、镜像工具和图表工具等。以后会将这些工具的

用法陆续穿插在以后的实例或讲解中，但不可能把所有功能讲尽，所以同

时希望本章能对有余力和兴趣的用户起一个抛砖引玉的作用。 

2.3.3  绘制螺旋线 

绘制螺旋线工具在工具箱和特效工具里都有，对应图标为 ，它的用

法与圆弧工具差不多。按住 Shift 功能键拖动，可以限制螺旋线按制定角度
旋转。双击该按钮，弹出对话框如图 2-15所示。 

 

图 2-15  螺旋线设置窗口 

各项设置具体功能如下。 
（1） Spiral type（螺旋类型）：第一种螺旋线是等间距的，简而言之，

各圈等距离（不显示增量选项）；第二种螺旋线各圈之间距离一对数形式逐

渐增大。其面板如图 2-15 所示。有一个 Expension（增量）项，可以设定
增量从 1%~200%。比如，设定为 20，即使说后一圈间距比前一圈的极径
大 20%。 
（2）Draw by（绘制方式）：包括两项，一项是 Rotations（螺旋线角

度），选中后下一项为螺旋线圈数，可利用文本框或滑块编辑圈数（如图

2-15 所示），设定值范围为 1~200；另一项为 Increments（螺旋线间距），
选中后下一项变为螺旋线宽度，用同样方法可进行编辑（图中未给出），范

围为 1~200。 
（3） Draw from（螺旋起点）：该项包括 3 个选项，分别为 Center（中
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心）、Edge（边缘）、Corner（对角）。选定中心项表示鼠标拖动起始点为螺
旋中心，释放点为螺旋终点；选定边缘表示鼠标起始拖动点为螺旋终点，

释放点为螺旋中心；选中对角表示鼠标起始点为螺旋最大直径两端点，释

放点为螺旋终点。 
（4）Direction（螺旋方向）：选定螺旋方向，第一项表示顺时针方向，

第二项表示逆时针方向。 

 

图 2-16  几个简单图例 

2.4  使用徒手绘图工具 

2.4.1  简介 

FreeHand 9.0 的最强大功能之一就是徒手绘图工具，这类工具主要有
徒手绘工具、贝赛尔工具和钢笔工具，它们既能绘制开放路径又能绘制封

闭路径。在绘图之前有必要介绍一下节点和手柄的概念。 
法国数学家贝赛尔认为：任何一条曲线都可以看成由两个端点再外加

许多中间特征点构成，每一个中间特征点都有两个切线控制手柄，一个控

制曲线到达该点的方式，另一个控制曲线离开该点的方式。这些控制点就

是节点，而切线控制手柄就是以后要经常用到的调节曲线曲率和方向的手

柄。 
根据贝赛尔理论衍生出了贝赛尔曲线，该曲线把节点分成了 3 类，即：

平滑曲线点、角点、连接点。其特点如下。 
（1）滑曲线点：两曲线平滑过渡的控制点，该点两控制手柄在一条直

线上，相互关联。 
（2）角点：节点两侧曲线过渡存在突变，从数学角度讲该点左右导数

不同即是说角点两侧切线方向不共线。 
（3）连接点：控制点是直线和曲线的切点。 
手绘工具功能强大，但运用起来最难的是贝赛尔工具，有时候会产生

匪夷所思的效果，所以用户绘制时一定要注意鼠标的速度和连续性。 

2.4.2  使用贝赛尔工具 

上一节讲了手绘的基本知识，下面简要介绍以下 3 种节点的创建方法。 
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（1）平滑曲线点：单击贝赛尔工具图标按钮，按住 Alt 键单击鼠标即

可创建节点。单击平滑曲线点，该点变成空心小圆圈“ ”，并且曲线点

两边出现互相关联共线的两手柄。 
（2）角点：单击贝赛尔工具图标按钮，单击鼠标即可创建节点。单击

角点会发现它变成一个空心小方块“ ”，而且角点的控制手柄数不尽相同。 
（3）连接点：单击贝赛尔工具图标按钮，按住 Alt 键单击鼠标右键即

可创建节点。单击它发现其变成空心小三角形“ ”，一般连接点仅有一

个手柄。 
那么，如何绘制线形？很简单，线是由一系列点连缀而成，只要依次

绘出特征点再加上该点的手柄类型即可。可以按住 Shift 键控制 0°、45°、
90°、135°几个方向。下面使用贝赛尔曲线创建的两个简单路径，如图
2-17所示。 

/ 小技巧 
FreeHand 9.0附带有点、格子等的捕捉工具，菜单项在 View→Snap to 

Gird（Guide,Point），复选后可实现捕捉功能。捕捉选项时，先要启动绘图
功能，使鼠标箭头呈“十”字形，捕捉到点时，“十”字形右下角会出现相

应标记，表明鼠标已移动到该点，可以辅助绘图。图 2-17 所示的左图中不
清楚的地方，是由于被节点遮住的结果。 

        
图 2-17  两个图例 

单个节点没有大小，当用户取消选择后，节点和手柄被隐藏，屏幕上

将看不到节点和手柄。所以用户对一些难于寻找的节点最好记下大致位置，

也可以首先框选许多节点然后从其中选择相应节点，以便以后用工具选择

起来更加方便。还有绘制封闭路径时注意首尾相连，否则将来填充颜色会

比较麻烦。 
另外，若要进行节点精确定位或者改变节点类型、显示手柄等功能，

就必须使用对象面板，如图 2-18所示。 
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图 2-18  对象面板及图例 

表 2-2  贝赛尔曲线的对象面板功能一览简表 

项  目  名  称 功      能 

Path（路径） 
对象名的种类。对节点来说，面板显示节点所在

的对象的属性 
Even/odd fill（偶/奇填
充） 

复选以奇/偶方式填充，则偶次重叠部分为镂空；
如不复选此项，则偶次重叠部分也是填充区域 

Point（点数） 对象包含节点的个数 
Closed（封闭） 复选有效则路径起点与终点自动以直线相连 
Flatness（平滑度） 决定绘制曲线的平滑度。数值越小越平滑 

Point type（节点类型） 
3 种图标依次代表平滑曲线点、角点和连接点。
切换 3个图标可以改变节点类型，进而改变路径 

Point location（节点位
置） 

显示节点坐标，若节点为两个以上该项无效 

Handles（手柄） 控制手柄的显示方式 
Automatic（自动） 恢复被删除的节点手柄 

2.4.3  使用钢笔工具 

钢笔工具在工具箱中，和贝赛尔工具基本一样。二者最主要的区别是：

贝赛尔工具创建的节点没有确定的手柄，而用钢笔工具创建的节点有确定

的手柄。钢笔所创建的节点手柄是由用户拖动鼠标而成的，可以预览，随

时调整。相比之下，贝赛尔工具是自动分配节点手柄，不能进行预览，所

以钢笔可以尽量减少绘图的调整时间。下面简要介绍一下钢笔工具的用法： 
（1）绘制角点：单击页面产生无控制柄的角点，移动至另一处再单击

又产生一个角点，两点自动连成一条直线。同样结合 Shift 键可以在特征方
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向上绘制直线。 
（2）绘制曲线点：在所需节点处单击拖动则在释放点和单击点之间生

成手柄，调整手柄即可调整所绘曲线形状。对绘制好的节点，可单击选中

后，移动节点或调节手柄改变线形。 
（3）绘制平滑连接点：按住 Alt 键在所需绘制节点处单击并拖动至另

一点释放，即可得到一连接点。其他基本与曲线点绘制方法一样。 
图 2-19 所示是两个用钢笔绘制的图例，看是不是与贝赛尔工具绘制的

图差不多。其实，二者各有长短，应该互补才能得心应手。 

       

图 2-19  图例 

2.4.4  使用普通徒手绘工具 

2.4.4.1  使用 FreeHand （徒手绘）  
双击“普通徒手绘”按钮，打开如图 2-20所示的对话框。 

 
图 2-20  “徒手绘”对话框 

在 FreeHand 9.0选项下，该对话框有 Precision（精度）、Draw dotted line
（绘断点线）两项，功能分别如下。 
（1）精度：控制绘制的路径与鼠标轨迹的拟合程度。精度数值越高拟
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合程度越好，相反，拟合程度越差。但是拟合程度差时绘制的曲线很光滑，

视觉效果好，精度太高就会在路径上有很多突变。 
（2）绘断点线：该项复选有效，鼠标轨迹用断续的特征点来表示；取

消该项，则用连续的曲线来表示，如图 2-21所示。 

 

图 2-21  绘断点线复选与否的比较 

F 注意 

图 2-21 左图所示为取消复选后绘制的曲线，右图为复选后绘制的曲
线，而且当释放鼠标后那些点会自动连缀成曲线。另外，这些点也不一定

都是节点，千万不能混淆。 

/ 小技巧 
用户在绘图过程中如发现错误，想返回重画，可按住 Ctrl 键不放，同

时不能释放鼠标沿着鼠标轨迹向回移动就可以擦掉刚刚绘制的部分，直到

满意为止，然后可以继续以涂抹路径的最后一点继续接着进行绘制工作。

此技巧适用整个手绘工具。 

2.4.4.2  使用 Variable stroke （画笔） 
在徒手绘对话框中，选择 Variable stroke（画笔）项，接下来的选项会

发生变化，如图 2-22 所示，各选项分别为 Precision（精度）、Draw dotted line
（绘断点线）、Auto remove overlap（重叠自动删除）、Width（线宽设置）。 
各选项的功能如下（前两项不再赘述）。 
（1） Auto remove overlap（重叠自动删除）：复选该项，若所绘路径

有重叠交叉部分则自动将重叠部分内的边缘内线段删除，效果如图 2-23 所
示。所谓重叠删除是对同一条路径中的重叠部分的删除，但是对于两个不

同路径是无效的。 
（2）  Width（线宽设置）：这一项调节的是画笔绘图的线条的粗细，

设定值从 1~72，此项就是画笔与徒手绘的最大区别。线条是可以改变粗细
的，而且在绘制过程中就可以改变线宽。在鼠标绘制过程中，按下键盘方

向中的向右的箭头键或数字 2 键可以使线条变宽，按下键盘方向中的向左
的箭头键或数字 1 键可以使线条变窄，至到各自的限定最大或最小的极限
值，如图 2-24所示。 
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图 2-22 “画笔工具”对话框 

 

图 2-23  重叠自动删除效果 

 

图 2-24  两个图例 

/ 小技巧 
在绘图过程中，如果在某一点按下 Alt 键，则以下的一段直线为以按
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下 Alt 键的点为一端点、以释放 Alt 键的一点为另一端点的直线，还可以
旋转直线来控制直线倾斜的角度。 

2.4.4.3  使用 Calligraphic pen（书法笔） 
FreeHand 9.0还有一种功能强大的手绘工具 ,它就是书法笔。单击“手

绘工具”按钮，在对话框中选择 Calligraphic pen，如图 2-25所示。 

        

图 2-25  “书法笔”对话框 

其中有 Precision（精度）、Draw dotted line（绘断点线）、Auto remove 
overlap（重叠自动删除）、Width（线宽设置）、Angle（笔锋角）等几个选
项，其主要功能和用法与前面的画笔工具差不多，对于控制特性相同的部

分不再赘述。 
书法笔工具对话框的特色选项功能如下。 
1．Width（线宽）：其下选项有二，其一为 Fixed（固定）,即在绘图前

指定线宽，在一次绘图操作中不能改动，调节的方法是在编辑框中输入

0~72 之间的数字或拖动滑块儿。其二是 Variable（可变线宽）,这方面的设
置大致与画笔设定方法相同，绘制时线宽的调节方法也是一样，详见前一

节。 
2．笔锋角（Angle）：这个工具主要是模仿书法笔的笔锋，修改编辑框

的数字或拖动旁边圆钮就可改变笔锋角，从而在绘画中使用一定的笔锋。

如图 2-26、图 2-27所示。 

 

图 2-26  30°和 60°笔锋的比较图例 

笔粗可变 
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图 2-27  用 30°和 75°笔锋绘制的“飞”字图例 

经过以上的图例比较，用户现在应该明白什么是笔锋了。笔锋对于一

条横线来说就是起笔部分的倾斜边缘与水平线的夹角，通过调节笔锋会产

生一些需要的效果，对于绘图有很大帮助。 

' 提示 
在徒手工具不同模式下，徒手绘的图标是不太相同的。如图 2-28 所示

从左到右依次是徒手绘、画笔、书法笔模式，根据对应图标可以知道当前

正在使用什么模式，这对绘图有一些帮助。 

       

图 2-28  不同模式下徒手绘工具的图标 

到这里，创建路径这一章的讲解就结束了，不知用户有何收获，是否

本书对您有些帮助呢？本书对于一些比较简单或认为较简单易学的知识并

未深刻讨论，所以学完本章以后可以对实例进行一下实际操作，相信您会

对本章内容有一个更加深刻的了解。 
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第 3章  编辑路径 

通过上一章的学习，用户了解了什么是路径及如何使用各种工具创建

路径。在这一章里，主要讲授如何选择进而编辑节点和路径。本章主要介

绍对节点和路径进行的添加、选择、删除等基本操作以及对路径进行连接、

组合变形等简单的效果操作。 

3.1  基础知识 

路径一般可以分为封闭路径和开放路径。路径这个概念是具有矢量性

的，它没有分辨率，可以被任意地放大或缩小，不会产生损失也不会影响

图形的清晰度。并且，作为一个矢量概念，路径有许多数学特性，诸如长

度、宽度、方向性等等。在存盘文件中保存的是路径的数学性质参数，而

并不像位图一样将每一个点的特性记录进文件，所以所有矢量图形的存盘

文件都要比同样的位图文件占用的磁盘空间小。 
既然路径分为开放和封闭两种，那么这两种路径各有什么特性呢？开

放路径，是指具有两个端点的图形对象。开放路径是不能填充颜色的，仅

能改变路径本身自己的颜色。封闭路径是指没有端点、仅具有内部点的图

形图像，它具有可填充性，可以在图形内部填入规定的颜色和样式。这就

牵涉到第 5章介绍的知识了，请参阅第 5章相应的内容。 

 

图 3-1  几种路径的图例 

另外，路径还有另外一种分法，就是：自由路径、复合路径、组合路

径 3 种。自由路径是指单独的没有同其他路径相结合的路径，这种路径是
简单的又是可以编辑的。复合路径是指由自由路径连接而成的或者有字符

转换而成的路径（字符转换而成的路径本章暂时不讲）；组合路径是指已经

由几个路径组合并且成为一个对象的路径。组合路径不能直接对其中的节

点编辑，必须进行解组操作转换成自由路径后才能编辑。例如椭圆、矩形
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等就是组合路径。 
下面再深入讨论一下节点的问题。节点是用来控制图形性质的点。首

先，节点位于路径之上。这一方面需要大家注意，例如圆的圆心也可以控

制圆的性质，但是它不是节点，它不位于路径之上，直线的中点也不是节

点，虽然它位于路径之上。节点的位置及数目的多少一般是由系统计算得

出的，当然一些个人设定或类似钢笔的专用工具绘图除外。对于不规则图

形路径和曲线来说，影响节点数目和位置的条件很多，如路径曲率等。 

3.2  选择路径与节点 

3.2.1  选择路径 

要对一个路径进行编辑，首先要选中路径。选中单个路径的方法很简

单，主要利用工具箱中的箭头工具。单击箭头工具图标按钮，再将光标移

动到某一节点或路径上，单击就可以选中它。被选中对象的节点和控制手

柄就会显现出来，并且节点会以黑色实心小方块的形式显示出来，然后就

可以进行编辑了。 
对于多个路径可以用框选法来选择，也可以用多选法即 Shift 键法。 
框选法主要步骤是：在系统默认状态下，单击箭头工具后，在绘图区

域内按住鼠标左键并拖拽出矩形区域后释放鼠标，对于组合路径完全被包

含在矩形内的路径被选中，非组合路径被选中一部分即可选中整个路径（但

只能选中部分节点），如图 3-2 所示。选中的节点呈空心显现，路径被选中
而路径上节点未被选中的呈黑色小方块。 

     

图 3-2  选择的图例 

多选法主要是使用 Shift 键，在单击箭头工具后按住 Shift 键，逐个单
击对象可以从许多对象中选择用户需要的对象；对于选中的对象按住 Shift
键单击可取消选取。 

/ 小技巧 
双击箭头工具按钮弹出对话框复选 Contact Sensitive,可以实现敏感选
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择功能，即框选部分组合路径时也可以选中该对象。 
另外，还可以选择菜单 Edit→Select 下的子菜单，如图 3-3所示。 

 

图 3-3  子菜单 

其具体功能如下。 
（1）All（全选）：除了位于不可见层和页面外的对象之外，选中当前

页面内所有对象。 
（2）All In Document（当前文件全选）：选中当前文件中所有对象。 
（3）None（无）：取消对象的被选定状态。 
（4）Invert Selection（反向选择）：选择反向选定功能。 
（5）Superselect（超级选择）：选中一个多层的群组中的一个对象，

再选择此命令，则整个群组均被选中。 
（6）Subselect（选定组对象）：选中所选组中的所有对象。  
取消选择很简单，可以在空白处单击也可选择菜单的“无”选项。 

3.2.2  选择节点 

节点的选择方法和选择路径差不多，而且一般来讲，大多数情况下首

先选定对象，再在被选定对象上选定节点，尤其在节点不是很明显时。选

择某一个节点一般单击即可，选中后节点以反白显示。对于被选中的节点

一定以空心方式显示，有手柄的显示手柄，但是不同类型节点的空心图形

并不完全一样，例如角点为空心小方块，平滑曲线点为空心小圆圈，连接

点为空心小三角形等。路径被选中而节点未被选中者，节点将以黑色小方

块形式显现。一般编辑是看不清的，放大一下视图比例效果更好，如图 3-4
所示。 
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图 3-4  节点选择的效果 

3.3  添加和删除节点 

3.3.1  添加节点 

3.3.1.1  在路径外添加节点 

在路径外添加节点，可以借助钢笔工具和贝赛尔工具，下面将举例说

明如何用这两种工具添加节点。其步骤和主要方法如下。 
（1）现在有待编辑线段 AB，首先选定线段端点 B。 
（2）单击钢笔工具按钮，在路径外一点 C 单击，就可以从 B 点引出

一线段 BC,且此时 C点处于被选中状态。 
（3）使用钢笔工具，单击 C 点后拖动至 D 点出现手柄 CD，再在 E

点单击，绘制出曲线 CE，调节手柄 CD 可以改变曲线形状。整个过程如下
图 3-5所示。 

          

图 3-5  在路径外添加节点 

F 注意 

第二步中可以用贝赛尔工具代替钢笔，第三步则不可以。另外，图 3-5
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中的 D点并不在路径中，它是 C点手柄端点。 

/ 小技巧 
在选择点的过程中，建议用户最好打开捕捉点选项，其位置在 View

→Snap to point 或使用快捷键 Ctrl+Shift+Z，方便用户进行点的选择和下一
步绘图。 

3.3.1.2  在路径上添加节点 

有时用户希望能在路径上添加一些节点，这就要依托钢笔工具和贝赛

尔工具的强大功能，下面是在一线段路径内添加节点的过程。 
添加节点方法很简单，选中线段后，单击钢笔工具，此时钢笔在页面

内而不在线段上时，“十”字光标右下角为空心方框；在线段上时“十”字

光标右下角为小三角形。当鼠标移至线段上的合适位置时单击，即可添加

一节点，再拖动即可添加手柄。如此反复，可添加若干节点。整个过程如

图 3-6所示。 

 

 

图 3-6  在线段中添加节点 

若要给椭圆或者矩形以及其派生类添加节点就稍微麻烦一些，主要因

为这类图形在 FreeHand 9.0中是组合路径，不能直接添加节点，必须首先
解组。当然对于所有组合路径都一样，必须先解组再添加节点。对于一个

未解组的路径，比如椭圆，添加节点的方法和步骤如下。 
（1）选中椭圆后，选择菜单栏 Modify→Ungroup（解组→修改）命令，

使之变成一个可分离曲线，出现 4个节点。 
（2）单击钢笔工具按钮，移动光标至合适位置，添加方法与线段添加

节点方法相同，并可以用箭头工具适当调节节点位置。过程如图 3-7 所示。 
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图 3-7  给椭圆添加节点并调整 

3.3.2  删除节点 

节点的删除很简单也有很多方法，对于非组合路径只需选中要删除的

节点，按下 Delete 键或者 Backspace 键即可；对于组合路径，必须先解组
再加以删除。 

F 注意 

某些时候删除路径上某些节点会很大程度地改变路径的形状，所以删

除节点时，一定不能乱删。 

3.4  删除路径 

3.4.1  删除整个路径 

选中整个路径，按下 Delete键或者 Backspace 键即可达到目的。 

3.4.2  删除部分路径 

删除部分路径主要借助小刀工具 ，下面介绍一下它的参数设置和用

法。双击“小刀”图标按钮，弹出如图 3-8所示对话框。 
各项功能及设置如下。 
（1）Tool Operation（工具操作形式）：下有二选项，FreeHand 表示切

刀的路径是任意的和光标走过轨迹一样；Straight 表示切刀路线仅能是鼠标
起点和终点的连接直线。 
（2）Width（切刀宽度）：表示小刀在切的过程中的切刀宽。 
（3）Options（选项）：其下有两个互不干扰的复选项。Close cut paths
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选项表示使用小刀将路径切开后自动在路径分割处用直线段连接，使路径

闭合。Tight fit复选项表示分割后产生的路径与实际路径紧密符合。 

 
图 3-8  小刀工具对话框 

下面我们就暂举一例用小刀工具分割一个椭圆，至于更改参数设置的

效果请与实际效果联系。首先绘制一个椭圆并选定它，接下来设置小刀参

数（如图 3-8 所示），在页面中像画线一样在欲分割位置画线分割路径，从
对象浮动面板上可以看到前后的不同，对象名由 Ellipse 变成 2 Objects。选
中其中一个对象，移动即可实现分离。整个过程如图 3-9所示。 

     

     

图 3-9  小刀工具的使用图例 
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3.5  转换路径与节点 

3.5.1  转换节点 

点的转换可以借助对象面板的点的类型按钮 来进行。选定一个

节点后，对象面板的点类型中就会显示出该点的类型，究竟是一个平滑曲

线点还是一个角点、连接点，只要在不同按钮上单击即可实现在不同类型

节点间切换。 

3.5.2  自由路径与复合路径的转换 

3.5.2.1  复合开放路径 

复合开放路径主要利用菜单栏 Modify→Join（修改→复合）命令。下
面以实例说明，首先创建如图 3-10 左图所示的 3 条开放路径，并选中它们，
然后选择 Modify→Join命令，即可完成。如图 3-10右图所示。 

     

图 3-10  复合开放路径示例 

3.5.2.2  复合重叠封闭路径 

下面仍以一个典型的示例进行讲解，其步骤如下。 
（1）创建 3 个封闭路径：矩形、圆形、椭圆，分别填充蓝、红、黑 3

色，如图 3-11所示。 

 

图 3-11  绘制 3 个封闭路径 
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图 3-12  将绘制图形重叠 

（2）将 3个路径叠放在一起后，再框选 3个路径，如图 3-12所示。 
（3）选择菜单栏 Modify→Join 或使用快捷键 Ctrl+J，可获得如图 3-13

所示的效果。 

 

图 3-13  奇偶复选有效复合效果 

 

图 3-14  奇偶复选无效复合效果 

@ 提示 
要想实现如图 3-14 所示的效果，只要打开对象浮动面板，取消奇偶填

充（Even/odd fill）即可。其实，这一项复选有效则偶数层叠在一起的部分
会透明即失去填充。取消此选项则不管重叠的部分的奇偶全部填充。 

F 注意 

关于路径的层次问题，一般来讲，先绘制的图形在内，后绘制的在外，

而且复合颜色为最里面路径的颜色。其实，对象的顺序也可以调节，选定
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路径后，右击鼠标再选择 Arrange 下的子选项可以调节对象的层叠顺序。
另外，关于如何给对象填充颜色，请参看第 5章的相关部分。 

3.5.2.3  复合不重叠封闭路径 

复合不重叠的封闭路径的方法和上一节差不多，只不过不存在奇偶填

充的问题。本节仍以一个示例为范例做讲解。 
首先，依次绘制如图 3-15 所示的矩形、椭圆、圆，分别填充红、黄、

黑 3色；框选 3个路径；选择复合命令。复合后效果如图 3-16所示。 

 

图 3-15  绘制非重叠对象 

 

图 3-16  复合后的效果 

3.5.2.4  复合路径转换成自由路径 

自由路径连接成复合路径，复合路径分解而成自由路径。分解复合路

径很简单，选中复合路径后，选择 Modify→ Spilt 菜单命令或使用
Ctrl+Shift+J 组合键即可。但是各独立路径不能恢复复合前的各对象属性，
这一点广大用户要切记。复合效果如 3-16 图所示，分解后的效果如图 3-17
所示。 
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图 3-17  分解后效果 

3.5.3  组合路径与非组合路径转换 

3.5.3.1  非组合路径转换成组合路径 

组合路径是指将一系列的路径组合为一个整体，将不同的路径捆绑在

一起，作为一个整体来处理。组合路径与复合路径的一个重要区别是：组

合后的各对象仍然保持各路径自己原有的属性，而复合后的对象都变成了

一个属性。 
组合主要利用菜单命令 Modify→Group（修改→组合）或快捷键

Ctrl+G。首先创建如图 3-18 左图所示的圆和两个正方形，其中的最小的正
方形可以旋转得到，并依次依照图 3-18 左图排列好；框选 3 个对象；选择
组合命令，这样就得到如图 3-19所示的效果。 

 

图 3-18  组合前的 3 个路径 
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图 3-19  组合后的效果 

F 注意 

路径组合后，原先各路径上的控制点消失，取而代之的是组合后新对

象的控制点，表明已经组合为一个对象。 
3.5.3.2  组合路径转换成非组合路径 

将组合路径转换成自由路径，使用的命令是菜单命令 Modify→
Ungroup（修改→解组）或者使用快捷键 Ctrl+U。选中要解组的组合路径
后，执行命令即可。 

3.6  连接与变形路径 

3.6.1  连接路径 

复合路径是连接路径的一类方法，另外还可以使用钢笔工具在辅助点

捕捉功能，将路径的节点用曲线连接起来。下面再介绍一些使开放路径变

成封闭路径的方法。开放路径和封闭路径在应用上最大的不同是封闭路径

可以填充颜色和样式，而开放路径不可以。所以也经常用这种方法验证路

径是否封闭。 
3.6.1.1  开放路径端点连接 

如图 3-20 所示，两个分别使用钢笔工具和徒手绘工具创建的开放路
径，使其闭合的步骤如下。 
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图 3-20  两个开放路径 

（1）选中折线路径，并打开对象控制面板，可以看到没有选中面板中
的路径封闭（Closed）。如果选中封闭路径，即可完成路径的封闭，观察效
果如图 3-21所示。 

 
图 3-21  封闭开放路径 

（2）对于手绘曲线也是按第一步过程进行，效果如图 3-21所示。 

F 注意 

用这种方法仅能用直线来连接开放路径端点，以封闭路径。 
3.6.1.2  不同路径间连接 

下面仍然以示例说明不同路径连接的方法，如图 3-22 所示，分别从正
八边形、椭圆上用小刀各截取一部分下来；然后，将两个路径如图 3-23 所
示放置，按下 Ctrl+J 键复合路径，然后填充颜色，如不能填充则可以在对
象面板内将 Closed选为有效，即可填充颜色，说明路径封闭。 
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图 3-22  两个独立的路径 

 

图 3-23  合并后的封闭路径 

3.6.2  路径的变形 

路径的变形工具在 FreeHand 9.0中除了可以用箭头拖动和贝赛尔工具
外，经常用到的还有自由转换工具（Freeform），旋转、倾斜等。前两种比
较简单，主要是拖动节点和手柄进行变形操作；旋转、倾斜前边已经有所

介绍。所以，这一节主要讲一下 Freeform（自由转换工具）的用法和参数
设置。 
用鼠标双击“自由转换工具图标”按钮，就弹出如图 3-24 所示的对话

框，其参数设置和功能如下。 
（1）Tool Operation（工具操作）：这里有两个选项，分别是 Push/Pull

（推拉工具）和 Reshape Area（区域整形工具），二者仅能选其一。图 3-24
左图为推拉工具面板，如图 3-24右图所示为区域整形工具面板。 
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图 3-24  自由转换工具对话框 

（2）Push settings（推设置）：这项在选择推拉工具时出现，主要设置
推变形参数。Size 表示变形曲线变形部分尺寸的大小；Precision 表示曲线
变形精度，精度越小图形变化越缓和。另外，在推拉设置下不可以推拉时，

光标如 形状；当选中图形可以推拉时，光标如 形状；按下鼠标左键即

可进行变形操作。正六边形变形示例如图 3-25所示。 

 

图 3-25  正六边形变形示例 

（3）Pull Setting（拉设置）：在选择推拉工具时出现该项，它主要设
置推拉变形参数。Bend 表示拉动时变形方式，主要可以选择从长度上和在
两点间两种方式，二者为互排斥选项。长度参数使用选项下的编辑框或滑

块调节。变形效果如图 3-26所示。 

 

图 3-26  不同设置的变形效果 
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（4）Settings（设置）：这一项仅在 Reshape Area（区域整形工具）有
效时才可见。区域整形状态下变形还作用于路径经过的地区。该设置下有

3 项参数：Size、Strength、Precision 分别代表变形部分的尺寸、变形剧烈
程度、变形精度，它可以设置比较小的变形。如图 3-24右图所示。 
（5）Pressure（压力）：该选项区有 Size（尺寸）和 Length（长度）

两个复选框，可以设置变形的尺寸及长度大小是否与操作速度有关。 
总之，该工具用法很灵活，就像同样是一支毛笔，书法家可以用它写

出价值连城的书法珍品，而放在庸人手中仅能当一把毛刷子用。所以，用

户应该在讲解后多做练习，挖掘出书中没有或者没有做到的东西才能真正

有所收获。 

3.7  组合路径 

组合路径在以后的编辑中有很重要的地位，这是因为在大多数作品的

对象中，十分规则的基本图形很少，大部分是通过对基本图形路径进行组

合及渲染等操作得到的。通过对基本路径及手绘路径的变形、连接、组合

等编辑操作就几乎可以得到任意图形。 
组合路径功能的实现主要依靠菜单栏 Xtras→Path Operations（特效→

路径操作）下的子菜单命令来实现，它们分别是：Crop（剪切）、Divide
（分割）、Expend stroke（线条加粗）、Inset path（内置路径）、Intersect（交
叉）、Punch（穿孔）、Transparency（透明）、Union（联合）。 

3.7.1  剪切 

路径的剪切其实就是求最外层图形与其内层图形的重叠部分，外层路

径是剪刀，实际上就是数学上所谓的“布尔求差”。这样可能还是不好理解，

下面以一个例子说明一下剪切路径的使用方法和效果，如图 3-27 所示。其
具体步骤如下。 
（1）在空白页面上绘制矩形、正六变形和椭圆，矩形在内层，其次正

六边形，椭圆最外，并重叠成如图 3-27 的状态，填充不同颜色以区分层位，
如图 3-27左图所示。 
（2）框选所有路径，并选择剪切命令，可获得以椭圆为剪刀，以其余

二路径为被剪对象的路径对象，如图 3-27右图所示。 

      

图 3-27  剪切效果示例图 
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/ 小技巧 
在执行剪切命令时，按住 Shift 键执行此命令，则可以保留剪切操作

的原始对象，如图 3-28 所示。当然，图中已经把原始对象移动了位置，以
免挡住获得的结果。其他命令如穿孔也有此功能。 

 

图 3-28  使用 Shift 键可以保留原始对象 

3.7.2  分割 

分割命令可以使几个对象的重合部分独立出来，并从原始对象中去除

重合部分。下面以示例说明。步骤如下。 
（1）在空白页上新建矩形和椭圆，设置位置布局如图 3-29 左图所示。 
（2）框选二者并执行分割命令，再将得到的 3 个对象移动开一定的距

离。如图 3-29右图所示。 

    

图 3-29  分割效果示例图 

@ 提示 
为了得到某一类的路径，功能选择上一般有很多种方法。比如，如果

想要得到如图 3-29 右图所示的矩形和椭圆的公共部分，除了可以使用分割
的方法外，还可以使用剪切、交叉的方法。 

3.7.3  线条加粗 

这是一个加粗路径轮廓的工具，同时，它是既对开放路径有效也对封

闭路径有效的工具，用此工具处理后的路径，会在内外生成两个新路径并

且与原路径复合形成一个复合路径。默认状态下，以原路径颜色加以填充。
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选择菜单栏下该命令，弹出如图 3-30 所示的对话框，可以进行参数设置。 

 

图 3-30  加粗线条对话框 

下面以实例说明，如图 3-31所示。步骤如下。 
（1）在空白纸页上创建一正六边形和一段开放路径，如图 3-31 左图

所示。 
（2）选中开放路径，选择加粗线条命令，在对话框中设置线宽为 5，

然后确定。 
（3）选中正六边形，设置线宽为 15，连接部分为第二种过渡，然后

确定。效果如图 3-31右图所示。 

        

图 3-31  加粗线条效果例图 

3.7.4  内置路径 

内置路径主要是通过在路径内部或者外部添加一些与原路径外形相似

的路径，以产生特殊的效果。选择菜单栏下的内加路径命令，弹出如图 3-32
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所示的对话框。 

 

图 3-32  内置路径对话框 

下面以一示例说明，如图 3-33所示。步骤如下。 
（1）在空白页上绘制一正六边形。 
（2）选中该正六边形，选择内置路径命令，对话框参数设置如图 3-32

所示。效果如图 3-33右图所示。 

         

图 3-33  内置路径效果图例 

3.7.5  交叉 

交叉组合方式是得到所有被选中路径的公共重叠部分，最后仅能获得

一个路径，结果与路径层叠顺序无关。如果是两个路径交叉，得到的结果

与剪切没有什么区别，但是 3 个或更多时，区别很明显：剪切获得的是最
上层与其他每个层的重叠部分，交叉获得的是所有对象的公共重叠部分。

下面以实例说明，请与剪切对照。 
步骤如下。 
（1）如图 3-34 左图所示，在空白页上绘制正方形、椭圆和正六边形，

并叠放如图。 
（2）框选 3个路径，选择交叉命令，得到效果如图 3-34右图所示。 

设置路径间间距变化

情况，有等距、渐大、

渐小 3种情况 

线连接部分过渡类型 
 

斜角限量，设置线的平

滑程度 
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图 3-34  交叉效果图例 

3.7.6  穿孔 

穿孔是针对几个有重叠的路径，将第一个选中的路径作为孔的形状，

其余作为穿孔对象，生成新路径。且原路径保留原有路径的颜色等属性不

变。下面以示例说明，如图 3-35所示，其步骤如下。 
（1）在空白页面上创建如图 3-35 左图所示布局的正六边形和五角星。 
（2）框选二者，选择穿孔命令，得到效果如图 3-35右图所示。 

       

图 3-35  穿孔效果图例 

3.7.7  透明 

透明命令是用来使几个重叠的图形在重叠部分产生透明的效果，有一

点需要说明，这种组合方式目前还不支持渐变填充，要想实现此功能，只

能借助其他特效。 
选择透明命令，会弹出如图 3-36 所示的透明属性设置对话框。当参数

为 100 时，使用内路径颜色进行填充；参数为 0 时，使用外路径颜色进行
填充；参数为中间值时，按一定比例混合内外路径色进行填充。透明参数

一般设置在 50 左右，调节的方法为直接在编辑框中键入 0~100 的数字，
或者拖动滑块改变编辑框中数字。 
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图 3-36  透明度设置对话框 

下面以实例讲解，如图 3-38所示。步骤如下。 
（1）在空白页上创建五角星和椭圆，并布局、染色，如图 3-37 所示。 
（2）框选二路径，选择透明命令，透明参数设为 54，效果如图 3-38

所示。 

 

图 3-37  创建的路径 

 

图 3-38  透明效果图例 

另外，透明效果的实质其实是在执行透明命令时生成一个新的路径，

该路径形状与两个被选择路径的重叠部分的形状、位置均相同，但是颜色

是两个被选择路径颜色按一定比例调配而成（如图 3-39 所示），借助它就
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可以产生透明的效果。 

 

图 3-39  透明效果的实质 

/ 小技巧 
在完成透明效果后，用户可以尝试调换各路径的层叠顺序，这样会产

生一些令您惊喜的效果，用户不妨尝试一下。 

3.7.8  联合 

联合命令是将重叠部分细节略去而仅仅保留整个所选图形路径的外部

轮廓，最后生成路径的颜色与最内层路径颜色一致。下面仍以实例进行讲

解，如图 3-40所示。其步骤如下。 
（1）绘制一椭圆填充以黄色，再绘制一正圆并填充以黑色。再将二图

形路径布局按照图 3-40左图所示。 
（2）框选二图形路径，选择联合命令，效果如图 3-40右图所示。 

       

图 3-40  联合效果图例 

F 注意 

组合（Group）、复合（Join）、联合（Union）三者功能效果好像差不
多，其实还有很多不同：组合是将两个路径相互连接成一个路径，并且相

对位置固定，但每一部分还保持原来的颜色和样式属性；复合不仅是路径

相互连接，而且路径本身的颜色和样式也会发生变化，生成的路径包含原

路径的所有轮廓线；联合也是路径连接路径本身也发生变化，但生成的路

径仅是复合路径的外轮廓线路径而已。 
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本章到此又告一段落了，用户是否有一定的收获，是否基本了解如何

编辑路径及一些相关工具的用法呢？如果感觉有信心，尝试着做一下实例

部分相关的例子，相信您会有更大的收获。 
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第 4章  文本处理 

与其他应用绘图软件一样，FreeHand 9.0 也同样拥有文本处理功能，
而且功能十分丰富、有特点。除了拥有专业文字处理软件的基本功能外，

他还有着最近比较流行的一些文字特效功能。FreeHand 9.0 的另一突出特
点就是可以将文本作为一个单独的操作对象进行编辑处理，比如文字的属

性、特效及段落的编排和分栏处理等，从而弥补了一般绘图软件在这方面

的不足。 
总之，FreeHand 9.0 作为一个专业的平面图型设计软件，不仅在图形

方面而且在文字排版方面也有相当卓越的表现。它将优秀的绘图功能和出

色的文本编辑功能结合的如此完美，以至使之成为这一领域最为优秀的一

员。下面我们将逐一领略其出色的文本处理功能。 

4.1  文本的添加 

在 FreeHand 9.0中文本的添加有 3种方法。 
（1）直接添加输入法。 
（2）文本编辑器输入法。 
（3）导入文件法。 
这 3种方法分别运用于 3不同的情况，下面将分别予以介绍。 

4.1.1  直接添加输入法 

这种方法十分简单、方便，适用于位置精度要求不高的情况，也是一

般较为常用的方法。其具体操作方法如下。 
（1）用鼠标单击工具箱中的文本图标按钮 ，鼠标变为“ I”字状，

并不停闪烁。 
（2）在图上所需插入文本的位置单击鼠标，随即出现一个文字标尺，

如图 4-1所示。 

 
图 4-1  文字标尺 
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（3）现在开始输入文本。 

 

图 4-2  输入文字（1） 

F 注意 

在用此输入法输入过程中，所输入文字只有在键入“Enter”时才会换
行 。 

/ 小技巧 
在第 2 步中，也可以在单击之后按住鼠标左键不放，继续拖动鼠标直

至达到所需文字边框大小，再输入文字亦可,如图 4-3所示。 

     

图 4-3  文字输入（2）          图 4-4  溢出文本框 

这时读者也许会注意到图 4-3 所示的右下角有一个下方框，这是用来
进行链接文本的链接框，它也可以显示该文本框里的文本是否溢出，如果

成实心状则表示溢出，为空表示未溢出，如图 4-4所示。 

F 注意 

这种文本框输入法与直接输入法有所不同，在于它可根据框的大小调

节文本，还可自动换行。 

/ 小技巧 
拖动鼠标同时按住 Shift 键，创建的就是一个正方形文本框，如果同

时按住的是 Alt键，则创建的是一以单击点为中心的正方形文本框。 
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4.1.2  文本编辑框输入法 

这种方法适用于文本较为庞大或被输入文本的图形较为复杂的情况

下，因为这些情况输入相对较为困难，这时采用文本编辑框输入，可以获

得一个较为明了的输入环境。其具体操作方法如下。 
（1）用鼠标单击工具箱中的文本图标按钮 ，鼠标变为“I”型。 
（2）在图上所需插入文本的地方单击鼠标，按住左键拖动鼠标，创建

一个文本输入框，如上一节小技巧中。 
（3）再在菜单栏中选择 Text菜单，打开 Text菜单，选中 Editor 命令，

此时会弹出一个对话框。此时也可以单击文本栏中的 ，效果同上面一样，

如图 4-5所示。 

 

图 4-5  文本编辑框 

4．输入所需文本，单击“OK”按钮，即可。 

/ 小技巧 
在文本输入框出现的情况下，将鼠标移至链接框上再单击右键，就会

弹出一个令你意想不到的菜单，在其中选中 Editor，效果同上一样，单击
更为快捷、方便，这个技巧还可用于其他操作过程。 

4.1.3  导入文件法 

这种方法适用于将大量已存在于计算机中的文本导入页面。其操作步

骤如下。 
（1）先选中菜单栏中 File 菜单，再选中其中 Import 选项，立即弹出

一个导入文件对话框，如图 4-6所示。 
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图 4-6  导入文件框 

（2）选中其中所需导入的文件，再单击 ，对话框消失而同时

鼠标变成“ ”的形状，这时就是提示你该选择导入文本的位置了。 
（3）此时，在所选中的位置单击鼠标左键并拖动出一矩形区域，即可

完成文件的导入，如图 4-7所示。 

F 注意 

导入文本之前必须考虑导入文本的文件格式，有一些文件 FreeHand 
9.0 并不支持，如最为常用的 DOC 文件，它仅支持 TXT、DXF、CGM 等
文件格式。所以请读者在导入文件之前看清文件格式。 

 

图 4-7  导入文件 

4.2  文本的设置 

文本的设置就是对文本的一些基本属性如字体、字号、行距与间距及
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段落属性等的设置。本节将主要介绍文本各方面属性的设置。 

4.2.1  字体、字样及字号设置 

字体、字样及字号的设置有两种比较简便的方法。现分别予以介绍。 
（1）通过菜单进行设置。步骤如下。 
①  选择 Text菜单中的 Font 命令，弹出一个子菜单，其中包括了十几

种字体可供选择。在其中选中所需字体后单击即可，如图 4-8所示。 
② 选择 Text 菜单中的 Type Style 命令，弹出另一个子菜单，里面有 4

种字样可供选择，如粗体、斜体等，选择所需字样单击。 
③ 选择 Text菜单中的 Size 命令，同样选中所需字号即可。 

@ 提示 
在菜单中可能会有一些灰色选项，代表该选项不能被使用。被选中的

选项前面会出现一个“√”，选中时有一点要注意：必须在文本输入前进行

设置，否则字体的各种属性皆为上一次默认属性。 

 

图 4-8  通过菜单设置属性 

（2）通过文字面板进行设置。步骤如下。 
①  在菜单栏中选中 Window 一栏，再在其中选中 Inspectors，再将

鼠标移到 Text选项上，单击即可打开文字面板。如图 4-9 与图 4-10 所示。 
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图 4-9  打开文字面板 

 

4-10  文字面板 

②  在图 4-10 中，可以清楚地看到文字的各种属性下拉框，设置时
只需在其中选择你所需要的即可。在设置字号时，如果下拉框中没有你所

需要的选项，这时可打开 Text菜单栏中 Size 的 Other 选项，在弹出一个字

字

样

下

拉

框

字 体 下

拉框 

字 号 下

拉框 
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号对话框中输入所需号数，单击“OK”按钮即可。 

4.2.2  字符行距与间距的设置 

在对字符的行间距与字符间距设置前，先让我们了解一下什么是行间

距和字符间距。所谓行间距是指文本中两行文字基线在竖直方向上的垂直

距离。字符间距是指文本中字与字之间的水平距离。下面介绍一下设置方

法。 
字符行间距的设置也有 3种方法。 
一种是通过菜单进行设置。打开 Text 菜单下的子菜单 Leading项，如

图 4-11所示。 

 
图 4-11  行距子菜单 

行距子菜单中包含 3个选项：Other、Solid、Auto。其功能如下： 
（1）Other 命令：用来精确调整字符的行间距。其后面的“ …”表示

其包含下级对话框，单击该命令项，弹出如图 4-12所示的行距对话框。 

 
图 4-12  行距对话框 

对话框中包含两个文本框。当在右边下拉列表框选择 Extra 项时，左
边文本框的就是用来输入想要设置的行间距数值。注意该数值是以百分数

来计量的，输入行间距的大小也就是输入数值的百分数乘以字符大小；当

在下拉列表框中选择 Fixed 项时，就是把一行文本的基线到另一行文本的
基线之间的距离作为行间距。当选中 Percentage 时，就是用字符高度的某
一百分比作为行间距，最大为 120%。 
（2）Solid命令：用来使所有所选字符都有一个固定行距。 
（3）Auto命令：使用系统默认值来调整字符行间距。 
另一种就是通过浮动面板来设置。Text 面板上的 Range Kerning 选项

（如图 4-10所示）就是对其水平间距进行设置的选项。 
还有一种最为直接，通过对文本框直接操作来获得。文本框一共有 8

个控制柄，上下可以调节两行的行间距，左右可调节字符的间距。四边角

可调节其字符大小或边框大小。此时如果按住 Alt 键，再拖动四边角中任
意一个角柄，则进行文本的缩放。如果同时按下 Alt+Shift 键，则不改变水
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平与竖直比例进行缩放，如图 4-13所示。 

 
图 4-13  用控制柄调节属性 

@ 提示 
在调节边角手柄时，可能会出现只调了边框大小的情况，请读者多实

践几次，便可发现其中规律，同时还可获得许多意想不到的收获。 

4.2.3  基线漂移的设置 

基线漂移这一功能是专为特殊需要而设计的。当要添加一些特殊文本

时，比如公式、分数等，基线漂移功能就显得极为方便了。首先让我们来

了解一下什么是基线，基线是就是字母的属性线，调整属性线可创建上下

角标等特殊形式。简单地说，基线漂移是用来调节同一行中字符之间的相

对上下距离。 
基线漂移是在 Text面板的 Baseline shift 一项中进行设置的，在其中添

入所需漂移量，按下回车即可。当键入数值为正值时，表示字符上移，字

符与基线之间的间距变大；当键入数值为负值时，表示字符下移，字符与

基线之间间距减小。效果如图 4-14所示。 

 

图 4-14  基线漂移效果 

4.2.4  文本对齐的设置 

当输入完一块文本后，总要对文本进行最后的外观处理，以使文本在

外观上更为美观。而这一过程中很重要的一步便是对其进行对齐设置。对

齐方式有 4 种：左对齐，右对齐，居中对齐和强制分散对齐。其设置方式
有两种：菜单设置和面板设置。菜单设置是通过选择 Text中的 Align 子菜
单进行。如图 4-15所示。 

水平控制柄 

角柄 



FreeHand 9.0 快学通                        71 

 

 

图 4-15  对齐方式子菜单 

表 4-1  对齐功能命令简表 

命  令 功  能 快  捷  键 
Left 左对齐 Ctrl+Alt+Shift+L 
Right 右对齐 Ctrl+Alt+Shift+R 
Center 居中对齐 Ctrl+Alt+Shift+M 
Justified 分散对齐 Ctrl+Alt+Shift+J 

 

面板设置法十分直接，通过单击 Text 工具栏或文字面板上的按钮即可
进行设置。设置按钮如图 4-16和图 4-17所示。 

 

图 4-16  Text 工具栏中对齐按钮 

 

图 4-17  文本面板中对齐按钮 

面板最右边的按钮是用来设置对齐方式属性的，用户可通过单击它进

行更为精确的设置。设置对话框如图 4-18所示。 

 

图 4-18  “对齐属性设置”对话框 

分散对齐 

对齐方式

属性 
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对话框中包含两个输入框：Ragged width 项和 Flush zone 项。其中
Ragged width项用来调节文本排布区域的宽度。 

4.2.5  大小写转换 

大小写转换的主要作用是方便英文文本的输入和更改。具体方法是先

选中要转换的文本，再选中 Text菜单下的 Convert Case 子菜单。如图 4-19
所示。 

 

图 4-19  大小写转换的设置 

其中 Upper 项用于将所有小写字符转换为大写；Lower 项用于将所有
大写字符转换为小写；Small Caps 项用于将所有小写字符转换为小号大写
字符；Title 项用于将英文文本转换为标准文本模式；Sentence 项用于将英
文文本转换为标准句段模式；Settings 项是对上面几种方式的综合，并可
进行更为细致的设置。 

4.2.6  特殊字符的插入 

FreeHand 9.0 为用户在文本应用较为特殊的地方也提供了方便，比如
特殊字符的插入，用户可以通过单击 Text 菜单下 Special Characters 子菜单
中的各项命令获得。7个项命令选项如图 4-20所示。 

 

图 4-20  特殊字符的插入命令 

各项命令的功能如表 4-2所示。 
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表 4-2  特殊字符插入命令简介 

   命   令 说      明 
End of Column 在选定的位置插入一个非显示字符作为列的结束标

志，其后字符将全部予以删除 
End of Line 在选定的位置插入一个非显示字符作为行的结束标

志，其后字符将另起一行 
Non-Breaking 
Space 

防止两个单词被拆开分放两行而紧缩排列，快捷键为
Ctrl+Shift+H 

Em Space 在选定的位置插入一个全角空格字符，快捷键为
Ctrl+Shift+M 

En Space 在选定的位置插入一个半角空格子符，快捷键为
Ctrl+Shift+N 

Thin Space 在选定的位置插入一个 1/10 字符大小的空格，快捷键
为 Ctrl+Shift+T 

Em Dash 在选定的位置插入一个全角的破折号 
En Dash 在选定的位置插入一个半角的破折号 
Discretionary 
Hyphen 

在选定的位置插入一个连字符 

4.2.7  段落文本的设置 

段落同字符一样拥有设置属性，比如水平与竖直间距等。段落属性的

设置方法也有两种：第一种是通过文字面板来设定，如图 4-21 所示。另一
种较为简单，直接通过调节文本框手柄进行调节。其调节方法同字符的调

节方法类似，比较简单，这里不作详细介绍。 

 

图 4-21  段落间距编辑框 
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4.2.8  文本框的链接和断开 

在添加文本的时候，常会遇到一个问题，就是添加的文本往往会溢出

文本框，而文本框又没有再扩大的空间。这时 FreeHand 9.0中文本框的链
接功能就显得尤为特别和重要。应用这一功能可以通过扩大文本框的添加

范围，来满足用户的需要。只要周围有可添加文本框的地方，都可以使用

这一功能。其原理就是将各个文本框之间前后首尾连结，从而生成一个新

的文本框，连接后其中的文本可以作为一个整体来进行编辑。 
这一功能的操作具体步骤如下： 
（1）选中所要链接的文本框，此时文本框处于带角柄和链接框的文本

框状态。 
（2）用鼠标点击第一个文本框的连接框，同时按住鼠标左键，拖动直

至第二个文本框中。 
（3）用同样方法将其他文本框链接起来。链接过程如图 4-22所示。 

 

图 4-22  链接过程 

如果在中途需要调整文本框的链接顺序，或从中删除某一个文本框，

这时就需要断开文本框的链接。文本框的断开方法同链接一样，选中要断

开的文本框，用鼠标左键单击其链接块，再按住左键拖动至页面空白处，

此时其选中的原文本框中的文本消失，再使用上面所介绍的链接方法重新

进行联接。 

4.3  文本的特效处理 

 FreeHand 9.0的文本特效处理功能同其外挂功能一样强大，恰当使用
此项功能能使文本产生美观大方，别具一格的效果，从而使文本更具特色。

这些功能包括高亮度显示、阴影、下划线、变焦等。本节将按特效处理菜
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单中排列顺序分别予以介绍。 

4.3.1  高亮特效 

高亮特效的作用主要用于相对需要强调的文本，产生的效果可以引起

读者的注意。使用该命令可以使选中的文字加一层底色来区别其他文本。

其操作方法也有两种，一种是通过 Text浮动面板中的 Effect下拉列表设定，
但此种设定只能使用默认选项。如果用户需要自己编辑一些效果，就必须

使用菜单设置法。选中 Text 菜单中 Effect 项，单击其中的 Highlight 命令，
弹出一个设置对话框，如图 4-23所示。 

 

图 4-23  高亮特效编辑框 

其各设置选项说明见下表。 

表 4-3  高亮特效设置说明一览表 

               名  称 说   明 
Position 编辑框 底色框相对基线的垂直距离，即底色框的位置 
Dash下拉列表框 设置不同类型的虚线作为底色处理 
Stroke Width编辑框 设置底色框的宽度 
Stroke Color 下拉列表框 设置底色框的颜色 
Overprint复选框 设置是否进行压印处理 

 

@ 提示 
Sroke Color 下拉列表框中可选颜色有限，用户可通过调色板调制所需

颜色。在其左边的小方框是其颜色预览框，显示颜色为当前选中颜色。 
图 4-24 所示是不同高亮特效设置的对比图，由于压印效果无法显示，

所以未加进压印效果。 
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图 4-24  高亮特效对比效果 

4.3.2  轮廓特效 

轮廓特效就是使文本产生一种描边内嵌的效果，类似于雕刻效果，是

文本特效极为常用的一种。经过这种特效处理的文本看上去美观、醒目。

下面介绍这种功能的使用方法。 
首先选中所要使用轮廓特效的文本，然后在 Text面板中 Effect 下拉列

表框中选中 Inline 即可。但是，这时使用的只是前一次操作后的默认设置。
如果要重新设置，可以从 Text 菜单中的 Effect 子菜单中选中 Inline 项，选
中后系统会弹出一个对话框如图 4-25 所示，然后在其中设置所需的数值和
选项，再单击“OK”按钮即可。 

 

图 4-25  轮廓特效编辑框 

轮廓特效编辑框中各项设置说明如表 4-4所示。 
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表 4-4  轮廓特效设置说明一览表 

名  称 说      明 
Count编辑框 设置所描轮廓线的条数 
Stroke Width编辑框 设置所描轮廓线宽 
Strok Color 下拉列表框 设置所描轮廓线颜色，也可通过调色板配置 
Background Width编辑框 设置所描轮廓线最外层线宽 
Background Color 下拉列
表框 

设置所描文本的背景颜色，注意不要与轮廓线

相近或相同 

图 4-26所示是轮廓特效不同设置的效果对比图。 

                      

图 4-26  轮廓特效对比效果 

4.3.3  阴影特效 

阴影特效也是一种常见的文本特效，用于产生一种立体的效果。当你

在使用 FreeHand 9.0 的此项功能时，也许会发现此项特效无设置对话框，
就是说它只有系统默认的一种设置。此特效的使用可通过选中 Text 菜单中
Effect 子菜单的 Shadow 项获得。当然前提是必须选中要进行特效操作的文
本。图 4-27所示的是阴影特效不同设置的效果对比图。 

 

图 4-27  有无阴影特效对比效果 

F 注意 

在使用此特效的过程中，也许会出现无法看到其效果的现象，这时请

三层描边效果 
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查看一下 View菜单中的 Preview是否被选中。如果仍无法看到效果，再察
看一下系统是否设置为可以显示阴影效果。 

4.3.4  删除划线特效 

这种特效似乎是用于产生一种类似于原稿笔记的效果，提醒读者此处

文本已被删除。在 FreeHand 9.0中，用户同样可以根据需要自己设置删除
划线的属性来改变这种特效的效果。比如设置删除划线的线宽、线型及颜

色。 
这种功能的使用同其他特效处理的一样：首先选定所需进行处理的文

本，再通过选中 Text菜单中 Effect 子菜单的 Strikethrough 项调出编辑对话
框，如图 4-28 所示。然后在其中输入需要的设置，再单击“OK”按钮即
可。当然也可通过选中 Text 面板中 Effect 下拉列表框中的 Strikethrough 项
获得。 

 

图 4-28  删除划线特效编辑框 

删除划线特效编辑框的各项设置说明如表 4-5所示。 

表 4-5  删除划线设置说明一览表 

名  称 说             明 
Position 编辑框 设置删除划线与基线的相对距离 
Dash下拉列表框 设置删除画线的线型 
Stroke Width编辑框 设置删除画线的线宽 
Stroke Color 下拉列表框 设置删除画线的颜色 
Overprint复选框 设置是否产生压印效果 
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图 4-29 所示是删除划线效果图，上下部分分别是线型和线宽设置不同
的效果。 

 

图 4-29  删除划线效果图 

4.3.5  下划线特效 

下划线实际上是删除划线的一种特例，如果设置合适，其效果可与删

除划线相同。它的属性设定同删除划线一样，如线型、线宽、颜色及压印

效果等。 
给文本添加下划线也有两种途径，即面板法和菜单法。菜单法：首先

选定文本对象，然后再通过选择菜单命令 Text→Effect→Underline 调出编
辑对话框，如图 4-30 所示，再设定，最后单击“OK”按钮即可。面板法：
选定对象，单击 Text 面板中 Effect 下拉列表框中的 Underline 命令即可。
两种方法有一点不同就是菜单法可以任意设置，而面板法只能用默认设置。 

 

图 4-30  底划线特效编辑框 

图 4-30中各项设置的说明如表 4-6所示。 
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表 4-6  底划线设置说明一览表 

名    称 说   明 

Position 编辑框 设置底划线与基线的相对距离 

Dash下拉列表框 设置底划线的线型 

Stroke Width编辑框 设置底划线的线宽 

Stroke Color 下拉列表框 设置底划线颜色 

Overprint复选框 设置是否产生压印效果 

图 4-31 所示是不同设置的底划线效果图，是两个使用不同线型和线宽
的效果。 

 

图 4-31  底划线效果图 

4.3.6  投射特效 

投射特效就是利用颜色的渐变来产生高度立体感。通过不同的设置还

可以产生不同效果的投影，比如方向、大小、颜色等。该功能的使用方法

同其它特效的一样：先选中待处理的文本，再选中 Text 菜单中 Effect 子菜
单的 Zoom项，然后在弹出编辑对话框中进行设置，最后单击“OK”按钮。
还可以直接通过单击 Text面板中 Effect下拉列表框中的 Zoom命令项获得。
投射效果的编辑对话框如图 4-32所示。 
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图 4-32  投射特效编辑框 

图 4-32中各项设置的说明如表 4-7所示。 

表 4-7  投射设置说明一览表 

        名   称                说     明 

Zoom To 编辑框 设置投影终止处字符大小比例 
Offset x编辑框 设置投影终止处字符的相对横坐标 
Offset y编辑框 设置投影终止处字符的相对纵坐标 
From Color 下拉列表框 设置投影终止处字符的颜色 
To Color下拉列表框 设置投影起始处颜色，就是字符原本颜

色 

图 4-33 所示是不同设置的两种投影效果，上面一种是比例为 100%，
坐标为（–20,20）、（0,20）和（20, –20）三部分的效果，下面一种是比例
为 200%，坐标为（0，–20）的效果。 

 

图 4-33  投影效果图 

4.4  文本与路径 

在学习了前两章之后，大家对文本和路径都有了一定了解，此时也许
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会产生文本与路径是两个完全不同概念的感觉。但当大家了解到它以下几

种功能后，就会对这两者之间的关系有一个新的认识，进而对路径和文本

有更深的了解。这几种功能是：在路径中输入文本，将文本捆绑于路径，

将文本与路径分离，将文本转换为路径。下面将分别予以介绍。 

4.4.1  在路径内部输入文本 

要在路径中输入文本，首先必须有一个路径，如果没有，则必须先创

建一个路径，用户可以用路径编辑工具来创建。待有了一个路径之后，便

可以通过下面的方法在其内部输入文本：先选定待输入文本的路径，再选

择 Text→Float In Path 命令，这时路径变成一个天蓝色的文本框，此时便
可以往里面输入文本了。输入完毕后按 Tab 键取消选定。如果还要对相对
路径的形状进行编辑，只需按住 Alt 键选中路径，再利用各控制柄来调节
形状，此时不用担心文本会因路径的变化而产生受损等现象。因为文本会

随路径的变化而自动调节。在路径内部输入文本效果如图 4-34所示。 

      

图 4-34  在路径中输入文本效果图 

4.4.2  将路径捆绑在路径上 

在路径与文本的联系方面，FreeHand 9.0 不仅提供了在路径内部输入
文本的功能，而且还提供了一个非常奇特的功能 — —将文本捆绑在路径上。
下面我们来介绍它的功能和使用方法。 
将文本捆绑在路径上有两种方法。一种便是最为方便的直接输入法：

首先选中一条路径（路径形状可以是任意的），再选择 Text 工具，然后选
择菜单 Text→Attach To Path 命令，或者用鼠标左键单击 Tex 工具栏中的
Attach To Path图标按钮 。这时，选定的路径变为天蓝色，并在路径的起
始点出现一个 标记，路径的末端是一个链接块。此时便可以输入文本了。 
另一种方法就是将原已存在的文本捆绑在路径上，但得注意：选定的

文本必须是在矩形文本框中的。而选定的路径也必须是自由路径，不能是

组合路径。要将已有文本捆绑在路径上，首先要同时选中文本和路径，再
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选择菜单 Text→Attach To Path命令，或单击 Tex工具栏中的 ，两者都可
以达到捆绑的目的。 
在使用这一功能的过程中，必须得注意 Enter 键的使用，特别是对于

封闭路径。选定的文本中如果有回车符，它就会自动地把所选文本分为两

部分，一部分位于路径的上部，另一部分位于路径的下部，如图 4-35 所示。
还可以对这两部分分别进行操作，具体的操作工具是浮动面板中的 Text on 
a path 这一页，如图 4-36 所示。下面对其中各项设置分别作以说明，如表
4-8所示。 

 

图 4-35  将两部分文本捆绑在路径上 

 

图 4-36  Text on a path浮动面板 
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表 4-8  捆绑文本于路径设置说明一览表 

       名       称       说        明 
 None 删除捆绑于路径上的文本 
Top 下拉列表
框 

Baseline 
将路径上的文本基线与路径边

缘重合 
 Ascent 将路径上的文本置于路径上方 
 Descent 将路径上的文本置于路径下方 

 Rotate around path 
使路径上每一个字符的基线与

路径在该点的切线方向垂直 
Orientation 下
拉列表框 

Vertical 
使路径上的文本始终保持垂直

状态 

 Skew horizontal 
使路径上文本的倾斜程度随路

径的倾斜程度而变化 

 Skew Vertical 
使路径上的文本产生一种绕垂

直线的旋转，本身仍保持垂直 
Show path复选框 是否显示原始捆绑路径 

inset编辑框 字符相对于原位置的旋转角度 

 

图 4-37  文本捆绑路径的不同效果 

4.4.3  图文混排 

图文混排实际上就是将文本与图形混合起来，使文本看起来不再单调，

而使其显得更为美观。 
图文混排的过程也就是在一个文本框内部插入一个图形对象，并使该

文本框中的所有文本围绕图形对象的外围进行排列，或者图形与文本交织

在一起。在进行图文混排时要注意图形对象是不是一个单一路径的封闭路

径，如果不是，则必须先给它创建一个封闭的外框路径把它包围起来，然

后才可以进行此项操作。其具体操作过程是：先将图形对象拖到所要插入

的文本中，然后选择菜单 Text→Run Around Selection 命令，调出一个设置

文本保持垂直 

文本保持垂

直倾斜 
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对话框，如图 4-38 所示。再在其中进行设置，待设置完毕后单击“OK”
按钮即可。 

 

图 4-38  图文混排编辑框 

在图文混排编辑框中 表示将文本作为图形对象的背景，而 表示将

文本围绕图形对象的外部轮廓排列。下面 4 个小的编辑框分别代表图形对
象的上下左右轮廓与文本之间的距离。 

4.4.4  将文本转换为路径 

FreeHand 9.0 还为用户提供了一个使文本拥有路径属性的功能，也就
是使文本能够像路径一样进行路径编辑操作。简单地说，就是将文本变成

了一幅可编辑的图形对象。例如： 
通过它可以将简单的文本变成特殊字符或文本。 
这一功能可以通过使用 Text 菜单下的 Convert to Paths 命令或单击

Text 工具栏中的 控件来实现。文本在转换为路径时，是形成简单路径还
是形成复合路径，取决于字符对象的复杂程度，如果较为简单如 T，就形
成简单路径，如果较为复杂如 W，就形成复杂路径。而一个文本块就是形
成一个组合路径，在对组合路径转换时首先要将它进行解组操作，解组操

作可通过选择 Modify 菜单下的 Ungroup 命令获得。在解组操作之后，就
可以对字符单独进行转换操作了。但在操作中要注意一点：文本转换为路

径是单项性的，不能再将路径转换回文本，所以在转换前先考虑好文本的

字体、字号、样式等。 
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第 5章  使用颜色和样式 

5.1  基本知识 

究竟什么是颜色？颜色是如何产生的？颜色是如何组成的？按照物理

学的观点，不同的颜色只不过是不同波长的光在人们眼中的不同反应而已。

颜色千变万化无法尽言，于是人们提出了种种理论来解释颜色的问题。其

中最著名的是 3 色理论：红、绿、蓝 3 种颜色为原色，认为其他任何颜色
都可以由 3 种原色按照一定的比例调配而成。这种理论影响很大，也有实
际价值。我们的许多彩色显示设备都基于 3 色理论，例如彩电。另外，我
们用的软件 FreeHand 9.0 系统默认的基本颜色也仅有 3 种。FreeHand 9.0
为了满足不同用户的习惯需要，也为了在色彩调整时的方便，提供了 4 种
不同的模式。 
下面再介绍一下颜色的位数知识。颜色的位数是计算机中颜色的重要

指标，它列出了显示器的所能处理的颜色数目。颜色的位数是指计算机中

表示每一种颜色所用的数据的位数，位数越多表征的颜色越多。现在使用

的颜色位数主要有以下 5种。 
（1）1 位：黑白色，单色显示。在计算机中用 1 位数据表示颜色，仅

能表示黑色和白色，现在已经很少用到。 
（2）4 位：通常说的 16（2 的 4 次幂）色，用 4 位数据存储颜色数据。

这些颜色仅能表示黑、白色和 14种过渡颜色，但还是不能表示彩色。 
（3）8 位：通常说的 256（2 的 8 次幂）色，用 8 位数据存储颜色数

据。这是一个从黑白色到彩色的飞跃，它占用的内存不是很大，执行速度

快，经常在网络、普通绘图中用到。 
（4）16 位：通常说的 16 位增强色，这是大家在个人电脑中经常用到

的颜色设置，理论上讲可以显示 65536 种颜色，但实际中将最后一位作为
颜色重载，从而能表示 32768 种颜色，但这也大大超出常人能分辨的颜色
范围，所以几乎可以表示我们眼中的所有颜色。 
（5）24 位：通常说的 24 位真彩色，颜色能表示 1600 多万种，除了

专业图像处理用到之外，其余的方面没有必要用这种设置。 

' 提示 

在这里不可能把一些内容讲得很详细，比如不同原色如何组合得到另

一种颜色等等，用户如果对颜色的基本知识了解太少，最好找一些相关的

资料看一看，相信会对以后的效果渲染有所帮助。 
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5.2  调色面板的使用 

FreeHand 9.0 提供了不止一个的调色工具，调色板担任主要的调色功
能，色调板辅助细调，还有半调色板，但是不经常用到。下面逐一介绍每

一种调色工具的使用。 

5.2.1  调色板（Color Mixer） 

根据调色方式的不同，调色板提供了 4 种不同的颜色模式：CMYK 模
式、RGB 模式、HLS 模式、SYSTEM 模式，它们从不同的方面去调配颜色，
可以满足各种习惯的用户，同时各模式间交互性也很好。 

5.2.1.1  CMYK模式 
CMYK 模式是系统默认的颜色模式，它其实是以 4 色彩色打印机油墨

颜色为基础的调色模式，C 代表青色，M 代表品红色，Y 代表黄色，K 代
表黑色。其对应面板如图 5-1 所示的参考框是调配颜色的一个参考色，调
节滑块或者直接在编辑框内输入数字即可。以后的各模式调色板用法也是

如此。 

 

图 5-1  CMYK 配色面板 

下面再介绍一些典型的颜色调配方法。 
（1）青色+品红=深蓝色；青色（适中）+品红=紫罗兰色；青色（适

中）+品红（适中）=浅蓝色。 
（2）品红+黄色=鲜红；品红（适中）+黄色=桔黄色；品红（适中）+

黄色（适中）=玫瑰色。 
（3）青色+黄色=绿色；青色（适中）+黄色=浅绿色；青色+黄色（适

中）=茶色。 
（4）青色+品红+黄色=深褐色；青色（适中）+品红+黄色=紫色；青

色+品红（适中）+黄色=墨绿色；青色+品红+黄色（适中）=深蓝色； 
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（5）黑色可以用来产生各种灰色调，并辅助其他 3 种颜色产生效果。
白色调节只要把各原色设为 0即可得到。 

F 注意 

各配方中，原色后没有标注的就是饱和的意思。例如：青色+品红=深
蓝色，就是说饱和或接近饱和的青色和饱和或接近饱和的品红混合的深蓝

色。至于适中是什么程度，用户满意那就是得到的颜色就是行了。 

5.2.1.2  RGB模式 
这是大家在其他软件中经常用到的一个模式，即红、绿、蓝模式。一

些细节问题，在以后的实例讲解中再进一步讲，调色的方法和前文讲的方

法一样。调色面板如图 5-2所示。 

 

图 5-2  RGB 配色面板 

下面再介绍一些典型的颜色调配方法。 
（1）红色+绿色=黄色；红色（适中）+绿色=草绿色；红色（适中）+

绿色（适中）=桔黄色。 
（2）红色+蓝色=洋红色；红色（适中）+蓝色=紫色；红色+蓝色（适

中）=玫瑰色。 
（3）绿色+蓝色=青色；绿色+蓝色（适中）=靛青色；绿色（适中）+

蓝色=天蓝色。 
（4）红色+绿色+蓝色=白色；各原色全部设为 0得到黑色。 

5.2.1.3  HLS模式 
这是一个比较特殊的模式，大家好像不太容易理解，其实这是得到颜

色的另一种途径。它提供了操作颜色的不同方式，这些方式中，以 HLS 模
式最常用。H、S、L 分别代表亮度、色度和饱和度。其面板如图 5-3 所示。 
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图 5-3  HLS 配色面板 

这个面板没有颜色配方，但是还是要给大家介绍一下 3 个参数对于颜
色设置的影响。各参数对颜色影响如下。 
（1）色度：这个参数可以看色轮，色度实际上是按照 360°圆周计算

的纯色。例如，红色对应 0°，绿色对应 120°，蓝色对应 240°。这个色
轮其实就是大家经常见到的色饼图。如图 5-3 所示，色度的调节可以在编
辑框中直接键入 0~360 的任意数字，或者在色饼盘内沿圆周移动小圆圈选
择色度。 
（2）亮度：亮度表示颜色明亮与黑暗的程度。亮度为 0 时，不管什么

颜色都相当于黑色；同样，亮度为 100%时，不管什么颜色都相当于白色。
如图 5-3 所示，与圆圈图标对应的编辑框直接输入或者使用调节手柄可调
节亮度。 
（3）饱和度：饱和度用于描述颜色的纯度。0 饱和度对应灰色，100%

饱和度产生各种纯色。如图 5-3 所示，调节饱和度的办法是在对应编辑框
中输入 0~100的数字或者用鼠标沿径向拖动小圆圈。 

5.2.1.4  SYSTEM模式 
当您并不是需要很多颜色时，SYSTEM 模式就有了用武之地。它虽然

不能提供太多颜色，但是它提供了一些您经常用到的系统默认的颜色，颜

色的选择也比其他方法准确一些。所以在您需要以常用的系统默认色时，

就使用 SYSTEM模式。 
该模式使用很简单，单击对应图标按钮，弹出相应对话框如图 5-4 所

示。看准您想要的颜色单击即可得到，如还是不十分满意，可以到其他模

式下进一步调节。 

色度框 

亮度框 

饱和度 
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图 5-4  SYSTEM 模式面板 

5.2.1.5  添加自定义颜色 
调出一个自己满意的颜色并不是一件很容易的事，所以对于您比较满

意的颜色，你可以存起来，想用时可以调用它。方法很简单：当你调配出

颜色之后，单击调色板上的图标 弹出如图 5-5所示的对话框。 

 

图 5-5  “添加颜色”对话框 

那么颜色填加到哪里去了呢？打开 Color List（颜色浮动面板）看一看，
颜色被添加到颜色对话框中，并作为一种常用颜色放在了颜色列表框中以

备以后使用，如图 5-6所示。 
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图 5-6  颜色浮动面板 

5.2.2  色调面板（Tints） 

对于相同的颜色如果色调不同也能表现出不同的效果，色调面板就是

进行色调设置。一般调配的颜色，其实是由许多种颜色组成，这些颜色构

成了调配的颜色与参考色之间的逐渐过渡。每种颜色间的浓淡程度不同就

有了不同的色调，分别用 0~100 代表不同的色调。调节滑快，或者直接在
编辑框内键入数字即可获得不同色调，色调面板如图 5-7所示。 

 

图 5-7  色调浮动面板 

添加的颜色 
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在基本颜色下拉列表框里可以进行色调设置的基本颜色，添加颜色的

方法与上一节讲过的方法一样，在此不再赘述。 

5.3  颜色的使用 

FreeHand 9.0 还有一个强大的颜色工具，它可以帮助我们设置图形内
部填充、轮廓线填充。这就是 Color List 浮动面板工具，如图 5-8 所示。
Color List浮动面板主要有以下各部分组成。 

5.3.1  填充工具按钮 

填充工具按钮有 3 类，单色全填充工具 、轮廓线着色工具 、图形
整体着色工具 。使用很简单，只要先选择填充图形，再选择填充种类，

最后在颜色列表中单击所选色即可。另外也可以直接点击要选定的颜色，

拖动到要填充的图形部分，然后释放鼠标即可。注意，一定注意位置，填

充轮廓时一定要在轮廓上释放，填充内部时一定要使颜色小方块全部在图

形内部。 

5.3.2  颜色操作工具按钮 

 

图 5-8  颜色浮动面板 
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图 5-9  Option 菜单栏（一部分） 

如图 5-8 所示，在单击 Option（颜色操作按钮）后弹出如图 5-9 所示
的菜单栏。下面简要介绍一下该菜单栏的各项命令。 
（1）New（新建）：在颜色列表中新建一个新颜色。 
（2）Duplicate（制作副本）：用于在列表中创建选中颜色副本。 
（3）Remove（移除）：在颜色列表中移除选中的颜色。 
（4）Replace（替换）：用于替换选中的颜色。 
（5）Hide names（隐藏名字）：隐藏颜色列表中的名字，仅显示图标，

可以使列表中显示更多的颜色，以便于用户更加方便地选择。要想恢复，

再打开菜单，该项变成 Show names，执行即可。 
（6）Make spot（设置成专色）：执行此项，设置颜色成专色，颜色名

称以规则体显示。 
（7）Make process（设成印刷色）：执行此项，设置颜色成印刷色。

颜色名称以斜体显示，与设成专色相对。 
（8）Make CMYK（切换至 CMYK 模式）：执行切换至 CMYK 模式。 
（9）Make RGB（切换至 RGB 模式）：执行切换至 RGB 模式，该模

式与 CMYK模式相对，二者不能同时有效。 
（10）Import（导入颜色）：执行此命令，打开对话框，可以导入其他

图形处理系统的颜色库。执行此命令，弹出如图 5-10 所示的对话框。在系
统默认的情况下，系统把后缀名为*.?cf 的所有文件全部默认为是可以导入
的颜色库样本，其实会有很多难以预料的情况，主要是因为现在各软件的

后缀名比较乱，所以大家一定要有把握准确才能导入，以免发生错误。选

中要导入的颜色库确定即可。 



FreeHand 9.0 快学通                         94 

 

 

图 5-10  导入颜色库对话框 

（11）Export（导出颜色）：执行此命令，打开对话框，可以导出颜色
库。执行此命令，弹出如图 5-11 所示的对话框，其中列出的是颜色列表中
的颜色，选中要导出的颜色，然后单击“OK”按钮（要实现多向选择，可
结合 Shift 和 Ctrl 键，用法与在 Windows 下的用法一样）；接下来弹出如图
5-12所示的对话框，取一个在保存目录中没有用过的颜色库名称即可存盘，
以备以后导入。 

 

图 5-11  导出颜色对话框 

（12）其余是 21种专业颜色库，供用户选择。 
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图 5-12  生成颜色库对话框 

5.3.3  颜色专业库 

FreeHand 9.0 设计者可谓用心良苦，不仅提供了 4 种调色的方法，而
且还提供了 21 种专业库，以便广大用户用起来更方便。如图 5-13 是 21 种
颜色库中的一个对话框。下面图中注解了每一部分的功能。 

 

 

图 5-13  颜色库对话框 

颜色库中由许多十分有价值的颜色，而且调制不易，大家一般没有必

要自己去调色，在各颜色库中找一找，找不到再自己调色。注意经常把自

己调制的一些有价值的颜色导出到文件中，经常有目的地去搜集一些颜色

库导入备用。这些都是好习惯，应该逐渐培养，慢慢你就会发现收获很大。 

5.4  样式的使用 

样式是预先指定好的图形或者文本的属性，主要用于批量操作，可以

大大提高工作效率，类似于其他软件中的模板样式。FreeHand 9.0 中的样
式可以分为两类：一类是文本的对象样式，主要设置字体、字型等属性；

显示与颜色库

相关的说明信

息 
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另一类是图形对象的样式，主要设置图形的填充特性等属性。FreeHand 9.0
提供了大量的样式，诸如文本颜色、字体属性、图形线条属性、填充属性

都可以找到。负责此重任的是样式浮动面板（Window→Panels→Styles），
执行菜单命令可以弹出浮动面板，如图 5-14 所示。该面板共有样式列表和
样式操作下拉菜单按钮两个部分，各部分功能如下。 

 
    图 5-14  样式浮动面板 

（1）样式列表：显示各样式名称和代表图标，其中代表图标中 A 代
表文本样式，其余代表图形样式。 
（2）样式操作下拉菜单按钮：弹出下拉菜单，执行新建等各项功能。

下拉菜单如图 5-15所示。 

 

图 5-15  样式操作下拉菜单 
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下面简要介绍一下各菜单命令的功能。 
（1）New、Duplicate、Remove、Hide names、Import、Export 命令的

基本功能与使用方法，同上一章颜色列表的对应菜单的基本功能与使用方

法，在此不再赘述。 
（2）Remove unused（删除无用的样式）：删除没有使用过的样式。 
（3）Edit（编辑）：用于编辑一个已经存在的样式。针对不同的样式，

弹出不同的对话框。对于图形，弹出图形样式编辑对话框；对于文本，弹

出文本编辑对话框。 
如图 5-16 中，  Style（样式名）是待编辑样式，  Parent（母样式名）

是该样式继承的样式，可以根据母样式衍生出一些子样式。Style affects（样
式影响）用于选择样式编辑范围，共有 3 种选择：Both Fill+Stroke 填充和
轮廓线均编辑，即均设置样式；Fill Attributes 表示仅设置填充；Stroke 
Attributes表示仅设置轮廓线。 

 

图 5-16  “图形样式编辑”对话框 

其他部分看起来好像很多，仔细观察一下，其实就是几个浮动面板放

在了里面，关于其中的一些设置，这里暂不讲解，在其他章相应部分会将

其分解开进一步讲解。另外，文本样式设置对话框的设置与图形很相似，

在此不再赘述！ 
（4）Redefine（重新定义）：把图形属性定义给样式，执行此命令弹

出如图 5-17 所示对话框。在对话框中选中需重新定义的样式，单击“OK”
按钮后，则选择对象的属性会定义给选中样式。 
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图 5-17  重新定义对话框 

（5）Set parent（设置母样式）：设置选中样式的母样式。选中的母样
式将把自己的一些属性传递给字样式。 
（6）RGB or CMYK Styles.fh9（样式库的调用）：可以调用专用的样

式库，选择不同的样式以便用户方便地应用，用法与颜色库用法相同，如

图 5-19所示。 

 

图 5-18  设置母样式对话框 



99                        FreeHand 9.0 快学通 

 

 

图 5-19  样式库的调用对话框 

到此，颜色和样式使用也给大家介绍完了，相信大家基本了解了颜色

和样式的用法，希望大家不要忽视本章的重要性，一个图形的成功与否很

大程度上取决于您上色和填充样式的技巧。下一章，还将继续介绍图像填

充的方法和技巧。 
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第 6章  图形的填充 

图形的填充是 FreeHand 9.0拥有的一个使作品更加绚丽多彩、栩栩如

生的功能，没有图形填充就见不到如此令人羡慕的图形和许多在其他软件

中难以见到的特效。要想在 FreeHand 9.0中绘制出各种精美的图形，必须

要用到各种填充功能。FreeHand 9.0 可以对封闭图形进行普通、渐变、透

明、Postscript 填充、透镜、纹理、图案、拼贴和自定义填充，其功能非常

强大，这些功能将在以后的章节中逐一介绍。 

6.1  单色填充 

单色填充是最普通也是最常用、最简单的一种填充方式。其实在第 5

章中讲到的填充就是单色填充，在有些参考资料中也叫标准填充或者纯色

填充，都是一个意思。 

在 FreeHand 9.0中，实现填充功能主要依靠填充浮动面板对封闭路径

和文本框进行各种类型的填充，填充面板如图 6-1所示。 

填充方式列表框中可以选择填充类型，例如，选择 None 代表进行透

明填充，选择 Basic代表进行最基本的单色填充等等。我们选择 Basic，下

面一个就是填充颜色列表框，用于选择填充颜色。一般当你打开列表框时，

仅有几种颜色，所以你要选择好基本色并把调好的颜色加入到 Colors（颜

色列表）浮动面板中去，再打开此下拉列表就会发现刚添加的颜色了。 

进行单色填充很简单，上一章已讲过一些。由于有时还会出错，所以

在这里再强调一下。首先选中要填充的对象，然后在填充方式中选择单色

填充，最后选定要填充的颜色即可。另外拖动颜色也是一个好方法，直接

把颜色拖动到要填充的对象上，即可实现填充功能，十分快捷。 
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图 6-1  填充浮动面板 

6.2  透明填充 

透明填充是一种经常用到的效果，而且在系统默认的情况下就是透明

填充或者干脆就叫没有填充也可以。选中图形对象，选择填充面板下的

None（透明填充）选项，即可以实现透明填充。 
透明填充分为两种，一种是对路径内部进行填充，另外一种是对路径

轮廓线进行填充。第一种填充比较简单，当创建一个路径以后默认就是透

明填充。第二种是对轮廓线的填充，有以下两种方法。 
（1） 选中图形路径后，如图 6-2 所示，在颜色面板中选中仅填充轮

廓线，单击 None选项，可以看到如图 6-3所示的前后变化。 

 

图 6-2  颜色面板设置 

填充方式列表框 

填充颜色列表框 
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图 6-3  填充前后效果 

（2） 选中路径后，如图 6-4 所示，在 Stroke 面板下设置为 None，即
可以得到如图 6-3所示的效果。与第一种方法有异曲同工之效。 

 

图 6-4  Stroke（笔划）面板 

但是大家注意，透明填充和白色填充是最容易混淆的两种填充，白色

填充属于基本单色填充。单是一个图形无论谁也不能分辨出它们，但是当

透明填充图形和白色填充图形挡住一个图形时，就会很容易地分辨它们，

如图 6-5所示。 
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图 6-5  透明填充和白色填充的不同效果 

如图 6-5 所示，透明填充并不遮住下面一层图形，而白色填充遮住下
面一层中的文本和椭圆，有遮挡效果。希望大家在以后的应用中多加注意。

另外，在填充面板上也可以轻易找到当前的填充颜色和样式等。 

6.3  渐变填充 

渐变填充是指在同一封闭对象内从一种颜色变换到另一种颜色的特殊

填充效果，它是一类使作品更加有层次更加绚丽的填充效果，而且在

FreeHand 9.0中还支持多色填充，是其他大多数软件望尘莫及的。 
FreeHand 9.0提供了两种填充方式：直线式渐变填充和径向渐变填充。 

6.3.1  直线渐变填充 

直线渐变填充是填充中最常用的一种方法，它能够创建沿直线方向的

对数或线形的任意两种颜色的渐变效果。启动直线渐变填充很简单，打开

填充面板，在下拉列表框中选择 Gradient（渐变填充），再单击图标按钮 ，
使之呈凹下状态，表示进入直线渐变模式，直线渐变面板如图 6-6所示。 

 

图 6-6  直线渐变填充面板 

对照图中注释，各部分功能如下。 
（1） 渐变起始颜色：设置渐变起始颜色，系统默认为黑色。若要更

白色填充 
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换起始颜色，单击按钮会显示当前系统中颜色列表中的所有颜色，添加即

可。找不到合适颜色，则先由调色板调出添加到颜色列表再进行设定或者

直接拖过来也可。 
（2） 渐变样式选择：左边的是直线渐变模式，右边的是径向渐变模

式。 
（3） 是否压印：该复选框对于屏幕上预览效果没有什么影响，主要

在打印时决定对象是否与其他对象的重叠部分颜色混合。比如说：在某一

图形部分填充了红与绿两种颜色，且红色在上。如果复选该项，那么在用

彩色打印机打印作品时，先在该部分打印绿色然后再打印红色；若不复选

该项，则打印时仅打印最外的红色。所以您如果不准备将您的大作打印出

来的话，可以完全不去管它，在电脑上是不会对图形颜色产生任何影响的。 
（4） 直线渐变方式：这一项主要设置渐变起始颜色与终止颜色间的

渐变速度。从数学角度来讲就是说， Linear（直线渐变）是线性匀速渐变，
颜色转变速率在整个过程中恒定；另一种 Logarithmic（对数渐变）是对数
性渐变，颜色转变速率与时间之间是对数曲线的关系，速率越来越小。填

充不同效果如图 6-7 所示。其中，左图为线性填充，右图为对数性填充，
是不是区别很大，如果书上效果不好，可以试着看在电脑中做一下。 

 

图 6-7  线性填充与对数填充的不同效果 

（5） 渐变直线倾角：调节直线渐变的方向，可以用鼠标调节转动柄
或直接在编辑框中输入 0~360 的数字。下面是不同渐变倾角的效果比较，
如图 6-8所示。 

 

图 6-8  不同倾角下的不同效果 

（6） 渐变终止颜色：它的用法与渐变起始颜色一样，不再赘述。 
（7） 渐变色带：反映颜色渐变的情况，还可以向其中加入新的颜色

实现多色渐变填充。 
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6.3.2  径向渐变 

径向渐变填充其实就是由选定辐射中心向外辐射产生同心圆的渐变效

果，所以又可称作同心渐变。打开填充面板，选择渐变填充，再单击径向

渐变按钮，使之凹下，进入径向渐变填充模式，其面板如图 6-9所示。 
这个面板的各参数设置与直线渐变的差不多，惟一指出的是渐变辐射

中心的设置，它是一个比较特殊的选项，直接用鼠标拖动滑盘中的滑块可

以改变辐射中心的位置。辐射中心不同会产生不同的效果，如图 6-10 所示。 

 

图 6-9  径向渐变填充面板 

 

图 6-10  不同位置的辐射中心效果不同 

另外，FreeHand 9.0 还支持在渐变过程中使用两种以上的颜色进行中
间过渡，这就大大丰富了用户可以进行渐变的方式，也活跃了用户的思维，

往往会产生许多意想不到的特效。如图 6-11 所示的效果就是用多色渐变填
充合成而得。 

 

图 6-11  多色填充的特殊效果 

辐射中心 
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看了以上的效果用户是不是很惊讶，其实步骤很简单，只要在双色填

充的基础上做就可以了。在做完双色填充之后，再在调色板中调出几种颜

色来，分别拖动到渐变色带的不同位置上即可，然后根据预览情况调节各

颜色的位置和排列顺序，直到满意为止。两种填充方式都支持多色填充，

图 6-11中前两个图是径向填充，第三个图是直线渐变填充。 

6.4  透镜填充 

透镜式填充是 FreeHand 9.0 中又一个比较特殊的填充工具，严格地说，
它并不是一个填充方式，而是借助它可以对其他对象产生几种特效，相当

于在对象上放置了一个可以实现指定效果的透镜，使对象在透镜下的部分

产生特效，有些类似于 Photoshop 的滤镜效果，不过和滤镜比只不过是小
巫见大巫了。 
在填充面板下选择 Lens（透镜），就进入透镜填充模式，其中供使用

的透镜有以下 6 种：Transparency（透明度）透镜、 Magnify（放大）透镜、 
Invert（反显）透镜、Lighten（变亮）透镜、  Darken（变暗）透镜等。以
下将逐一介绍它们的用法。 

6.4.1  透明度（Transparency）透镜 

透明度透镜主要从设置透明色和透明百分比等角度产生特效，其面板

如图 6-12所示。 

 

图 6-12  透明度透镜面板 

各项功能和使用方法如下。 
（1） 透镜颜色选择下拉列表：单击此按钮，弹出颜色下拉列表，从

中选中用户满意的颜色，欲添加新颜色可以先调出颜色后添加至颜色列表

填充模式 

透镜类型 

透镜颜色 

不透明度 
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即可。 
（2） 不透明度的设置：该设置参数从 0~100%，0%表示完全透明，

100%表示完全遮挡。百分数越大，不透明度越大；百分数越小，不透明度
越小。设置的百分数不同，最后的结果不同，效果如图 6-13 所示，其中的
左图不透明度为 80%，中间图不透明度为 30%，右侧图透明度为 50%，效
果明显不一样。一般而言，大多数情况下应把不透明度设置在 50%左右。 
（3） 透镜中心设置：该选项主要通过设置透镜中心的坐标来实现特

殊效果。改变透镜的中心，可以在编辑框中直接键入数字，其实更加常用

的是在透镜中直接调节。当用户选中该复选框之后，您就会发现在透镜上

出现了一个类似于“*”的标记，这一点代表的就是透镜中心的位置，用鼠
标拖动该标记，透镜中心就会发生相应的变化，从而产生不同的效果。如

图 6-13 所示，左侧和中间的透镜中心不变，右侧透镜中心发生变化，看一
看图中人物的头是不是换了位置。 

   

 

图 6-13  不同透明度和透镜中心的不同特殊效果 

（4） 仅限对象：此复选框主要用来调整透镜的填充效果。当复选有
效时，系统仅在透镜与被透视对象重叠的部分显示透镜效果，其他部分以

空白显示；否则，透镜下的所有区域都会产生特效。如图 6-14 所示，左图
是没有复选仅限对象的效果，右图是复选后的效果。 
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图 6-14  仅限对象的复选与否不同效果 

（5） 快照模式：复选该选项可以加快显示透镜效果的速度。 

 
图 6-15  透镜边界选为 None 的效果 

/ 小技巧 
透镜总是有一个有色的边缘线，就会显得比较别扭，可以将边缘线设

置为无，效果就好一些，如图 6-15 所示，与图 6-14 相比较，是不是别有
一番风味呢！ 

6.4.2  放大（Magnify）透镜 

放大透镜好比通过放大镜看图形对象，可以得到一些特效，它的面板

如图 6-16所示。 
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图 6-16  放大透镜面板 

面板上各项的功能和用法如下。 
（1） 放大倍数设置：该编辑框用来设置放大倍数，设置值为 1~20。

输入方式可以直接在编辑框中键入数字，也可以拖动滑块来改变放大倍数。

如图 6-17所示就是放大的效果，放大倍数是两倍。 
（2） 中心点：其设置方法与透明度透镜一样，效果也相仿。图 6-17

所示，上面的图是默认中心的效果，下面的图是改变透镜中心后的效果。 
（3） 仅限对象、快照模式：与透明透镜功效一样，不再赘述。 

 

图 6-17  放大镜的效果 
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6.4.3  反显（Invert）透镜 

这个透镜主要功能是对透镜下的颜色，按照在 CMYK 模式下的互补色
呈现出来。所谓的互补色，就是指色轮上相对位置的两种颜色就是互补色，

反显透镜的效果有点类似于照片的底板的效果。设置很简单，面板没有什

么特殊的设置，只要在透镜类型列表框下选择 Invert（反显）透镜，效果
如图 6-18所示。 

 

图 6-18  反显透镜的不同设置效果 

6.4.4  变亮（Lighten）透镜 

变亮透镜功能是使透镜下的图形对象亮度增加。打开填充浮动面板，

选择透镜，再在透镜类型下选择变亮即可。这类特效对于位图效果特别明

显，另外反显、变暗透镜对位图效果也特别明显。其面板如图 6-19 所示。 

 

 图 6-19  变亮透镜浮动面板 
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图 6-20  变亮透镜的特殊效果 

如图 6-19 所示，亮度比例可以进行调节，0%表示没有亮度效果，显
示为透明色；100%表示最亮效果，显示为白色。图 6-20 所示为变亮透镜
的特殊效果。 

6.4.5  变暗（Darken）透镜 

变暗透镜的使用方法与变亮透镜完全相同，只不过是效果相反而已。

变暗透镜使位于其下的图形对象亮度降低，其面板设置如图 6-21（a）所
示。 
暗度比例调节方法与变亮透镜亮度调节方法一样，一般设置在 50%左

右。变暗透镜的不同效果，如图 6-21（b）所示。 

 
图 6-21（a）  变暗透镜浮动面板 
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图 6-21（b）  变暗透镜的特殊效果 

6.4.6  单色（Monochrome）透镜 

启动单色透镜的方法和其他透镜启动方法一样，其功能是使透镜下所

有有颜色的线条填充时以透镜颜色来显示。不过在本书中因为是黑白打印，

可能看不到明显的效果，在彩色打印或电脑屏幕上可是十分清晰啊！单色

透镜的浮动面板如图 6-22所示。 

 

图 6-22  单色透镜浮动面板       图 6-23  单色透镜的特殊效果 

如图 6-22 所示，下拉框下的颜色按钮就是该单色透镜的颜色。它与透
明度透镜并不相同，透明度透镜显示的是透镜颜色与图形对象相互叠加的

结果，而单色透镜是对透镜下所有颜色的线条填充时都以透镜颜色来显示。

其他项目与其他透镜设置方法基本一样。 
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6.5  图案填充 

图案填充可以用定制的也可以用自己手绘的位图来填充图像，这些位

图是以方形图块显示，并且大部分图案可以让用户自己编辑，改变图案的

线条样式、颜色、粗细等，来填充选中的图形对象。在填充浮动面板下，

选择 Pattern填充，得到如图 6-24所示的浮动面板。 

 

图 6-24  图案填充浮动面板 

各选项的功能和参数设置方法如下。 
（1） 图案颜色：主要设置图案的填充颜色，用法与其他填充时的颜

色设置方法相同。 
（2） 位图编辑与预览框：可以预览各种定制图案的位图，并且可以

进行位图的编辑，自己创建一些自定义的位图，体现一些个人的风格。该

窗口由 8×8 的点阵组成，每个像素点以黑色或者白色填充。在每一个点单
击一次，就会使原来的点变换成另一种颜色。 
（3） 图案预览框：在这一栏中可以预览指定样式或者自定义样式的

图案。 
（4） 清空位图编辑框：单击此按钮，可以清空位图编辑框以便进行

新的编辑。 
（5） 反白显示：即反色处理，将图案中黑色的像素点变成白色，把

白色的像素点变成黑色。 
（6） 图案列表框：主要用于选择使用的定制图案，拖动滑块可以显

示出其他图案，单击选定图案。 
下面有两个填充效果，仅供大家在此参考，如图 6-25所示。 

图案颜色 

图案预览 

反白显示 

图案列表 
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图 6-25  几种图案填充的效果 

6.6  描述语言填充 

Postscript 填充是一种利用 Postscript 语言设计出来的特殊的纹理填充
方式。Postscript 是 Adobe 公司推出的一种功能十分强大的页面设计绘图语
言，它功能强大但十分复杂和专业，所以在这里仅介绍一下该工具的用法，

至于语言设计不属本书介绍范围，有兴趣的用户可以参看这方面的专业书

籍。 
在填充面板下，选择 Postscript 进入 Postscript 模式，面板如图 6-26

所示。 

 

图 6-26  Postscript 填充面板 

面板设置很简单，颜色填充面板仅有填充颜色和语言代码两项，颜色

设置与其他颜色设置相同，代码直接在代码编辑框中书写即可。另外，由

于该功能的显示会需要较长的时间，所以内部填充的效果在屏幕中均以

“PS”字符填充，所以无论如何设置，仅能得到如图 6-27 所示的效果，真
正的效果在打印时显现出来。 

填充颜色 

语言代码 
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图 6-27  Postscript 填充的屏幕效果 

6.7  纹理填充 

底纹填充方式是 FreeHand 9.0的另一个较有特色的填充功能，它使用
更接近生活的真实事物的表面形状和颜色的底纹填充选中的对象。

FreeHand 9.0提供了 9 种不同的底纹：Burlap、 Coarse gravel、 Coquille、 
Denim、  Fine gravel、 Heavy mezzo、  Light mezzo、  Medium mezzo 和  
Sand。打开颜色填充浮动面板，在填充方式中选择 Textured（纹理填充）
即可进入纹理填充模式，其面板如图 6-28所示。 

 

图 6-28  纹理填充浮动面板 
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图 6-29  纹理填充屏幕效果 

面板的设置没有什么特殊的地方，所以不再讲解。只不过本填充效果

和上一节的 Postscript 填充一样，不能在屏幕上看到效果，仅能在打印时
才能显现出来。屏幕效果如图 6-29 所示。纹理填充方式还有一个不足的地
方就是不能自己进行编辑，所以它也只有 9 种编辑填充的方式，应该说是
少了一些。 

6.8  拼贴填充 

Tiled（拼贴填充）是另一类可以进行填充图形的特殊工具，它利用用
户自己编辑的图案去填充对象，可以将一个或几个对象填充到另一个对象

中，填充完毕后，填图与填充对象结合在一起，就像图案贴上去了一样。

而且，填好之后，填图与填充对象总是可以保持一定的大小和位置比例。

其浮动控制面板如图 6-30所示。 

 

图 6-30  拼贴浮动面板 
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下面逐一讲解各选项的功能和使用方法。 

（1） 预览框：用来预览用户填入图形对象内部的图案，这些图案用

户必须自己编辑，并且建议用户最好将这些图案先放入剪贴板。 

（2）  Paste in（粘贴）：当剪贴板中有新图时，将剪贴板上的图案粘

贴进预览框，并将预览框中的图案粘贴进选择的图形对象；当剪贴板中无

新图时，仅将预览框中的图案粘贴进选择的图形对象。 

（3） Copy out（复制）：将预览框中的图案复制到剪贴板中，以便绘

图工具编辑。 

（4） Angle（角度）：该选项可以实现填入图案的旋转。旋转可以在

编辑框中键入数字，也可以用鼠标转动轮盘。 

（5）  Scale（比例）：调节填入图案与原图案的比例。比例分为两个

方向设置，Y 方向代表水平方向，Y 方向代表竖直方向。比例大小设置可

以放大也可以缩小，但一般使用缩小的时候较多。 

（6） Offset（偏移量）：此选项主要设置填入图案与原图案相比较在

X、Y 两个方向上的各自偏离原图案的距离，偏离的设置与数学设置相同，

正表示向右或向上，负则相反。 

拼贴填充的步骤稍微麻烦一些，首先要编辑好填充图案，再将图案放

入剪贴板（使用剪切或复制命令），接下来选定要填充的图形，然后再拼贴

模式下单击“Paste in”  按钮即可实现填充。其余参数设置，可在拼贴好

以后进一步调节。填充的效果在这里就不列出了，在后面的实例讲解中还

会一步一步地讲解它的用法。 

6.9  自定义填充 

自定义填充是填充中种类最多最复杂的一类填充方式，系统一共提供

了 10 种自定义的填充方式，它们分别是：Black&white noise、Bricks、

Circles、Hatch、Noise 、Random grass、Random leaves、Squares、Tiger teeth

和 Top noise。下拉列表框如图 6-31 所示。其实它们全都是使用 Postscript

语言编出来的一些特殊的填充效果，所以仅仅在屏幕上用户是看不到它们

具体的效果，只有到了打印机上才能显示出它们迷人的图案。 
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图 6-31  自定义下拉列表 

屏幕上的效果如图 6-32所示。 
下面对每一种填充方式进行逐一讲解。 

F 注意 

因为无法预览，所以在这里仅讲授各面板的设置方法，至于产生什么

样的效果，请用户自己在打印机上看吧！ 
 

 

图 6-32  自定义填充屏幕效果 
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6.9.1  Black&white noise填充 

Black&white noise 填充实际上就是用随机的黑、白点来填充对象，这
完全是随机的，用户也不能控制指定的某一点到底是什么颜色。填充方法

是选定对象后在 Custom（自定义）选项下选择 Black&white noise，即可达
到目的。面板中没有其他选项，图略。 

6.9.2  Bricks 填充 

Bricks 是使用整行的错位矩形组成的图块来填充图形对象，进入
Bricks模式后，可以看到该面板下的参数设定项目，如图 6-33所示。 
面板中每一项的功能和设定方法如下。 
（1） Brick 颜色设置：进行 Brick 的颜色设置，可以从颜色列表中选

择，也可以从系统中取色。主要设置矩形颜色，默认为黑色。 
（2） Mortar 颜色设置：进行 Mortar 的颜色设置，可以从颜色列表中

选择，也可以从系统中取色，与 Brick 颜色设置方法完全一样。主要设置
矩形块间的缝隙颜色，系统默认为白色。 
（3） Width设置：设置矩形块的宽度，以“磅”为单位。 
（4） Height设置：设置矩形块的高度，以“磅”为单位。 
（5） Angle设置：设置矩形块的旋转角度，默认值为 0°。 

 

图 6-33  Bricks参数设置面板 
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图 6-34  Circles参数设置面板 

6.9.3  Circles填充 

Circles 填充是使用正的行或列的圆圈来填充选中对象，其面板如图
6-34所示。Circles面板各参数的功能和设置方法如下。 
（1） 颜色设置：进行的 Color 的轮廓线的颜色设置，可以从颜色列

表中选择，也可以从系统中取色，系统默认为黑色。圆圈内部始终为透明

色。 
（2） Radius设置：设置填充圆圈的半径，单位为“磅”。 
（3） Spacing设置：设置两相邻圆之间的圆心距，单位为“磅”。 
（4） Angle 设置：设置填充是每一行圆圈的圆心连线的旋转角度，

默认为 0°，击圆心连线为水平。 
（5） Stroke width设置：设置圆圈轮廓线的宽度，单位为“磅”。 

6.9.4  Hatch填充 

Hatch 填充是用两组互相交叉的平行线来对对象进行填充的，其面板
如图 6-35所示。其各项参数的设置和使用方法如下。 
（1） Hatch 颜色设置：用于设置线条的颜色，但线条间的颜色始终

是透明色。 
（2） Angle1设置：设置第一组平行线线条的倾斜度。 
（3） Angle2设置：设置第二组平行线线条的倾斜度。 
（4） Spacing设置：设置平行线的相邻两平行线的间距，单位为“磅”。 
（5） Stroke width设置：设置平行线线条的宽度，单位为磅。 
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（6） Dashed lines 设置：设置平行线的线型。复选该项，则使用虚线
线型；取消该项，则使用实线线型。 

 

图 6-35  Hatch参数设置面板 

6.9.5  Noise填充 

Noise 填充类似于 Black&white noise 填充，是使用随机产生的独立像
素点来填充对象，只不过像素点的颜色是随机的灰度值，不是黑、白点，

其面板如图 6-36所示。 

 

图 6-36  Noise 参数设置面板 
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下面介绍一下各参数功能。 
（1） Min 设置：设置随机产生的点的最小灰度值，默认值为 0（黑

色），且必须比最大灰度值小，范围在 0~100之间。 
（2） Max 设置：设置随机产生的点的最大灰度值，默认值为 100（白

色），且必须比最小灰度值大，范围在 0~100之间。 

6.9.6  Random grass填充 

Random grass 填充是使用随机放置的特定数目的黑色曲线对对象进行
填充。Random grass 参数设置面板下仅含有一个参数“# of blades”，它的
功能是设置选定区域内的曲线条数，理论允许值为从 0~32000 条。其面板
如图 6-37所示。 

 

图 6-37  Random grass 参数设置面板    

6.9.7  Random leaves填充 

Random leaves 填充是使用指定数目的叶子对对象进行填充的，但树叶
的形状和位置是系统随机放置的。该项只有一个参数“# of leaves”可以设
置，用于设置随机显示的叶子的个数，其设定的理论值也是 1~32000。其
他的参数都已给定，叶子轮廓线 1 磅宽、黑色，叶子内部透明色（或白色）
填充。Random leaves的参数设置面板如图 6-38所示。 
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图 6-38 #Random leaves参数设置面板 

6.9.8  Squares填充 

Squares 填充是使用整行或者整列的正方形来对对象进行填充。其参数
设置面板如图 6-39所示。 

 

图 6-39  Squares参数设置面板 

下面介绍各参数的具体功能。 
（1） Squares 颜色设置：设置正方形轮廓线的颜色，正方形路径内部

始终为透明色。 
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（2） Side length设置：设置正方形的边长，单位为“磅”。 
（3） Spacing设置：设置相邻两正方形的中心距，单位为“磅”。 
（4） Angle 设置：设置某一行正方形中心的连线旋转的角度，单位

为“度”。 
（5） Stroke width设置：设置正方形轮廓线的宽度，单位为“磅”。 

6.9.9  Tiger teeth填充 

Tiger teeth 填充是使用两组相互交错的三角形对对象进行填充，产生
一定的特殊效果。Tiger teeth 的参数设置面板如图 6-40 所示。另外，因为
该项效果有些类似于食肉动物锋利的牙齿，所以该项目名称为 Tiger teeth，
中文名为虎牙。 

Tiger teeth参数设置面板的各项功能如下。 
（1）  Tooth 颜色设置：设置牙齿三角形的颜色，系统默认为黑色。

颜色设置方法与其他类型颜色设置方法相同。 
（2） Background 颜色设置：主要设置用于作为背景的三角形的内部

填充颜色，系统默认为白色。 
（3） # of teeth设置：设置作为牙齿的三角形的数目。 
（4） Angle 设置：设置某一行三角形中心连线的旋转角度，单位为

“度”。 

6.9.10  Top noise填充 

Top noise填充是使用随机的像素点组成的图案对对象进行填充。它和
Noise 相比较而言，具有的像素灰度仅是一个值，用户定了之后就不可以
变动，最后的效果也是同一灰度的点打印在纸上。灰度值在 0~100%之间，
即在黑色与白色之间。 

 

图 6-40  Tiger teeth 参数设置面板 
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图 6-41  Top noise 参数设置面板 

F 注意 

在填充中有许多效果在电脑屏幕上显示不出来，所以作者在这里要对

那些不准备把自己的作品打印出来的用户朋友们提个建议，就是最好不要

用那些不能直接在屏幕上得到效果的填充方式。 
到此为止，颜色填充这一章又结束了。这一章主要讲授了利用颜色填

充的一些方法，而且主要是对封闭对象内部进行填充。其实，对于路径本

身或对象轮廓线也可以填充一定的样式和颜色，主要利用笔划线条填充面

板（对应命令 Windows→Inspectors→Stroke），填充的方法和本章讲的步骤
基本一样，由于篇幅限制，本书在这方面就不单独提出来讲了。用户在实

例讲解中可以做一下，以巩固提高。 
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第 7 章  外挂功能 

FreeHand 9.0 外挂功能具有开放式结构，允许高级用户自己添加其他
新的功能，从而进一步扩充和完善其外挂功能。换句话说外挂功能就是

FreeHand 9.0 的一个外部通道，通过它可以将其他与之兼容的软件连结起
来，使其他软件的功能能够在 FreeHand 9.0中得以发挥，这样以来外挂功
能就得以扩充。 

FreeHand 9.0的外挂功能包含 Xtra Tools 和 Xtra Operations 两部分 ,它
们分别可以通过 Windows 菜单下 Toolsbars 子菜单中 Xtra Tools 和 Xtra 
Operations 命令调出来。也可以通过 Xtras 菜单直接调用外挂命令，但由于
这种方法在操作过程中极为不便，而且必须记住每个功能的名称和作用，

而通过 Xtra Tools和 Xtra Operations 工具栏中的控件则显得极为方便。因
为在每个控件的上面都有着十分形象的图标，通过图标能极为快捷地判别

出该控件的功能。单击控件比调出两级菜单要快捷省事得的多，所以一般

都采用单击控件法。下面我们分别通过小实例来介绍 Xtra Tools 和 Xtra 
Operations 工具栏中一些典型控件的用途和使用方法。由于 Xtra Tools 和
Xtra Operations 工具栏中的功能和 Xtras 菜单中的命令属性和使用方法差
不多，所以在这里只对 Xtra Tools和 Xtra Operations 工具栏中的功能作以
介绍。 

7.1  Xtra Tools工具栏的使用 

在使用 Xtra Tools 功能之前，我们可以通过选中 Windows 菜单下
Toolsbars 子菜单中 Xtra Tools 命令项，调出 Xtra Tools 工具栏，如图 7-1
所示。 

 
图 7-1  Xtra Tools工具栏 

从图 7-1 中可以看到工具栏中共有 12 个控件，每一个控件都有比较形
象的图标，通过它控件的功能。仔细观察会发现有一些图标的右上角有一

个同 Tools中控件相同的“ ”标记，这个标记代表用户在使用该功能时，

可以根据需要自己设置功能的属性和大小数值。使用时可通过双击该控键

调出编辑对话框，然后进行设置。设置完毕后单击“OK”按钮即可。下面
将向读者介绍其中几个比较典型和新颖控件的使用方法。 
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7.1.1  鱼眼透镜控件 的使用 

鱼眼透镜的作用就是使图形局部产生不同程度放大或缩小的变形，从

而达到一种夸张的畸变效果。我们通过制作字体变形小实例来介绍鱼眼透

镜的使用方法，其步骤如下。 
（1）单击 Tools工具栏上新建按钮，新建一个页面。 
（2）选中菜单命令 Windows→ Inspectors→Text，调出 Text 控制面板，

将字号设置为 48，字样设置为 Comic Sons MS。 
（3）单击 Tools工具栏中的文本控件，此时鼠标变为“Ⅰ”形光标，

再将光标移到工作区某一位置单击，待出现文本框后开始输入文本“ I want 
to fly”。 
（4）选中所输入文本，单击 控件，将文本转换成路径。 
（5）选择菜单命令 Windows→Panels→Color Mixer，调出填充面板，

调好颜色，再用箭头或 Tools 工具栏中的拾色滴管工具，将调好的颜色调
入 Text控制面板上填充页中的小方框即可，此处设置为绿色。 
（6）选中转换后的路径，再双击 Xtra Tools工具栏中的 ，调出该功

能设置编辑框，如图 7-2 所示，在左边框中设置畸变程度，也可以通过调
节滚动条设置，两者效果一样。设置完毕后，单击“OK”按钮。 
（7）完成上一步后，鼠标会变成“十”字状。将鼠标移到文本路径左

上角，再按住左键并拖动鼠标至文本右下角，释放鼠标，此时文本的鱼眼

效果就出现了，如图 7-3所示。 

 
图 7-2  鱼眼透镜对话框 

 

图 7-3  文字的鱼眼透镜效果 

F 注意 

文本对象必须在转换为路径后才能使用，转换为路径就是使其转换为

矢量图形，所以一般导入的位图和文字都不能进行此操作。 
在第（7）步中，拖动鼠标时可以通过按住 Shift 键、Alt 键或同时按
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下两键来改变的透镜形状。 

7.1.2  三维旋转控件 的使用 

三维旋转的作用就是使二维平面图形产生三维立体效果。说起来可能

觉得不可思议，但只要了解其原理是造成人的视差错觉就能理解了。比如

一个平铺矩形，离得越远的边在眼睛中的投影越短，越近的边投影越长，

旋转就是将其对应的边进行放大或缩短，虽然离眼睛的实际距离相同，但

由于长短本身有差别，所以在眼睛中的投影就有差别，从而产生视觉差异

形成立体效果。 
在介绍三维旋转控件的使用方法前，先介绍一下三维旋转对话框中的

各项设置的作用。双击旋转控件 ，调出旋转设置对话框如图 7-4 所示。
系统默认的是 Easy（简单）项，当选择 Expert（高级）项时，设置对话框
会增加一些设置项，如图 7-4 所示。下面先介绍 Easy（简单）模式下的对
话框。 

       

图 7-4  简单模式下的设置对话框 

该对话框中有 3 个设置项：模式、Rotate from（旋转点）和 Distance
（距离）。模式单选钮就是用来选定 Easy（简单）和 Expert（高级）两种
模式中的一种。 

Rotate from（旋转点）下拉列表框：该列表框是用来设置图形的旋转
中心。其中包含 4 个选项：Mouse click（鼠标单击点）、Center of selection
（所选物体的中心）、Center of gravity（重心）和 Origin（原点）。Mouse click
（鼠标单击点）就是将鼠标第一单击点作为旋转中心；Center of selection
（所选物体的中心）就是将所选物体对象的中心作为旋转中心；Center of 
gravity（重心）就是将多个物体的中心作为旋转中心；Origin（原点）就
是将所选对象的左下角作为旋转中心。 

Distance（距离）文本框：该文本框是用来设置物体旋转点相对于观
察点的距离，也就是设置观察距离。距离的大小直接影响变形程度的大小。

输入数值越大，三维旋转的效果越不明显；相反输入数值越小，三维旋转

的效果越明显。所以利用它可以直接来控制旋转变形程度。它的调节范围

从 100~200，单位是磅。用户不仅可以在文本框中输入该数值。也可以通
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过拖动下面的滚动条来改变数值大小。 
当选定 Expert（高级）模式时，对话框中增加了一个新的 Project from

（投射点）下拉列表框。该下拉列表框是用来选择观察点的位置，其中包

含 5个选项，如图 7-5所示。 

      

图 7-5  高级模式下的“设置”对话框 

前面 4 个选项与 Easy（简单）模式下的旋转点意义和用法都一样，这
里不再重复介绍。当选择其中最后一个选项（X/Y coordinates）时，会出
现 X 与 Y 两个文本编辑框，分别用来设定 X 与 Y 两坐标的位置，也就是
更精确地设定观察点。而且当旋转对象时下面还会出现两个显示项，分别

用来显示 YZ平面和 XZ平面相对于页面的旋转角度。 
三维旋转的效果如图 7-6所示。 

 

图 7-6  三维旋转效果 
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F 注意 

该功能设置对话框中虽没有预览，似乎很不利于调整，但用起来用户

也许会发现该对话框类似于一个控制面板，在设置或更改设置时并不需退

出该对话框，而且该对话框还会继续显示在桌面上，同时还显示图像当前

的操作状态，所有这些也不影响图形对象的进一步操作。 

7.1.3  涂抹控件 的使用 

涂抹控件是通过给图形对象添加颜色渐变的阴影来产生动感效果。离

图形对象越远的阴影越模糊，颜色越淡，感觉就像彗星拖着一条长长的尾

巴。下面通过一个简单实例来介绍其功能和使用方法。步骤如下。 
（1）单击 Tools工具栏上新建按钮，新建一个页面。 
（2）选择菜单命令 Windows→ Inspectors→Text，调出 Text 控制面板。

将字号设置为 48，字样设置为 Comic Sons MS。 
（3）单击 Tools工具栏中的文本控件，此时鼠标变为“Ⅰ”形光标，

再将光标移到工作区某一位置单击，待出现文本框后开始输入文本“ I want 
to fly”。 
（4）选中所输入文本，单击 控件，将文本转换成路径。 
（5）打开填充面板，对转换后的文本路径进行填充。 
（6）选中该路径，双击 Xtra Tools 工具栏中的 按钮，弹出该功能编

辑对话框，如图 7-7 所示。在对话框中有两个选项，其中“Fill”是用来设
置阴影的填充颜色，“Stroke”是用来设置轮廓线的颜色，默认设置均为白
色。用户只需直接从颜色列表框（可选择菜单命令 Windows→Panels→Color 
List 调出）中拖动颜色样本到对话框中的样本框中即可。设置完毕后单击
“OK”按钮，退出对话框。 

 

  图 7-7  涂抹设置对话框 

（7）此时鼠标变成小手形状，单击对象并按住左键，同时拖动鼠标，
在拖动一段距离后释放左键。其效果如图 7-8所示。 
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图 7-8  涂抹效果图 

F 注意 

该项功能的操作对象必须是矢量图形对象，如果是文本，则必须先将

文本转化为路径。功能使用时最多只能对同一个对象使用两次，否则会出

现错误提示。而且在使用第二次涂抹时一定要按住 Alt 键，否则涂抹的会
是第一次涂抹后的整个组合对象，就会使图形变得混乱。 

7.1.4  弯曲控件 的使用 

弯曲功能主要用来使图形产生弯曲变形效果，操作方法与涂抹功能的

操作方法类似。下面也以一简单实例来说明其使用方法。步骤如下。 
（1）单击 Tools工具栏上新建按钮，新建一个页面。 
（2）单击 Tools工具栏上 按钮，绘制一个八边形。 
（3）打开填充面板对图形对象进行填充。填充完毕后按住 Alt 键，同

时单击绘制好的图形对象，再按住左键并拖动鼠标，此时便复制出另一个

八边形。 
（4）选中一个八边形，双击 按钮，调出弯曲设置对话框如图 7-9 所

示，该对话框中有一个编辑框和一个滚动条，都是用来设置弯曲程度的，

两者的功能和效果是一样的，只是表示方法不同罢了。待设置好后单击

“OK”按钮，退出对话框。 

 

图 7-9  弯曲设置对话框 
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图 7-10  弯曲对比效果 

（5）单击八边形的中心点并向上拖动鼠标，此时图形出现尖峰效果，
再单击另一个图形中心点并向下拖动鼠标，此时图形出现外凸效果，成为

花瓣状。两者对比效果如图 7-10所示。 

7.1.5  粗糙化控件 的使用 

粗糙化控件是用来使过于平滑的图形轮廓变得粗糙，从而产生逼真的

感觉。它的使用方法同弯曲和涂抹功能一样比较简单，所以在这里只对其

使用效果和设置项目进行介绍。 
双击粗糙化控件 ，弹出粗糙化设置对话框，如图 7-11 所示。该对话

框中有一个编辑框和一个滚动条，还有两个单选钮。编辑框和滚动条都是

用来设置图形轮廓线上添加的点的数目，即每一英寸增加点的数目，点越

多图形轮廓越粗糙。单选钮用来设置添加的点的类型，“Rough”表示所选
为角点，即最后边缘形成的为锯齿形，“Smooth”表示所选为曲线点，即
最后边缘形成的为曲线形。两者的对比效果如图 7-12所示。 

 

图 7-11  粗糙化设置对话框 

向

下

拖

动 
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图 7-12  两种不同设置的效果对比 

7.1.6  阴影控件 的使用 

阴影控件的作用是用来给图形对象添加各种风格的阴影，使其产生立

体效果。在运用此工具之前，我们先来了解一下该功能的设置对话框。 
首先双击 按钮，打开如图 7-13 所示的设置对话框，对话框中的第一

项是“Type”下拉列表框，用来设置阴影的类型。有一点需要注意，此处
每一种阴影类型对应一种对话框。一种为 Hard Edge（硬边）类型对话框，
另两种为 Soft Edge（软边）类型和 Zoom（缩放）类型，其设置对话框如
图 7-13所示。 

       

图 7-13  3 种阴影类型设置对话框   

首先介绍硬边阴影模式的对话框。 
Fill 下拉列表框包含 3 种选项：Color、Shade 和 Tint。选择 Color 时，

可以从颜色面板或混色器面板拖动一种颜色作为阴影颜色；选择 Shade 时，
系统将黑色与所选对象的填充色作为基色进行混色，阴影将用得到的混合

色进行填充；选择 Tint 时，系统则以对象的填充色作为基色，阴影色则取
该基色的某一色调值，用户可以通过编辑框和滚动条进行设置。 

Scale滚动条是用来设置阴影边缘相对于原对象的大小比例。 



134                      FreeHand 9.0 快学通 

 

Offset 编辑框是用来设置阴影相对于原对象的偏移距离，X 为水平方
向的偏移量，Y为垂直方向的偏移量。 

3 个按钮中有一个需要介绍一下：Apply功能是使用户的设置生效，但
并不退出对话框，功能就相当于预览。 
软边阴影模式比硬边阴影模式多了两个选项： Fade To 项和 Soft Edge

项。Fade To 项是用来设置阴影的颜色，该颜色将作为一种基色与对象本来
的颜色进行混合，混合后的颜色为阴影颜色。Soft Edge 项是用来设置混合
色中 Fade To 项的颜色比例。 
缩放阴影模式是其中最为简单的一种，其中的  Fill 项和 Stroke 项分别

是用来设置阴影的填充和轮廓线的颜色。 
3种阴影效果对比如图 7-14所示。 

 

图 7-14  不同类型阴影效果对比 

7.1.7  镜像控件 的使用 

镜像工具就是为原图形对象创建一个与其关于任意对称轴对称的对

象。它还能保留镜像前后的原本及副本，而且还能同时进行多重镜像。在

使用此工具前先了解一下镜像的设置对话框。 

双击 按钮，弹出镜像设置对话框，如图 7-15 所示。对话框中包括

了 4 种设置，分别是：Vertical（垂直），Horizontal（水平），Vertical&Horizontal
（垂直和水平）和 Multipe（多重）。它们的作用分别如下。 
（1）Vertical（垂直）：此选项的功能是将图形对象以一条垂直直线为

对称轴进行镜像。在操作时，左右移动鼠标可以移动对称轴，但始终无法

改变其垂直的属性。在拖动鼠标时如果按住 Alt 键，则可以围绕镜像中心
任意旋转对称轴，从而在任何方向都可以进行镜像操作。 
（2）Horizontal（水平）：此选项功能类似于 Vertical（垂直），只不过

是对称轴换成水平直线而已，换句话说其镜像操作就是将 Vertical（垂直）
操作的结果旋转 90°按住 Alt 键拖动鼠标，则可以围绕镜像中心任意旋转
对称轴，从而在任何方向都可以进行镜像操作。 
（3）Vertical&Horizontal（垂直和水平）：此选项的功能是同时将图形

对象进行水平和垂直两条对呈轴的镜像，而且同时保留 3 个副本。此项功
能实际上是垂直镜像和水平镜像的组合。同上面一样，按住 Alt 键拖动鼠
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标，就可以任意调节两条对称轴的方向。 
（4）Multipe（多重）：此选项功能就是使原图形对象同时产生多个镜

像，其对应设置对话框如图 7-16 所示。可以看到其中多了一个下拉列表框，
一个编辑框和一个滚动条。下拉列表框有两项：Rotate（旋转）和 Reflect
（反射），两者都使用来设置相对于每一条对称轴所产生的对象和副本的数

目及位置，Rotate 项是一个对称轴只产生一个副本，原件和副本总数目不
超过 50，Reflect 项是一个对称轴产生两个副本，原件和副本总数目不超过
100。 
设置框中还有一个 Close Paths 选项框，主要用来设置使线端相距一定

距离内的路径闭合。 

 

图 7-15  垂直设置对话框          图 7-16  垂直水平设置对话框 

其具体操作方法同上面其他功能操作方法一样，这里不做具体介绍，

请读者自己练习，此处只给出一个实例效果，如图 7-17所示。 

 

图 7-17  多重镜像效果 

7.1.8  图形喷管控件 的使用 

图形喷管是用来将不同的图案集当作填充对象对页面进行填充，形成

漂亮的背景图案。 
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为了更好地使用该功能，先了解一下该控件的各项设置。双击图形喷

管按钮 ，弹出该功能设置对话框，如图 7-18所示。 

       
图 7-18  图形喷管编辑对话框 

当在对话框上部的单选钮中选定“Hose”时，编辑对话框就是左上图，
右边的菜单是其上部下拉列表框中的选项。表 7-1 中是其中各项设置的说
明。 

表 7-1  图形喷管设置说明一览表 

       名     称                    说       明 
New 给图形库添加图案 
Rename 更改列表框中文件的名称 
Duplicate 复制生成所选文件的副本文件，文件名

为 Copy of +原文件名 

Hose
下拉

列表 
Clover,Flower,Leaves,
Shapes 

图形库已有图形文件，供填充图案是选

择 
Paste in按钮 在创建或修改图形文件时将剪贴板中的

图案粘贴到团列表中 

Copy out按钮 将选定的团拷贝到剪贴板中 

Delete按钮 将选定的图案从图案列表中删除 

Contents下拉列表 显示被选中图形文件中所有图案名称，

选定后在预览框中可以预览 

当在单选钮中选中 Options 时，编辑对话框如图 7-19 所示。下面分别
介绍一下各设置项的内容和功能。 
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图 7-19  选择 Options项时的 Hose 面板 

（1）Order（顺序）下拉列表框，该下拉列表框是用来设置填充图案
的排列顺序。它包含 3 个选项：Back and Forth（来回）、Loop（循环）和
Random（随机）。当选择 Loop（循环）时，图案导出将按导入时的顺序循
环出现，当选择 Back and Forth（来回）时，图案导出将按事先编好的编号
顺序导出。当选择 Random（随机）时，图案将以随机顺序导出。其 3 种
顺序的效果对比如图 7-20所示。 

 

图 7-20  3 种导出顺序的效果对比 

（2）Spacing（间距）下拉列表框，该列表框主要用来设置导出图案
的间距。其中有 3 个选项：Grid（网格）、Random（随机）、Variable（变
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化）。当选择 Grid（网格）时，图案间距设置就是以网格为单位进行；当
选择 Random（随机）时，图案将随鼠标的移动在页面上任意方向导出；
当选择 Variable（变化）时，可以随意设定导出图案间距的数值。 
（3）Scale（缩放）下拉列表框，该列表框是用来设定图案缩放的比

例和方式。其中包含 2 个选项：Random（随机）、Uniform（固定）。当选
择 Random（随机）时，图案随机出现，但会随其底下的编辑框和滚动条
的设置值而产生大小差异，数值越大，差异越大；数值越小，差异越小。

当选择 Uniform（固定）时，图案将按编辑框中的数值（百分比）成比例
缩放。 
（4）Rotate（旋转）下拉列表框，该列表框用来设置图案的旋转方式。

其中包括 3 种方式： Incremental（增加）、Random（随机）、Uniform（固
定）。当选择 Incremental（增加）时，图案将以编辑框中的数值为增量进
行旋转；当选择 Random（随机）时，图案将按随机角度进行旋转；当选
择 Uniform（固定）时，图案将按自己预先设定的角度旋转。Uniform（固
定）旋转始终是以一个固定角度旋转，而 Incremental（增加）旋转每次旋
转角度都不一样，并且是成比例增加的。图 7-21 所示为 3 种设置的对比图。 

 

图 7-21  三种 Rotate 设置对比效果 

7.1.9  颜色拾管控件 的使用 

颜色拾管控件的主要作用是从其他图形中获取颜色式样，从而使可供

选用的颜色品种更为丰富，同时还可以将它导入颜色列表中供以后使用。

它的使用方法极为简单：先单击 按钮，再把光标移到要拾取颜色的地方，

单击鼠标并拖动至待涂色的目标对象上，然后释放即可。 

7.1.10  图表创建控件 的使用 

图表是统计工作中最为常见的工具之一，它能十分直接地表现出统计

对象之间的对比或联系，还可以利用它来发现数据间的规律。下面详细介

Random 
方式 

Uniform 
方式 
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绍它的设置功能和使用方法。 
首先单击 Xtra Tools 工具栏中的 按钮，鼠标变成“┼”字光标。将

光标移至工作区的适当位置，再按住鼠标并拖动，此时会出现一个实线矩

形框，该矩形框就是待创建图标的控制框，选定合适大小后释放鼠标。在

释放鼠标后会弹出一个设置对话框，如图 7-22所示。 

 
图 7-22  图表设置对话框 

图 7-22 所示为处于图表数据处理模式下的设置对话框，也就是选中切
换按钮 所示的对话框。其中的各设置项的作用和说明见表 7-2。 

表 7-2  图表数据处理设置说明一览表 

名   称 说         明 

OK按钮 
确认图表设置完毕后，将该设置框中的内容应用于图表

并退出该对话框 
Cancel按钮 取消刚才所有的操作，同时退出该对话框 

Apply按钮 
设置完毕后将设置的内容应用于图表，显示效果的同时

并不退出对话框 
Decimal 
precision 文本
框 

设置图表中用到的十进制数的小数位数，小数位数在

0~4之间，超出范围时系统就会自动更改为 4位 

Thousands 
separator 选项
框 

设置是否显示千位分隔符号，即每隔 3 位数字加一个千
位分隔符号，这样方便辨认数据位数 

Undo按钮 
用于撤消前一次操作，只是前一次，连续使用两次相当

于没有使用，因为连续使用两次实际上就是第二次的撤

消操作将第一次的撤消操作撤消 
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续  表 

名   称 说         明 

Cut按钮 
将选定的内容剪下并送入剪贴板中。选取内容时可以单

击鼠标单个选取，也可拖动鼠标成片选取，还可以按住

Ctrl键不连续选取 
Copy按钮 将所选内容复制并保存在剪贴板中供以后重复使用 
Paste按钮 将剪贴板中的内容复制到选定区域 

Import按钮 
将已存在的 txt 文件导入到图表选定区域，如果超过区
域范围，系统会自动调整排列顺序 

Transpose 按
钮 

将工作表中的行、列数据进行对调，即第 n 行的数据变
为第 n列，而第 n列的数据变为第 n行 

Switch XY 按
钮 

将数据的奇偶列互换，只对散点图有效 

对话框中间有一个空白文本编辑框，此编辑框是用来输入数据的地方，

输入完毕后回车或按 Tab 键，系统就会自动将所输入的数据或文本添加到
选定的区域内，选定控制框在此时会自动进入下一个区域。 
当选中切换按钮 时，对话框进入图样选择模式，如图 7-23所示。 

 

图 7-23  图表样式设置对话框 

其中各项设置功能和说明见表 7-3。其中一些与图 7-22 相同的选项在
此不再重复介绍。 

表 7-3  图表样式设置说明一览表 

名   称 说          明 
Chart type 切换按
钮 

选择图表样式，FreeHand9.0中有 6 种样式：柱形图、
条形图、折线图、饼形图、面积图和散点图 

Column width 编
辑框 

设置数据柱的框度 
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 续  表 
名   称 说          明 

Axis display 下拉
列表框 

设置坐标轴的显示方式，其中包含 3 个选项：Show left 
axis（显示左坐标轴）,Show right axis（显示右坐标轴）
和 Show both（左右坐标轴都显示） 

Axis options 选项
钮 

进一步设置图表中两个坐标轴，包含 X axis 和 Y axis
两个设置项。 

Gridlines选项框 
设置网格线的显示方式，其中有两个复选框：X axis
和 Y axis，它们分别是控制 X、Y 轴的网格线是否显
示 

Data numbers in 
chart选项 

设置是否将数据显示在图表中，注意此选项在面积图

中无效 

Drop shadow 选项 
设置是否使用阴影特效，注意此选项对折线图和散点

图无效 
Legend across top
选项 

设置是否将图标放在图表的上方，默认情况是放在图

表的右上方 

当需要对 Y 轴或 X 轴进一步设置时，单击 Axis options 选项钮中的或
“X axis”按钮，即可调出该轴设置对话框如图 7-24 所示（此处为单击“Y 
axis”按钮）。 

 

图 7-24  Y 轴设置对话框 

对话框中上面的 Axis values 项包含两个单选钮，它们是用来设置坐标
上的刻度值。当选择其中 Calculate from data（数据计算）单选钮时，系统
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会自动从表格数据中计算出合适的单位刻度值；当选择其中的 Manual（手
动）时，下面的 3 个状态项都变成可编辑的文本框，可在其中相应的编辑
框中设置绘图所需的最大刻度值、最小刻度值和刻度间隔值。 
在设置对话框中间的 Tick marks 项是用来设置刻度标记方式。其包含

两个选项：Major（主刻度）和 Minor（副刻度）。两个下拉列表框中都含
有 4 种显示方式：None（无刻度线）、Across axis（交叉刻度线）、Inside axis
（内侧刻度线）和 Outside axis（外侧刻度线）。当选中 Across axis（交叉
刻度线）时，刻度线就会横穿坐标轴；当选中 Inside axis（内侧刻度线）
时，刻度线将分布在坐标轴内侧；当选中 Outside axis（外侧刻度线）时，
刻度线将分布在坐标轴外侧。它们的效果对比如图 7-25所示。 

 

图 7-25    刻度线的不同显示方式效果对比 

在 Minor（副刻度）下拉列表框的下方，有一个 Count（数量）编辑文
本框，该文本框是用来设置分刻度线的数量。 
在设置对话框最下面有两个文本编辑框，是用来设置坐标刻度值标签

的。其中 Prefix 项是用来设置字符前缀的，而 Suffix 是用来设置字符后缀
的。效果如图 7-26所示。 

 

图 7-26  添加前后缀和网格效果 
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7.2  Xtra Operations 工具栏的使用 

Xtra Operations 工具 Xtra Operations 与 Xtra Tools工具的使用方法基
本相同，不过不像 Xtra Tools 工具那样产生新的图形副本，而是直接在图
形对象上体现操作效果。 
选择菜单命令 Window→Toolbars→Xtra Operations 调出该外挂操作工

具栏。如图 7-27所示。 

 

图 7-27  Xtra Operations工具栏 

该工具栏中共有 19 个控件，有一部分前面章节已介绍过，所以在本章
中只对其中剩下几个较为常用控件作以介绍。 

7.2.1  弯折控件 的使用 

弯折控件是用来使图形边角上的每个节点有规则的生成附加线段，从

而产生一个复杂而漂亮的图案。进行弯着的次数越多，图形越复杂，不过

最好不要弯折次数太多，否则机器的刷新速度可能让人无法忍受。该工具

使用方法同 Xtra Tools 工具栏中的控件类似，这里不再介绍。其控件使用
效果如图 7-28所示。 

 

图 7-28  椭圆的多次弯折效果 
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7.2.2  陷印控件 的使用 

陷印控件主要用来弥补打印效果，使用该工具可以为带有基本笔触及

基本填色的图形对象补漏白。换句话说就是使打印机在此位置多打印几遍，

以达到补漏白效果。双击该控件，调出编辑对话框，如图 7-29所示。 
对话框中包含 3 个选项：Trap width（陷印宽度），Reverse traps（倒置

陷印），Trap Color Method（陷印颜色方式）。Trap width（陷印宽度）编辑
框使用来设置陷印宽度：Reverse traps（倒置陷印）选项是用来设置是否
使用逆转补漏白操作；Trap Color Method（陷印颜色方式）单选钮使用来
选择补漏白的方式。其中有两项可以选择，一种是直接取图形对象内部的

填充色作为补漏白的颜色；另一种是以图形内部的颜色作为基色，而取其

中一个色调值作为补漏白的颜色。 
使用方法很简单：选定操作对象，双击该控件，在弹出的设置对话框

中进行设置，设置完毕后单击“OK”按钮退出对话框完成操作，此时可以
发现图形已发生变化。 

 
图 7-29  陷印设置编辑框 

7.2.3  混合控件 的使用 

混合控件的功能是所有外挂功能中最为奇特的一种。它生成的图像让

人觉得不可思议，下面就让我们来看看它的奇异之处。 
混合实际上就是在两个不同图形之间创建一条渐变的路径，并用过渡

图形进行填充。这些填充对象一般被称之为级。在学习该控件之前，先了

解一下该功能的各项设置。选择混合好的路径后，打开对象面板，如图 7-30
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所示。 

 

图 7-30  混合设置面板 

从图 7-30 中可以看到设置面板中有两个可以设置的选项：Number of 
steps（混合阶数）和 Range（范围）。Number of steps（混合阶数）编辑框
是用来设置混合阶数的数目，也就是设置过渡对象的个数。默认值为 25。
Range（范围）编辑框是用来决定过渡体中的第一级和最后一级的宽度。
其中下面的 First 文本框是用来决定过渡体中第一级的颜色相对于两个原
对象填充色的差别程度，同时也决定了原对象和第一级的距离与两对象间

距离的百分比。另一个 Last 文本框的作用与 First 文本框的作用一样，不
过计算对象是以第二原对象为参考点。实际上这两个文本框的数值是随级

数和两原对象间的距离的变化而变化的，所以一般设置级数就可以了。 
下面通过几个小实例介绍几种混合方式的方法。 
（1）两个单独对象的混合。在混合两个对象之前必须注意几个问题：

组合对象和复合对象不能参与混合；非路径化的文本也不能参与混合；路

径方式不同也不能混合，比如开放路径和封闭路径；还有一个是填充路径

和非填充路径不能混合。两个选定的路径还可以通过正方向 和反方向

命令，将两个路径的方向调成相同和相反，而由此产生的效果大不相同，

感觉上就像被拧了 180°。混合完成后仍然可以进行正方向或反方向修改，
只需在用鼠标单击原对象的同时按住 Alt 键，然后单击正方向或反方向控
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件即可。正反方向混合效果对比如图 7-31所示。 
（2）路径上点的对应混合。在进行混合的过程中，两个路径的混合都

是默认的点对应混合，即第一个路径上的 A点和第二个路径上的 a 点对应
混合。当两个路径上的节点数不同时系统会自动的进行添加节点，直至两

者的节点数相同。但当节点数相差较大时，混合就会产生混乱，无法控制，

结果可能与设想的大相径庭。所以在混合前应设置好点点之间的对应，比

如第一个路径上的 A 点与第二个路径上的 b 点或 c 点混合，这些都应预先
设置好，设置方法是：先选定要混合的两个路径，再单击解组控件 将两

个路径打散为自由路径。再单击两个要对应混合的节点，比如第一个路径

上的 A点与第二个路径上的 b点。待选定两个对应点后单击混合控件即可。
对应点不同的混合效果如图 7-32所示。 

 
图 7-31  正反方向不同效果对比 

（3）多条路径的混合。多条路径混合与两条路径混合的操作过程相差
不大，都很简单。只不过在选择路径的同时多选了几条。有一点要注意：

多条路径混合后的次序与选中对象时的次序无关，只与路径的排放有关，

所以在混合前应排好各路径的顺序。排顺序可以通过单击鼠标右键，在弹

出的菜单中 Arrange 命令下的子菜单中进行。多条路径的混合效果如图
7-33所示。 
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图 7-32  对应点不同的混合效果对比 

 

图 7-33  多条路径混合效果 

（4）混合到路径。先按照前面所讲的方法混合好两个或多个路径，再
同时选定新路径（新路径可以是任意的）和已混合好的路径，然后单击 控

件即可。效果如图 7-34所示。 
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图 7-34  混合到路径效果 

7.2.4  简化控件 的使用 

简化控件的作用就是将图形对象的轮廓进行简化处理，尽量减少边角

点，这样可以减少存储空间和提高显示速度。它的使用方法同其他控件的

使用方法类似。先选中图形对象，再单击控件 （此控件只用单击简化就

可调出对话框），调出的简化设置对话框如图 7-35 所示，对话框中只有一
个编辑项，就是简化程度，范围从 1～10。设置完毕后，单击 Apply 即可
进行预览，此时如果发现效果不明显，可以多使用几次此项功能，此功能

可以在同一个图形对象上使用多次，待简化效果满意后再单击“OK”按钮
退出对话框即可。此功能的使用效果如图 7-36 所示。此处将简化程度设为
10，使用简化次数为 2次。 

 
图 7-35  简化设置对话框 
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图 7-36  简化效果对比 

7.2.5  删除重叠控件 的使用 

删除重叠控件是用来在不改变自身路径形状的情况下尽量删除重叠部

分多余的线条。其使用方法十分简单，完全不需要设置，只需选中有重叠

部分的图形对象，再单击该控件 即可。其使用效果如图 7-37所示。 

 

图 7-37  效果对比 

7.2.6  逆反方向控件 的使用 
前面讲过 FreeHand9.0 是一个矢量绘图软件，用它绘出的图形路径都

是矢量性质的，就是说都有方向的。方向相对而言有两种：正方向和反方

向。系统默认情况一般是：闭合路径的正方向为顺时针方向，开放路径的

正方向是由起始点指向路径的终点的方向。它的主要是用来使原混合图形

对象发生扭转或纠正扭转方向。 

7.2.7  矫正方向控件 的使用 

矫正方向的功能正好与逆反方向的相反，其使用方法完全一样。此处

不再赘述。其使用效果如图 7-38所示。 

删 除

后 的

图 形

对象 
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图 7-38  矫正前后的效果对比 

7.2.8  添加注释控件 的使用 

添加注释控件的作用就是给创建的图形对象添加名称和注解信息。它

的使用方法也较为简单：先选定要加以注释的图形对象，再单击添加注释

控件 ，弹出该控件的设置对话框，如图 7-39 所示。对话框中有两个文本
编辑框，上面的编辑框是用来添加所创建的图形名称的，下面的是用来添

加注解信息的。待添加完所需添加的信息后按回车键即可完成添加注释操

作，最后单击关闭按钮退出对话框。系统会自动将添加的注释信息添加到

图形对象上。如果以后要更改注释信息，只需在选中对象后再次单击该控

件即可调出已添加信息的对话框，然后便可以任意修改了。 
 
 
 

 

图 7-39  添加注释对话框 

7.2.9  浮雕控件 的使用 

浮雕控件的功能是给图形对象添加各种浮雕效果。它的效果类似于阴

影特效，但又不完全相同，相较而言它拥有更多的种类和更精确的设置。

下面就详细介绍该功能的设置和使用方法。 
在使用此功能之前，先了解一下浮雕设置对话框中各项设置的功能和

说明。首先选定一个图形对象，注意此处的图形对象必须是一个可填充的

封闭路径，并切实已经填充好了的。再单击浮雕按钮 ，调出浮雕设置对

话框，如图 7-40所示。 

输入注解信息 
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图 7-40  浮雕设置对话框 

对话框中有 5个设置项。 
（1）Type（类型）下拉列表框：该列表框用来选定浮雕的类型。在  

FreeHand 9.0 中提供了物种浮雕类型。分别是：Emboss（浮雕）、Deboss
（凹雕）、Chisel（凿雕）、Ridge（脊雕）、Quilt（褶雕）。选定所需类型后，
它的效果就会显示在上面的类型框中。 
（2）Vary（变化）下拉列表框：该列表框是用来选定边框的颜色。它

有两个选项：Contrast（对比度）和 Color（颜色）。当选定 Contrast（对比
度）时，系统会通过给其两边添加不同颜色深度的边框来产生浮雕效果，

可以通过下面的文本编辑框或滚动条来设定，两者效果一样。当选定 Color
（颜色）时，对话框中会出现两个新的选项：Highlight（高亮）和 Shadow
（阴影）。前面是用来设定亮区颜色，后面是用来设定阴影的颜色。 
（3）Depth（深度）文本编辑框：该文本编辑框是用来设置系统创建

的新边框和原始轮廓线间的距离。也就是浮雕凸出或凹进的深度。 
（4）Angel（角度）文本编辑框：该文本编辑框是用来设置系统创建

的新边框下相对于原始对象偏移的角度。 
（5）Soft Edge（边缘柔化）选项框：该选项框是用来设置边框的阴

影是否进行软化处理。但此选项在 Chisel（凿雕）、Ridge（脊雕）和 Quilt
（褶雕）3种浮雕模式下无效。 
在选定对象并设置完毕后，单击 Apply进行预览，如果效果达到用户

要求，则单击“OK”按钮退出对话框即可。如果效果不够明显，可以多次
使用此工具，直到达到满意效果为止。 

5种浮雕效果的使用对比如图 7-41所示。 
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图 7-41  5 种浮雕效果对比 

7.2.10  添加控制点控件 的使用 

添加控制点控件是用来给图形对象添加新的控制节点，从而让用户能

使用更精确的操作。 
添加控制节点时所添加的节点数与路径的类型有关，当路径为闭合路

径时且其节点数为 n 个时，使用一次该命令，节点数就会变为 2n 个，再使
用一次次命令节点数就会变为 4n 个，即节点数是成倍增加。当路径为开放
路径时且节点数为 n 个时，使用一次该命令，节点数变为 2n-1 个，再使用
一次变为 4n-3个。 
添加控制节点效果如图 7-42 所示。此处为使用该控件 3 次，上面为封

闭路径，下面为开放路径，左边为使用该功能前的效果。 

 

图 7-42  不同类型路径添加节点效果对比 

这一章也讲完了，到此用户已经学习了路径和文本的基本操作及其对

应的一些效果的渲染，关于实际操作的部分已经告一段落，用户可以使用

得心应手地使用 FreeHand 9.0 创作一些作品了。好好结合实例深造
FreeHand 9.0吧！ 

 

凹雕效果  

凿雕效果 

褶雕效果 
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第 8 章  文件管理 

在使用计算机工作过程中，或者在工作完成后，都需要将自己的成果

以文件的形式存储在计算机外部存储设备中，如硬盘、软盘等。而通常所

说的打开一个文件，也是只从计算机的外部存储设备中，调入一个文件。

文件就是一些相关数据的集合。用户在使用软件的过程中，必须经过新建、

打开、修改、保存等文件操作过程。 
在 FreeHand 9.0 中，用户不仅可以在本文件内进行数据共享，而且可

以和其他软件进行资源共享，而应用到一些相关的操作。本章将详细讲述

FreeHand 9.0的文件管理等相关问题。 

8 .1  FreeHand 9.0支持的图形文件格式 

各种图形文件，使用不同的软件存储时就有不同的图形存储格式，而

FreeHand 9.0支持多种不同的图形文件格式，而且也被其他软件所兼容。 
当前，图形软件是层出不穷，因此图形文件的格式也就日益增加。所

谓图形文件格式，就是指有不同的图形处理软件所得到的图形文件的不同

的存盘格式，而不同的格式就由不同的文件扩展名来表示。例如，FreeHand 
9.0 的默认文件扩展名为 .fh9，而 Photoshop 的默认扩展名为.psd。这些扩
展名可以区分与其他不同的文件的标志。而当前已经存在的图形文件格式，

总数多达几十种，但总体上讲，基本分为两大类，就是位图文件格式和矢

量图文件格式。下面介绍一下 FreeHand 9.0中的常用图形文件格式。 

（1）BMP 
BMP 是由 Microsoft 公司开发的位图文件格式，它被基于 Intel 处理器

的计算机的众多操作系统如 DOS、WINDOWS3.X/95/98、WINDOWS NT
等所支持，而且也能够被其他众多的图形软件所使用。该格式支持 1 位、4
位、8位、16位、24位、32位颜色，支持 RLE压缩文件。 

FreeHand 9.0 能够引入该文件，也能够将自身绘图导出为位图格式，
并且在导入导出时，可以调整图形的分辨率。 

（2）JPEG/JPG 
JPEG 是 Joint Photographic Experts Group（联合图像专家组）的缩写，

是一个可压缩的位图文件格式，几乎为所有的平台所支持，又称为有损压

缩格式，其在压缩时会丢失一些原图像中的像素，一般应用于非印刷行业。

使用这种图形文件格式时，可以自由设置图形的压缩比例，压缩比越高，

文件越小，但图像质量越差；反之，压缩比越低，则文件越大，图像质量

也越好。网络上经常使用这种图形文件格式。 
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FreeHand 9.0可同时支持该文件的导入和导出。 

（3）GIF 
GIF 是 Graphics Interchange Format（图形交换格式）的缩写，是由

CompuServe 公司开发的位图文件格式，易于联机转移位图文件，为多种平
台如 DOS、WINDOWS3.X/95/98、WINDOWS NT、UNIX、Macintosh、Amiga
等支持。GIF 为 8 位位图格式，支持 256 色，用户使用 LZW压缩方案可以
将文件压缩成为原始文件尺寸的一半左右。这种文件格式的优点是图像文

件小，但图像质量较高，可以在一个单独的文件中保存多个位图文件。 
FreeHand 9.0也可同时支持该文件的导入和导出。 

（4）DXF 
DXF是计算机辅助设计应用程序的矢量文件格式，为DOS、WINDOWS

所支持。该种文件格式支持 256 色，可保存三维图像，但不能被压缩。这
种图形是二维图形文件的交换格式，用于二维编辑应用软件、三维编辑应

用软件以及矢量绘图应用软件间的文件交换。大多数的三维图形编辑软件

支持这种文件格式，CorelDRAW也支持该种图形文件格式。 
FreeHand 9.0 支持该种文件的导入，但不支持该种图形文件格式的导

出。 

（5）EPS 
EPS 是由 Adobe Systems 公司开发的矢量文件格式，为 DOS、

WINDOWS、UNIX、Macintosh 等众多操作系统所支持，同时也被基于这
些操作系统的软件所支持。另外 EPS 图形文件格式是目前印刷行业中最受
欢迎的也是最理想的图形文件格式。目前众多的印刷厂家都使用这种图形

文件格式。 
FreeHand 9.0 能够同时支持导入和导出该格式的文件，或者进一步地

进行编辑。EPS 格式文件可以包含矢量图形或位图图像，可以在许多绘图
软件中获得该格式的文件。 

（6）PNG 
PNG 也是一种位图文件格式，它的最大优势在于能够提供无损压缩，

并可支持 64位颜色，输出图像颜色数极高。 
FreeHand 9.0也能够同时支持该格式文件的导入和导出。 

（7）TIFF 
TIFF 是 Tagged Image File Format（标签图像文件格式）的简称，是商

业印刷中常用的图形格式之一，它由 Aldus 公司开发，也是一种位图文件
格式，为 DOS、WINDOWS、UNIX、Macintosh、Amiga 等所支持。大多
数的绘图、图像、桌面印刷应用程序都支持该文件格式。该格式支持 24
位颜色，支持 RLE、LZW、CCITT3 组和 4 组及 JPEG 压缩格式，是广泛
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应用于各种平台和应用程序的见保存和交换图形信息的文件格式。 
FreeHand 9.0 可以导入和导出该文件，同时可以转换它，当把文件导

出为 TIFF格式时，将把该文件栅格化。 

（8）HPGL 
HPGL 是 Hewlett-Packard Graphics Language（惠普图形语言）的缩写，

是由惠普公司开发的，由商业印刷绘图仪可以得到该种格式的图形文件。 
FreeHand 9.0也同时支持该格式文件的导入和导出。 

（9）TARGA 
TARGA为位图格式文件，由 Truevision公司开发，为 DOS、WINDOWS、

UNIX、Macintosh 等多种平台和应用程序所支持，支持 32 位颜色，图像大
小不受限制，支持 RLE 压缩方案，广泛应用于绘画、图形和图像应用程序
和专业静态视频编辑中。 

FreeHand 9.0 也能同时支持导入和导出该种格式的文件，并且在导入
和导出时，还可以设计图形的分辨率。 

（10）PSD 
PSD 是 Adobe Photoshop 的位图文件格式，为 DOS、WINDOWS、

Macintosh 等平台的支持，支持 RLE 压缩方案，广泛应用于出版、印刷、
平面设计等诸多领域。 

FreeHand 9.0可以引入该文件格式，但不能导出。 

（11）AI 
AI 即 Adobe Illustrator，是由 Adobe Systems 公司所开发的矢量文件格

式，为 WINDOWS 平台和大量基于 WINDOWS 平台的绘图应用软件所支
持。 

FreeHand 9.0 可以直接打开、导入或导出该文件格式，并可进行参数
设置。 

8.2  文件管理 

用户都保护好自己的劳动成果，那么你必须学会管理好自己的文件。

对于计算机用户来说，了解和掌握文件管理是十分重要的。对于 FreeHand 
9.0 来说，文件管理主要包括：新建文件、打开文件、恢复文件、保存文
件、另存文件和关闭文件等操作。如果稍不小心，可能会使自己的劳动成

果付诸东流，所以必须十分重视。 

8.2.1  新建文件 

人要写字，要拿出一张新的信纸；画家绘画，也要摊开一张新的画布。

当你需要用 FreeHand 9.0 开始创作时，也要新建一个文件。在 FreeHand 9.0
中，创建一个新文件的方法很多，而且都十分简洁。 
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图 8-1  “Wizard”对话框 

用户可以在开始启动时的 Wizard对话框（如图 8-1 所示）中单击 New
按钮来新建一个文件；也可以在 File菜单中单击 New命令来新建一个文件；
还可以在主工具栏中单击 按钮来建立新文件；也可以使用快捷键 Ctrl + 
N来创建。 
新建的文件在没有被命名之前，系统默认为 Untitled-1。工作结束存盘

后，可以给文件赋予一个新名字，以后再打开该文件时，标题栏将显示新

的文件名。 

8.2.2  打开文件 

如果用户想要编辑的文件是一个已经存档过的文件，那么就要先打开

它，才能对其进行修改。打开文件的方法也有很多，可以在 Wizard 对话框
中单击 Open 按钮来打开一个文件，也可以在 File 菜单中单击 Open 命令来
打开，或者在主工具栏中单击 来打开，也可以用快捷键 Ctrl + N 来打开
一个文件。另外，用户还可以在我的电脑或资源管理器中用鼠标双击一个

FreeHand 9.0 文件来启动 FreeHand 9.0 打开该文件。打开文件时，都会出
现如图 8-2所示的一个 Open Document（打开文件）对话框。 

 

图 8-2  “Open Document”对话框 

该对话框中可以设置的选项如下。 
（1）查找范围下拉列表框：单击该列表框右边下拉箭头，可以显示系

统目录树结构，从中单击文件夹名可改变搜寻的目标位置。 
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（2）文件/文件夹列表框：显示在查找范围所选定的文件夹中所包含
的所有子文件夹和文件的名称。 
（3）文件名文本框：显示文件/文件夹列表框中所选定的文件的名称，

但不能显示文件夹的名称。 
（4）文件类型下拉列表框：显示了 FreeHand 9.0 可以支持的所有文件

格式。 
在该对话框中，选择所要打开文件所在的驱动器和路径，还要选择文

件类型和文件名，全部选择好以后，单击打开按钮就可以打开所要编辑的

文件。 

n 小技巧 

打开文件时，除了单击打开按钮以外，还可以直接在文件/文件夹列表
框中双击所要打开的文件来打开该文件。 

FreeHand 9.0 可以直接打开的文件格式，除了前一节所讲的图形文件
格式以外，还有以下几种：ASCII Text（*.txt）、AutoCAD DXF（*.dxf）、
CGM Graphics（*.cgm）、CorelDRAW（*.cdr）、FreeHand 旧版本图形格式
（*.fh3、*.fh4、*.fh5、*.fh7、*.fh8）等。有些格式的文件可以在预览栏
内预览。当打开这些文件时，在文件窗口的标题栏中可以看到文件名，但

扩展名改变了，存盘时会自动存成 FreeHand 9.0的格式。 
FreeHand 的打开文件对话框中，有一个“Setup”按钮，但通常情况下

是灰色的，只有在打开某些特定的文件格式时，才会可用。如纯文本、

AutoCAD、HPGL Graphics 等格式。单击此按钮，可以打开相应的对话框
进行参数设置。 

8.2.3  恢复文件 

恢复文件是 FreeHand 9.0 的一个特有的功能，对于初学者来说，这项
功能十分有用。在没有存盘前，此功能能将文件恢复到最近一次存盘的内

容，这使用户可以大胆对文件进行修改。如果对修改结果不满意，而要全

部去掉又十分麻烦的时候，可以使用此功能。此项功能是 File 菜单下的
Revert，单击此处，选择 Revert，就可以恢复到原来的状态。 

F 注意 

要提醒用户的是，使用恢复功能，只能把文件恢复到最近一次存盘的

情形，这对某些用户可能并不十分满意。有时候存盘比较频繁，只能去掉

最近的几次修改，而有时候长时间没有存盘，则会使得用户想保留的修改

也被删掉。要避免这种情况，只能把握时机，在觉得修改满意后立即存盘，

分段进行工作，这也是工作中的一点技巧。 
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8.2.4  保存文件 

当用户完成工作或要关闭计算机时，需要对文件进行保存。保存文件，

可以从 File 菜单中选择 Save 命令，也可以单击主工具栏上的 按钮，还

可以使用快捷键 Ctrl + S 来保存文件，具体使用哪一种方法，随个人喜好
而定。 
如果是对新建的文件首次保存，则会出现 Save Document（保存文件）

对话框，如图 8-3所示。 

 

图 8-3  “Save Document”对话框 

需要保存文件的驱动器和文件夹，可以在保存的下拉框和文件 /文件夹
中选取，文件名可以在文件名文本框中输入，然后选取保存类型，最后单

击“保存”按钮即可。 
FreeHand 9.0中，文件的保存类型共有 3种，分别是： 
（1）FreeHand Document：该项类型可以存储的内容包括面板所有的

设置及 FreeHand 9.0 工作页面内外的所有元素。再次打开文件时，可以再
次编辑。 
（2）FreeHand Template：该项类型是将文件保存为模板文件。 
（3）Editable EPS：该项类型将文件保存为可编辑的文件。 
如果是已经保存过的文件，以后再次保存时，将不会出现对话框，而

直接按原路径加以保存。 

8.2.5  另存文件 

若要将一选定文件保存副本时，可以从 File 菜单下选择 Save As 命令
来换名存盘。选择该命令后，将弹出和第一次存盘时相同的 Save Document
对话框，要求用户重新命名。 

8.2.6  关闭文件 

当用户关闭文件或者关闭应用程序时，如果文件未存盘或者在最后一

次存盘后又经过修改，则系统会弹出如图 8-4提示框。 
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图 8-4   系统存盘提示框 

如果选择“Yes”按钮，则保存并关闭文件。如果选择“No”按钮，
则直接关闭文件。如果选择“Cancel”按钮，则返回编辑界面重新编辑。 

8.3  导入文件与导出文件 

FreeHand 9支持许多种文件格式，如果用户希望用 FreeHand 9.0 打开
非 FreeHand 9.0 文件，或者希望将 FreeHand 9.0 中制作的文件存为其他格
式时，应该选用 Import（导入）和 Export（导出）命令。 

8.3.1  导入文件 

在 FreeHand 9.0 中，用户可以使用 File 菜单下的 Import 命令，来导入
由其他应用程序创建的图形文件，也可直接单击主工具栏中的 按钮，打

开 Import Document对话框，如图 8-5所示。 
FreeHand 9.0 中，Import Document 对话框和 Open Document 对话框所

包含的可以设置的选项几乎是一样的，操作过程也相似，也只有某些特殊

格式的文件时，“Setup”按钮才有效，单击也可以弹出一对话框，让用户
设置格式选项。 

 

图 8-5   “Import Document”对话框 

8.3.2  导出文件 

FreeHand 9.0 中，若要使用非默认格式存储某一幅绘图时，就要使用
Export 命令。使用 Export 命令时，先选定需要导出的图形，然后从 File 菜
单下选择 Export 命令，弹出如图 8-6 所示的 Export Document 对话框，在
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该对话框中为文件命名，并选择文件的存储格式。 

 

图 8-6  Export Document 对话框 

该对话框为导出文件提供了以下选项。 
（1）保存在下拉列表框：主要用来提供文件保存的驱动器和文件夹。 
（2）文件/文件夹列表框：显示选定文件夹所包含的子文件夹和文件

的名称。 
（3）文件名文本框：在该文本框中键入要保存的文件名称。 
（4）保存类型下拉列表框：从中选择需要保存的文件格式。 
（5）Selected objects only复选框：选定该框时，只导出选定的对象。 
（6）Pages范围选项：选定导出文件的页面范围。 
（7）Option in external application 复选框：选择该复选框，可单击下

面的按钮弹出“Please select a valid external application”对话框，如图 8-7
所示，在该对话框中可以指定用于打开导出文件的外部应用程序。 

 

图 8-7  为导出文件指定外部应用程序 

对于一些文件格式，在导出时需要设置其输出参数。对于 EPS 格式，
要求用户设置文件所包含的信息及输出文件的彩色模式，单击“Setup”按
钮会弹出如图 8-8所示对话框。 
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图 8-8  “EPS Export”对话框 

在确定了需要导出的文件类型和保存位置后，单击“Export Document”
对话框中的保存按钮，即可将选定的文件导出为所需要的类型，并保存到

指定文件夹。 

8.4  生成文件报告 

有的时候，用户需要列出文件的一份信息清单，以供他人或单位参考，

如需要为公司提供一份文件报告，使之了解文件大小、所用字体、颜色等

各项信息，此时就可以使用该功能。要生成某个文件的报告，从 File 菜单
中选择 Report命令，打开“Document Report”对话框，如图 8-9所示。 

 

图 8-9  “Document Report”对话框 

Document Report 对话框的左边为报告类型，右边是每个类型的详细选
项，不同的报告有不同的选项。当所有的内容都已经选定之后，单击“OK”
按钮，就会弹出 Document Report Viewer（文件报告预览框）对话框，单
击“Print”按钮，可以打印所显示的报告内容；单击“Save”按钮，可将
所显示报告存入磁盘。 

8.4.1  文件（Document）报告 

要在报告中显示文件的相关信息，在 Document Report 对话框中选择
Document 单选按钮，更改右边所需显示信息后，单击“OK”按钮创建报
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告。显示信息如下。 
（1）File name（文件名）：显示文件名称。 
（2）Directory（存储路径）：显示文件在磁盘上的存储路径，包含驱

动器名、各级文件夹名和文件名。 
（3）File size（文件尺寸）：以字节数表示文件的大小。 
（4）File access（文件锁定）：显示选定文件是否被所定。 
（5）Creation date（创建日期）：显示文件首次创建的日期和时间，以

系统时间为基准。 
（6）Modification date（修改日期）：显示修改和最后存储文件的日期

和时间。 
（7）Document units（文件单位）：在报告中显示文件面板中指定的单

位，也是报告中所有选项使用的单位。 
8． Total pages（页数统计）：在生成的报告中显示选定文件的页数。 

8.4.2  页面（Pages）报告 

在 Document Report 对话框中选择“Pages”单选按钮，Options 选项区
将显示如图 8-10 所示选项信息，从中可对生成报告中有关页面信息进行设
置。 

 

图 8-10  Pages报告 

Options中的选项主要有。 
（1）Page location（页面位置）：显示页面原点的坐标值（x，y）。 
（2）Dimensions（页面尺寸）：显示页面的宽度和高度。 
（3）Bleed size（可打印区域）：指定打印的页面边界以外部分的尺寸。 
（4）Orientation（页面方向）：显示页面方向为横向或纵向。 
（5）Page type（纸张类型）：显示所选择的纸张的类型和尺寸。 

F 注意： 
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如果选定的是多页文件，当启用相应的选项时，报告中会首先注明文

件的总页数，然后按页码顺序列出各页的相关信息。 

8.4.3  对象（Objects）报告 

在对话框中选择“Objects”单选按钮，Options 选项区中将显示如图
8-11所示的选项信息，从中可对生成报告中有关的页面信息进行设置。 

 

图 8-11  Objects报告 

Objects选项区包括如下 3个选项。 
（1）Set Note（设置标注）：在报告中显示文件中某一对象所添加的

注释内容。 
（2）Halftone（半色调）：显示在绘图中使用的半色调网屏设置信息。 
（3）Placed file（防止对象信息）：若文件中有外来其他格式图形对象，

该项可显示此对象的格式、大小和来源。 

8.4.4  字体（Fonts）报告 

在对话框中选择“Fonts”单选按钮，Options 选项区中将显示如图 8-12
所示的选项信息，从中可对生成报告中有关字体信息的选项进行设置。 

 

图 8-12  Fonts报告 
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Options选项区包括如下 5个选项： 
（1）Font name（字体名）：显示文件所使用字体的名称。 
（2）Font PS name（PS 字体名）：PS 字体是指用于能够支持 PostScript

语言的计算机或打印机上的字体，一般不用考虑该项。 
（3）Font File format（字体文件格式）：显示字体格式名称。 
（4）Font style（字体样式）：显示字体的样式，如加粗、倾斜等。 
（5）Size（字体大小）：显示字体的大小。 

8.4.5  文本块（Text Blocks）报告 

在 FreeHand 9中，文本都是以文本块的形式存在的，在对话框中选定
Text Blocks单选按钮，可以选定所需显示的选项信息。 

 

图 8-13  Text Blocks报告 

Options中包含如下几个选项。 
（1）Fonts used（使用的字体）：显示选定文件所应用的全部字体名称。 
（2）Colors used（使用的颜色）：列出文件所指定的文本块中已经命

名的颜色。 
（3）Bounding box（约束框信息）：显示约束框的形状、名称等信息。 
（4）Line count（行数统计）：显示文件中所有文本的行数。 
（5）Paragraph count（段落统计）：显示文本段落的总数等信息。 
（6）First line（首行）：显示文本的首行信息，如首行距等。 

F 注意 

如果用户在给文本着色之前，已经对要应用的颜色在 Color 面板中进
行了命名，则启用该项后，可以在报告中列出所有的颜色的名称。如果先

为文本指定了一种颜色，然后再放到 Color List 面板中，即使启用了该选
项也不会显示报告中颜色的名称。 
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8.4.6  图层（Layers）报告 

在 Document Report 对话框中选择“Layers”单选按钮，Options 选项
区中将显示如图 8-14 所示的各选项信息。这些选项用来指定报告中要显示
的有关的图层信息。 

 

图 8-14  Layers报告 

Options选项区中包括如下几个选项。 
（1）Foreground layers（前景层）：在报告中列出文件中所有的前景图

层。 
（2）Background layers（背景层）：在报告中列出文件所有的背景图

层。 
（3）Visibility（可见性）：在报告中显示层的属性信息，如是否可见

等。 
（4）Editing color（编辑颜色）：在报告中显示拥护自定义颜色的名称

等。 
（5）Access（锁定）：显示记录层是否被锁定。 
（6）Preview status（预览模式）：显示每个图层的预览模式。 

8.4.7  样式（Styles）报告 

在 Document Report 对话框中选择“Styles”单选按钮，Options 选项
区中将显示如图 8-15 所示的各项信息。这些选项用来设置是否在报告中显
示图形样式和文本样式等信息。 
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图 8-15  Styles报告 

Options中包含如下两个选项。 
（1）Graphic styles（图形样式）：对选定对象所应用的图形样式在报

告中列出其父样式及在此基础上派生出的各种变化，包括颜色、线条、填

充和半色调 4个组。 
（2）Text styles（文本样式）：列出 Styles 面板中的每一个文本样式的

父样式、字体、行距、段落间距、颜色等信息。 

8.4.8  颜色（Colors）报告 

在 Document Report 对话框中选择 Colors 单选按钮，Options 选项区中
将显示如图 8-16 所示的各项信息。这些选项主要用来指定报告中有关颜色
的信息。 

 
图 8-16  Colors报告 

Options中包括如下两个选项。 
（1）Named colors（已命名颜色）：在报告中显示 FreeHand 9.0 中所

有的已命名颜色的名称。显示内容有 Color List 面板中的颜色列表框中的
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颜色名称来决定。 
（2）Separations（显示分色）：显示使用的分色名称。 

8.4.9  输出选项（Output Options）报告 

Output Options报告是 FreeHand 9.0的 Document Report对话框中最后
一个报告类型。选择 Output Options 单选按钮，该选项区选项主要用来指
定在报告中显示的输出设置信息。 

 
图 8-17  Output Options报告 

Options中包括如下几个选项。 
（1）Invisible layers（隐藏图层）：启用该选项后，可以在报告中显示

绘图的隐藏图层，显示的图层名和数目由 Color layers 面板中图层的性质
来决定。 
（2）Split paths（分离路径）：在报告中显示所有创建的或编辑使用

Split命令的路径信息。 
（3）Image data（图像数据）：在报告中显示图像的数据。 
（4）Convert images（转换图像）：在生成的报告中显示使用 Convert

命令转换图像的有关信息。 
（5）Max color steps（配色步骤）：在报告中显示用户调配颜色的步骤。 
（6）Flatness（平滑度）：在报告中说明输出的图像是否经过了平滑处

理。 

8.5  FreeHand 9.0的资源共享 

在使用 FreeHand 9.0 的过程中，我们经常需要自身之间的复制或者和
别的绘图软件之间的复制、剪切和粘贴。此时就需要使用到 FreeHand 9.0
的资源共享。 

FreeHand 9.0 中，存在有非常丰富的复制命令，用户可以根据自己的
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需要来使用。这些命令包括：Copy、Clone、Duplicate，它们都位于 Edit
菜单中。 

Copy、Cut、Paste 命令是利用操作系统的剪贴板来实现的。这些都是
Windows 的基本操作知识，不再详细介绍。 

Clone 命令用来创建对象的副本。首先选中该对象，然后使用 Clone
命令即可。该命令得到的副本和原对象完全重叠在一起，因而只有将复制

品从原对象上移开才能够看到复制品。 
Duplicate 命令与 Clone 命令的作用基本相同，唯一不同的地方在于，

该命令把复制的副本以一定的偏移放置在原对象的前面。如果该命令紧跟

在一个变换命令后面，则该命令将重复一系列的变换操作，可以形成一些

比较特殊的效果，如图 8-18所示的椭圆树叶即是该命令的效果。 

 
图 8-18   Duplicate 命令复制得到的特殊效果 
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